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C H A P T E R  1

INTRODUCTION

The Blackbaud FundWare™ Accounts Payable module provides complete payables 
processing, including: creating requisitions, purchase orders, and invoices; writing 
checks; and posting financial and AP information to your FundWare General Ledger.
With AP, you get the ability to:

• Implement budget controls for all users with three levels of user-defined 
thresholds (message, warning, and full lock-out) while entering obligations.

• Access vendor information quickly and easily, including obligation from 
requisition to check reconciliation.

• Define your system to reflect each step of your AP process (e.g., requisitions, 
purchase orders [encumbrances], invoices) and multiple approval levels.

• Generate automatic interfund transactions when expenses are coded to multiple 
funds.

• Automatically calculate purchase discounts and due dates.
• Add vendors easily, at any time.
• Manage multiple checking accounts.
Blackbaud, Inc. 1.1
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1.2
EXAMPLE AP PROCESS
Table 1.1 defines an example AP process for an organization that uses purchase orders, 
based on the setup provided in the sample divisions (Division 95 and Division 96). 
However, remember that you can fully customize the AP process to meet the needs of 
your organization.

Table 1.1—Example AP Process

Step Additional Information

Enter a new purchase order.
• The new purchase order is saved to the 

Purchase Orders > New temporary 
subfolder. 

• In Division 95, purchase orders are entered at stage 20.

Review the new purchase order and post 
to the main Purchase Orders folder.

• You can use this step as review process before posting 
(potentially to GL). Also, some organizations use this 
step as an approval process (e.g., using the Verify 
task).

• In Division 95, purchase orders post to the 
Encumbrance journal (ENCUM). (Not all stages post to 
GL. This will depend on how you define the Basic Setup 
parameter and PO Extended Setup parameter.) 

• Any time you post information to GL, you should print 
and review the GL posting trace report to verify your 
entries. You should also save the printed trace reports.

Transfer the purchase order to the invoice 
stage. 
• The transferred invoice moves to the 

Invoices > Transferred From P.O. 
temporary subfolder.

• In Division 95, invoices are transferred to or entered at 
stage 30. 

Review the transferred invoice and post to 
the main Invoices folder.

• You can use this step as review process before posting 
(potentially to GL). Also, some organizations use this 
step as an approval process (e.g., using the Verify 
task).

• In Division 95, the invoice information posts to the 
Purchasing journal (PURCH). (Not all stages post to 
GL. This will depend on your Basic and Extended 
Setup.)

• Any time you post information to GL, you should print 
and review the posting trace report to verify your 
entries. You should also save the printed trace reports.
Example AP Process 
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Mark for payment by a specific Financial 
Institution account (FIA). 
• The marked invoice moves to the 

Marked for Pay > New Mark temporary 
subfolder for the specified FIA.

• In all divisions, checks are marked for pay at stage 50. 

Review the marked invoice and post to the 
main Marked for Pay folder.

• You can use this step as review process before posting 
(potentially to GL). Also, some organizations use this 
step as an approval process (e.g., using the Verify 
task).

• This stage is not defined to post to GL.
• FundWare requires that you mark obligations for 

payment at stage 50.

Write and log checks. • In Division 95, information on paid obligations is posted 
to the Cash Disbursement journal (CDIS). (Not all 
stages post to GL. This will depend on your Basic and 
Extended Setup.)

• Any time you post information to GL, you should print 
and review the posting trace report to verify your 
entries. You should also save the printed trace reports.

• FundWare requires that paid obligations are stored at 
stage 60.

Reconcile checks. • You can reconcile checks using our Integrated Bank 
Reconciliation module (for more information, contact 
your Sales representative) or the reconciliation feature 
within AP.

• FundWare requires that reconciled checks are stored at 
stage 70.

Table 1.1—Example AP Process (Continued)

Step Additional Information
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1.4
EXAMPLE STAGES

FundWare uses “stages” to mark each step of your AP process (e.g., requisitions, 
purchase orders [encumbrances], invoices) and multiple approval levels. For example, 
Table 1.2 shows some example stages in their normal sequence.

Stages 10, 20, and 40 are optional, depending on how your organization 
manages its payables. 

Stages are defined in setup. For more specific information, see Working With Stages on 
page 1.67.

EXAMPLE POSTING TO GL–P/G JOURNALS

Table 1.3 shows you an example of the journal posting process in AP.

For instructions to define your system to post data items to General Ledger–Project/
Grant, see Posting Data Items to GL–P/G on page 1.168.

Table 1.2—Default Stages

Stage 10 20 30 40 50 60 70

Step Initial Order 
(Requisition)

Purchase 
Order

Invoice Approved Marked for 
Pay

Paid Reconciled

Table 1.3—Journal Posting

Task Journal Debit Credit

Post Purchase 
Order

Purchase or Encumbrance Expense Reserved for 
Encumbrance

Post Invoices Purchase Expense Accounts Payable

Cancel Invoices Purchase Accounts Payable Expense

Edit Invoices Purchase Varies (based on stage) Varies

Split Invoices Purchase Varies Varies

Produce Checks NA NA NA

Log Checks Cash Disbursements Accounts Payable Cash

Void Checks Cash Disbursements Cash Accounts Payable
Example AP Process 
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CUSTOMIZING AP
AP’s flexibility allows you to customize it to fit the needs of your organization. Table 
1.4 describes some of the customization tasks that you can define during Basic and 
Extended setup. 

SEPARATE AND COMBINED ENTRY

One of the most critical decisions you will make when you configure your system 
concerns the way in which you will enter obligation information:

Table 1.4—Customizing AP

Item Define

Vendors Will you use automatic or manual vendor numbering?
What entry fields should display on the vendor record?

Purchase Orders What printing options do you need to use for your purchase orders?

Obligations What entry fields should display on your obligations?

General Ledger posting What references to you want to include in your GL postings?
To what journals will you post information?
When will you post to GL (i.e., what stage)?
Are there account masks that the posting task will use?
What account or accounts masks will you use for the AP accrual account 
and cash disbursements?
• You can use a single account, or you can mask the account number 

(e.g., by fund).

Stages • What fields will be available at each stage?
• What data items will be displayed or editable at each stage?
Blackbaud, Inc. 1.5
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1.6
• Separate Entry—Obligation detail is entered on the Line Items tab, and 
accounting information is entered on the Distribution tab. The data on each tab 
is independent, allowing greater flexibility. 

Figure 1.1—Example Data Items Tab (Separate Entry)
Customizing AP 
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• Combined Entry—Both accounting distribution and obligation detail are 
entered on the Detail Lines tab. This provides faster data entry, but requires an 
exact match of the detail and account number. 

Figure 1.2—Example Data Items Tab (Combined Entry)

Once you have posted purchase orders using the “Combined” setting, you may change 
the parameter to “Separate” one time. However, you cannot change from Separate to 
Combined once you have posted obligations. 
To see how this setting will impact how you enter your obligations, see Entering 
Obligations—Separate Entry on page 2.64 and Entering Obligations—Combined Entry 
on page 2.74.
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CUSTOMIZING YOUR VENDOR RECORD SETTINGS

You can customize the vendor record to meet the needs of your organization. For 
example, you can enable or disable the Sort key, Name, Phone, Fax, and Alternate 
Name fields on the Vendor tab of the vendor record (Figure 1.3), although we strong 
discourage you from disabling the Name field. You can also allow changes to existing 
entries but disable the fields for future entries. 

Figure 1.3—Vendor Tab
Customizing AP 
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You can enable or disable the Main Address and Alternate Address fields on the 
Address tab of the vendor record (Figure 1.4), although we strong discourage you from 
disabling the Main Address fields. You can also allow changes to existing entries but 
disable the fields for future entries. 

Figure 1.4—Address Tab

You can enable or disable the discount options (Discounts given by Vendor, Percentage, 
and Days) and the Net Days field on the Discounts tab of the vendor record (Figure 
1.5). 

Figure 1.5—Discounts Tab
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You can enable or disable the five Notes fields on the Notes tab of the vendor record 
(Figure 1.6). You can also allow changes to existing entries but disable the fields for 
future entries. 

Figure 1.6—Notes Tab

See Customizing Your Vendor Record Settings on page 1.40 for instructions to 
customize your vendor record.

CUSTOMIZING YOUR OBLIGATION ENTRY FORMS BY STAGE

For each stage of your AP process, you can customize the obligation entry form to 
reflect the specific needs of your organization at that specific stage. You can display, 
hide, or disable most of the fields by stage, as well as define the label for certain fields. 
Customizing AP 
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For example, the label for the stage date can reflect the stage. In Figure 1.7, the stage 
date is labeled “Invoice Date.” Also, you can define the number of description lines for 
the obligation on the Header tab of the obligation using the Basic Setup parameter. 

Figure 1.7—Obligation Header Tab

At each stage, you can display obligation references (i.e., data items) on the Data Items 
tab of the obligation for user entry (Editable Data Items) or for information only 
(Display Only Data Items (Figure 1.8). 

Figure 1.8—Data Items Tab
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At each stage, you can enable, disable, or hide the Auto button on the Detail Lines tab 
(combined entry) or Distribution tab (separate entry) of the obligation (Figure 1.9). 

Figure 1.9—Detail Lines and Distribution Tabs

See Customizing Your Obligation Forms on page 1.44 for specific instructions to 
customize your obligation entry forms.

USING MASKS
A mask is an FundWare term for using a “wild card” in an account number to indicate a 
group of accounts. The best use of this feature is for processing and reporting. Where an 
X is placed in a mask, any value in that digit position will be accepted. 

In Sample Division 95, if you enter the mask A01 00-00 111X in the Account 
Selector, you will get five accounts (A01 00-00 1110, A01 00-00 1111; A01 00-
00 1112; A01 00-00 1114; A01 00-00 1115).

When posting, FundWare completes the account number by replacing the masked 
characters with the digit in the matching position of the account in the balancing side of 
the entry.
Using Masks 
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Your setup includes an Accounts Payable liability account of AXX 00-00 2110. 
When you post an expense to account A03 01-02 7135, the liability posts to 
A03 00-00 2110.

THE ACCOUNTS PAYABLE HOMEPAGE
The Accounts Payable HomePage helps you keep an eye on your upcoming activities 
and provides you with direct access to produce your reports. The following areas make 
up the AP HomePage:

• Activity Reminder area, and
• Reports area.

ACTIVITY REMINDERS

The Activity reminder area allows you to enter a text note and a due date (optional) for 
module tasks (Figure 1.10). The Activity reminder area is user-specific: only you can 
view the notes that you entered, and you only see your own notes. When you open the 
HomePage, any tasks with due dates earlier than the system date of your computer will 
display as red. 

Figure 1.10—Activity Reminder Area

Use the following instructions to use the Activity Reminder area.
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1.  On the Accounts Payable HomePage, enter up to 100 alphanumeric characters 
in the Activity field (Figure 1.11). 

Figure 1.11—Example Activity Reminder

2. If this task has a due date, enter the date in the Due Date field (Figure 1.12). 
Click the drop-down arrow to access the calendar. This field is optional. 

Figure 1.12—Example Activity Reminder With Due Date

If you do not have any text associated with a due date, the due date will 
not be saved when you exit the HomePage.

Your entries are saved when you close the HomePage or FundWare. You can edit the 
text or date information at any time.

PRINTING REMINDERS

Click Print to print the information in the Activity Reminder area. The report output 
will reflect the current sorting and displays in a preview window, from which you can 
print the information.

DELETING REMINDERS

Use the following instructions to delete a reminder.
1.  Highlight the row.

2. Click Delete. The reminder is removed from your display.
The Accounts Payable HomePage 



Chapter 1—Introduction
REPORTS AREA
The same categories that you see in Report Manager for the module will also display in 
the Reports Area of the HomePage (Figure 1.13). Each category can expand and 
collapse to show or hide the reports contained within. A single click of a report title will 
display the report parameters screen. Once you enter the details of the report and click 
OK, your report is produced. 

Figure 1.13—Reports Area of the Accounts Payable HomePage

NAVIGATING THE FOLDER TREE
The Accounts Payable module organizes information in different categories, stored in 
the folder tree. At the highest level of the tree, you have three folders that will always 
display. However, the subfolders displayed within these folders are determined by your 
setup. The first-level folders in the Accounts Payable folder tree are described in Table 
1.5. 

Table 1.5—Navigation Tree Folders

Folder Description

Vendors Holds all your vendor records. From this folder you can add, delete, or edit these 
records.

Obligations Contains separate folders for each stage and sub-stage (e.g., purchase orders, 
invoices). The number and name of the folders is determined by how you define 
your stages. 
• The sub-stage folders (e.g., New, Transferred From) display only if they contain 

obligations. 
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These folders work similarly to folders in a Windows environment: when you click a 
folder, its contents display in the right pane of the window (called the detail pane) for 
viewing and manipulating. 
Each folder has a specific set of available options. For example, FundWare provides 
three ways to access an option, as described below and in Figure 1.14:

• Click one of the buttons at the bottom of the screen. They change according to 
what folder is currently open.

• Right-click on an obligation to display a menu, then select one of the options. 
They are the same options on the buttons at the bottom of the window.

Disbursements Holds subfolders for each AP use association defined by your Financial Institution 
accounts (FIAs). Within each subfolder, you will find the checks written from that 
account, divided into additional folders (e.g., Paid, Reconciled). 
• The subfolders (e.g., Paid, Reconciled) display only if they contain checks. 
• The only exception to this is the New Manual Checks subfolder. It always 

appears under each bank so that you can create manual checks.

Table 1.5—Navigation Tree Folders (Continued)

Folder Description
Navigating the Folder Tree 
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• Press the underlined letter while holding down the ALT key (to access an option 
with the keyboard). For example, to access Mark for Pay, press ALT+A. 

Figure 1.14—Folders

Some buttons are not accessible until you select an entry in the detail pane (e.g., an 
obligation or vendor). If a button remains disabled (i.e., grayed-out), your security level 
may not include access to this function. For more information on the Security feature, 
see the Blackbaud FundWare System Administration Guide.

TRANSFERRING OBLIGATIONS

You can use the “drag and drop” functionality to transfer obligations from one folder to 
another. The following rules apply when you move obligations:

• Folders that appear only when they hold obligations (e.g., Mark for Pay) must 
be on the navigation tree for you to drag and drop an obligation to them.

• Security restrictions are respected.
• You cannot drag and drop memorized obligations to create a new obligation.

See Transferring Obligations on page 2.125 for more information.

Right-click in the detail 
pane to display a menu, 
then select one of the 
options.

Access an option from the 
keyboard by pressing ALT plus 
the underlined letter on the 
button. For example, press 
ALT+A to access Mark for Pay.

Click one of the buttons. 
The set changes for 
each folder.
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THE DETAIL PANES

You have many options when it comes to how much information you want to display in 
the detail panes for the Vendors, Obligations, and Disbursements folders and their 
associated subfolders. You can:

• Reorder the records—Click the header of the category on which you want the 
sort based. Click a second time to reverse the order.

• Hide or display columns—Right-click and select the column to be hidden or 
displayed. A check mark indicates that a column is displayed in the detail pane.

• Adjust the column widths—Click the divider line between the column headings. 
The cursor will change. Move to the left or right until the column is the width 
you want.

• Reorder columns—Click the column heading and drag the column to a new 
position.
When you add or remove columns from the detail pane, the program remembers 
your settings (except column width) when you exit the folder.

FILTERING OBLIGATIONS
While in the obligation stage folders, you can filter the entries in the detail pane to 
match your needs. 

1.  In any of the Obligations subfolders, select the Filter check box (Figure 1.15). 

Figure 1.15—Selecting the Filter Option From the Invoices Folder
Filtering Obligations 
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The Filter window displays. The fields included on the window vary depending 
on the subfolder that you are in when you access the filter feature (Figure 1.16). 

Figure 1.16—Filter Windows

2. Complete the Filter window according to Table 1.6. 

Table 1.6—Filter Options

Option Description

Obl. Reference Select the data item on which you will filter (e.g., Obligation, Vendor number, Due 
date). By default, all matching records will be included in the filtered display (i.e., 
the All check box is selected).
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of values in the fields next to the data item.
• To select a single value, enter the appropriate alphanumeric text in both fields.

Vendor # Range By default, all vendors will be included in the filtered display (i.e., the All check box 
is selected).
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of vendor numbers in the From and To fields.
• To select a single value, enter the number in both fields.

“Stage” Date By default, all obligations will be included in the filtered display, regardless of stage 
date (e.g., “Date Ordered,” “Due Date”). In other words, the All check box is 
selected. Additionally, the From and To date fields are prefilled with the actual date 
(not the business date).
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of dates in the From and To fields. You can use the  
button to select a date from the calendar. 

• To select a single value, enter the number in both fields. You can use the  
button to select a date from the calendar.

Purchase 
orders and 
invoices

Memorized 
obligations
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3. Click OK. The filtered obligations are listed in the detail pane.

To view all obligations, select the Filter check box to remove the check 
mark. All obligations will display in the detail pane.

If no obligations display, your filter settings may be too narrow (i.e., no 
obligations meeting the requirements).

Last Used On 
Date Range

By default, all memorized obligations will be included in the filtered display, 
regardless of last date that the memorized obligation created a new obligation (i.e., 
the All check box is selected). Additionally, the From and To date fields are 
prefilled with the actual date (not the business date). 
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of dates in the From and To fields. You can use the  
button to select a date from the calendar. 

• To select a single value, enter the number in both fields. You can use the  
button to select a date from the calendar.

This field only displays on a filter for memorized obligations.

Account Mask You can also filter based on the accounts on the obligations by entering an 
account number or mask. This field does not display on a filter for memorized 
obligations.

Table 1.6—Filter Options (Continued)

Option Description
Filtering Obligations 
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SETTING STAGE SECURITY
Accounts Payable allows you to set security restrictions at the stage level. For example, 
we create a group called “Invoice Data Entry” and restrict the users assigned to the 
group to Stage 30 (Invoice) (Figure 1.17). 

Figure 1.17—Security—Allowing Access to Stage 30 (Invoice)
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We can assign a user to this group, which applies the group’s stage restrictions to that 
user. However, we can also modify the default settings for that user (Figure 1.18). 

Figure 1.18—Security—Customizing Users Access to Stage 30 (Invoice)

For more information and instructions on defining your security settings, please see the 
Blackbaud FundWare System Administration Guide.

SOME FUNDWARE BASICS
The following sections provide you information and instructions for opening and 
working in FundWare.

OPENING FUNDWARE

As you begin using FundWare, certain information is saved by the program and offered 
as a default. This has been designed to help you save time and steps, but you can change 
these defaults at any time by entering new information or selecting from the available 
options (depending on the field).

• User name—The program will enter the user name (or user number) of the last 
person to log into FundWare on that computer.
Some FundWare Basics 
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— For security reasons, your password is not automatically entered. You must 
always enter your FundWare password.

• Business date—Defaults to the current system date (according to your 
computer’s operating system).

• Division—The program automatically selects the division you were working in 
the last time you were in FundWare. 
— If you have only one division (or have security rights to only one division) 

and do not have security rights to the System Administration area, the 
program will bypass the division selection window. 

— Or, if you only have security rights to the System Administration area, the 
program will bypass the division selection window and open directly to the 
System Administration HomePage.

• HomePage—The program automatically opens to the HomePage of the module 
in which you were working the last time you were in FundWare. 

Use the following instructions to open and log into FundWare.
1.  Double-click the FundWare icon on your desktop or select Blackbaud 

FundWare® Enterprise or Professional from your Windows Start menu. The 
Login window displays. 

Figure 1.19—FundWare Login Window

2. Enter your user name in the User Name text box. You can enter your user 
number instead of your user name, if preferred. 

The User Name field will default to the last entry on this computer and 
the system will move to the Password field.

3. Enter your password in the Password text box. Your password entries will 
display as asterisks (*) as you type to maintain the privacy of your password. 
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4. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

Figure 1.20—Selecting the Date

5. Click OK. If your User Name, Password, and Business Date are verified, the 
Select Division window displays, defaulting to the division you were working 
with the last time you were in FundWare. 

Figure 1.21—Selecting the Division

If your organization uses the password aging feature, you may receive a 
message indicating that your password will or has expired. You will be 
offered the chance to enter a new password at this time. See Changing 
Your Password During Login on page 1.25.

If you have only one division (or have security rights to only one 
division) and do not have security rights to System Administration, the 
program will bypass the Select Division window. Or, if you only have 
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security rights to System Administration, the program will bypass the 
division selection window and open directly to the System 
Administration HomePage.

6. If necessary, select a different division (or System Administration) from the list. 

7. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

For users upgrading from earlier versions of FundWare, please note that you can only 
have one division open at a time in each instance of FundWare (a change in 
functionality). However, you can open the program multiple times for the same or 
different divisions and/or business dates.

CHANGING YOUR PASSWORD DURING LOGIN

If your organization uses the password aging feature (defined through System 
Administration), you may receive a message indicating that your password will or has 
expired. 

Figure 1.22—Password Expiring

Use the following instructions to change the password at this time.
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1.  Click Yes to the password expiration message. The Change Password window 
displays. 

Figure 1.23—Changing Your Password During Login 

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

You can also change your password from within the software. See Changing Your 
Password From the Software on page 1.29.

OPENING FUNDWARE MULTIPLE TIMES

Each “instance” of FundWare (i.e., each time you open the program) represents a single 
division on a single business date. However, you can open as many instances of 
FundWare as necessary to meet your needs. 
When dealing with multiple instances of FundWare, keep the following rules in mind:

• Each instance of FundWare represents a single user, division, and business date, 
or represents access to the System Administration features by a single user. 

• You can open as many instances of FundWare as necessary (i.e., for different 
users, business dates, or divisions).
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• You can still change the business date for the current instance of FundWare 
without opening a new instance. See Changing the Business Date on page 1.28 
for more information.

OPENING ADDITIONAL INSTANCES—FROM THE DESKTOP/START MENU

If you have one or more instances of FundWare open already, you can open additional 
instances of the program from your desktop or the Windows Start menu. You will be 
asked to identify the user, password, business date, and division (the same steps as 
opening the first instance of FundWare).

OPENING ADDITIONAL INSTANCES—FROM THE PROGRAM

You can also open a new division or a new instance of the same division from within 
FundWare. Because you are opening this division from the program, the system applies 
the same user and password to the new instance and allows you to select a new division 
or business date.

If you want to open a new instance of FundWare for a new division or a new 
business date, you can open the program from the desktop or Windows Start 
menu or from the Change Business Date task. For instructions on changing the 
business date, or opening a second instance of the program with a different 
business date, see Changing the Business Date on page 1.28.

Use the following instructions to open a new instance of FundWare for the current user 
and business date.

1.  Select File > Open FundWare from the menu bar. The Open New Instance 
window displays, automatically selecting the division you were working with 
the last time you were in FundWare. 

Figure 1.24—Opening a New Instance of FundWare

2. If necessary, select a different division (or System Administration) from the list. 
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3. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

4. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

CHANGING THE BUSINESS DATE

You can change the business date for your current instance of FundWare or open a new 
instance of the same division with a different business date using the Change Business 
Date task. When you choose to open a new instance of the same division, the system 
applies the same user and password to the new instance and takes you directly to the 
HomePage for the module in which you were last working in that division.

1.  Select Edit > Change Business Date from the menu bar. The Change Business 
Date window displays. 

Figure 1.25—Changing the Business Date 

1 Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you can 
click the down-arrow to select a date from the calendar.

2 Select the applicable option for applying the new business date:
• Current Instance of FundWare—Changes the business date for the current 

instance of FundWare. This option does not apply any changes to other 
instances of FundWare and does not open a new instance of the program.

The “Classic” windows will not accept a changed business date. If you 
have any of the Classic screens open when you attempt to change the 
business date for the current instance of FundWare, the system will 
return a message and not allow you to proceed. Close the Classic 
windows and try again.
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• New Instance of FundWare—Opens a new instance of FundWare to the 
HomePage for the module in which you were last working, applying the 
same user, password, and division but using the new business date.

1.  Click OK. The program applies your selection.

CHANGING YOUR PASSWORD FROM THE SOFTWARE

Use the following instructions to change the password for the current user.
1.  Select Edit > Password from the menu bar. The Change Password window 

displays. 

Figure 1.26—Changing the Current User’s Password

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

If your organization uses the password aging feature (defined through System 
Administration) and your password is nearing or has passed the expiration date, you can 
also change your password during the login process. See Changing Your Password 
During Login on page 1.25.
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USING THE MENU BAR

Each module for which your organization is licensed and to which you have security 
rights displays in the menu bar. From these menu options, you can access all module-
specific tasks (e.g., General Ledger > Journal Entries > New). In addition, you will 
use the menu bar to access specific program tasks (e.g., changing the business date):

• File—Open divisions; access Print Manager, Report Manager, or Financial 
Institutions.

• Edit—Change the business date or your password.
• View—View or close Navigator bar; view full or abbreviated menu names; 

view logged in users.
• Window—See all currently open windows, switch between these windows.
• Help—Access online help for the current module and program information. 

KEYBOARD NAVIGATION

To help you navigate quickly through the program, FundWare allows you to use your 
keyboard instead of your mouse to access program tasks.

• Menu bar—You can access any task listed on the menus using a combination of 
the ALT key and a letter and the arrow keys.
— Press the ALT key.
— Press the underlined letter of the item to display the menu. The menu 

displays.
— Use the arrow key and press ENTER to select a task.

• Shortcut menus—Access any applicable shortcut menus (normally displayed 
when you right-click your mouse) from the keyboard by pressing either 
SHIFT+F10 or the Application key (offered on many newer keyboards, located 
between the WINDOWS key and the CTRL key, to the right of the spacebar).

• Shortcut keys—Shortcut keys combine the CTRL key with a letter to give you 
direct access to certain tasks. These shortcuts are listed on the menus with the 
applicable tasks. 

• Drop-down lists—You can access any drop-down list when focus is on the 
associated field by using a combination of the ALT key and the down arrow key. 
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IS YOUR MENU BAR TOO CROWDED?

If your organization is licensed for a number of FundWare modules, your menu bar may 
be too wide to use conveniently. You can change the module names that are listed in the 
menu bar to display as acronyms, which will decrease the width of the bar:

• Select View > Abbreviated Menu Names from the menu bar. To change back, 
select View > Full Menu Names from the menu bar.

HOW YOUR SECURITY RIGHTS IMPACT THE MENU BAR

Your individual security rights may impact the modules and tasks that you see on the 
menu bar. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the menu bar.

• If your security settings allow you to access some, but not all, tasks in a module, 
the restricted tasks will not be listed in the menu bar.

USING THE NAVIGATOR BAR

The Navigator bar provides you with quick, mouse-driven access to your modules, 
module tasks, and currently open windows through two areas:

• Module navigator, and
• Open windows navigator.

You can resize the Navigator bar to meet the needs of your display by using your mouse 
to click on the right frame of the bar and drag the frame to the position you want. You 
can also hide or show the Navigator bar using the options on the View menu. Select the 
option to hide or show the bar, as applicable. These settings will be retained by the 
system when you close FundWare.

MODULE NAVIGATOR

The module navigator lists the modules for which your organization is licensed (unless 
your individual security settings do not allow you to access a module). When you click a 
module (it just takes a single click), the module expands to display all of the associated 
module tasks. 
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Accessing any of the tasks within the module takes another single click on the specific 
item. Some tasks are “nested” below a title. A single click will expand the title, 
displaying the related tasks below. 

Figure 1.27—Module Navigator—Expanded Menus

If your security settings restrict your access to specific tasks, those tasks will not 
be listed in the menu bar. 
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OPEN WINDOWS NAVIGATOR

The open windows navigator lists the windows that are currently open in this instance of 
FundWare, highlighting the window currently displayed. A single click of an entry in 
the open windows navigator redisplays the window in your workspace. 

Figure 1.28—Open Windows Navigator

As with all Windows applications, the more FundWare windows that you open 
concurrently, the greater impact to your processor speed. You can use the Open 
Windows Navigator to monitor how many windows you have open at any one 
time.

HOW YOUR SECURITY RIGHTS IMPACT THE NAVIGATOR BAR

There is no security impact to the open windows navigator. If your security rights 
allowed you to open a task, then that window will display in the open windows 
navigator. However, your individual security rights may impact the modules and tasks 
that you see on the module navigator. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the module navigator.

• Any tasks within a module from which you are restricted will not be listed in the 
menu bar. 

CUSTOMIZING YOUR DISPLAY

Throughout FundWare, you will encounter forms (similar to a table or spreadsheet) that 
allow you to customize the display through the shortcut menu (accessed by right-
clicking your mouse) or through direct manipulation with your mouse. Most of these 
settings are retained with your user name. Therefore, the forms display according to 
your settings wherever you log in to FundWare. (In other words, the program 
remembers how the form displayed when you closed FundWare. This is how it will 
display the next time you open the program.)
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Not all forms provide these options. If you attempt one of the customization 
options described here and are unsuccessful, it is likely that the option is not 
offered on that form.

HIDING AND DISPLAYING COLUMNS

To add or remove a column from a form, hover your mouse over the pane and right-
click. A shortcut menu displays, which allows you to hide or display columns from the 
form. 

Figure 1.29—Example Shortcut Menu for the GL New Journal Entry Form

The columns currently displayed in the form are indicated with a check mark. Select a 
column from the shortcut menu to add or remove that column to the detail pane.

If you have disabled fields through the module setup (e.g., the Accounts 
Payable parameter or stage settings), the associated column will not be listed on 
the shortcut menu.

RE-ORDERING THE COLUMNS

To re-order the columns in a form, “drag and drop” the column by clicking the column 
heading and moving the column to the desired position (holding the mouse button 
down).

In this example, the Account column is disabled 
because this column must always display. 

The remaining columns are currently displayed in the 
New Journal Entry form.
Some FundWare Basics 
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RESIZING THE COLUMNS

To resize a column, hover your mouse over the column border until the icon changes. 
Figure 1.30—Mouse Icon

Click your mouse button and drag the column border until it is the desired width.

SORTING THE ENTRIES IN A FORM

To resort the entries in a form, click the heading of the column on which you want the 
sort based. To reverse the sort order, click the column heading again. 

Figure 1.31—Sorting the Detail Pane

Sort order is not retained when you close FundWare.

HELP

If you encounter questions or problems while you are working in the program, you can 
access the online help from the Help menu (on the menu bar) or by clicking F1 to access 
the online help for the current module.

Original display.

Entries resorted 
based on Obligation 
number.

Entry order reversed.
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You can also access PDF files (portable document format) of the guides from your 
server:

• FundWare\Data\User Documentation
You must have Adobe Acrobat Reader installed to view the files. This program is 
available from the FundWare CD or as a free download from www.adobe.com.

TRAINING AND CONSULTING SERVICES

Blackbaud, Inc. offers a number of options to help you improve your use of FundWare.
• Regional classes—Training classes held several times per month in various 

cities across the nation. These one- to five-day classes provide a hands-on 
learning environment and low student-to-instructor ratio.

• eClasses—Interactive training classes offered over the Internet provide you and 
your staff the opportunity to receive training from FundWare experts without 
leaving your desk.

• Onsite custom training sessions and consulting—Our training/consulting group 
offers you onsite services, including:
— Training your staff using your data.
— Installing/upgrading and configuring the software to meet the specific needs 

of your organization.
For more information about any of our training or consulting services, please explore 
our Web site (http://www.blackbaud.com) or contact our Client Sales department (800-
551-4458).

USING THIS DOCUMENT

This manual is organized to reflect the most common uses of the module. It provides 
you with overview information of FundWare, followed by specific features and 
functions of the module.
Some FundWare Basics 
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CONVENTIONS

Use Table 1.7 as a reference for conventions used in this document. 

GETTING SUPPORT

The following table provides a quick reference for getting the support you need for 
FundWare modules.

Table 1.7—Icon Conventions
Indicator Description

A caution or warning that must be heeded. Information contained in a warning should be care
reviewed to avoid adverse affect on software operation.
An example, used to clarify an issue.

ENTER Keyboard directions are indicated in small capital letters (e.g., Press ENTER).
demo user Specific text entries are indicated with italics (e.g., Type demo user for User Name).
Click OK An item on the screen that requires user interface is indicated in bold.

Table 1.8—Getting Support
Department Contact Description

Business 
Office

800-551-4458 Obtain general information or contact a sta
member.

Technical 
Support

800-227-7575
e-mail: FWSupport@blackbaud.com

Get help resolving technical issues with th
product. Please have the following informa
ready when you call:
• Blackbaud Site ID
• FundWare version number
• Error message details

Knowledgebase
www.blackbaud.com

A searchable database where you can typ
your questions and get a list of possible 
answers.
• Requires your license number and Black

Site ID.
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Training 800-551-4458
Ask for the Client Sales department.

www.blackbaud.com

Contact us for more information on our trai
options:
• Regionals—Classes from 1 to 5 days in 

length; held in cities around the country.
• eClasses—Two- to three-hour classes of

over the Internet.
• Onsite custom training and consulting—O

consulting staff can implement FundWar
and/or train your employees using your 
organization’s data.

Product 
Management

www.blackbaud.com Contact our Product Management departm
with any suggestions for improving FundW

All other 
information

www.blackbaud.com Links are available for all other FundWare 
information including replacement software
user guides and software updates.

Blackbaud, Inc.
6430 S. Fiddler’s Green Circle, Suite 200
Greenwood Village, CO 80111
800-551-4458
303-756-3030

Table 1.8—Getting Support (Continued)
Department Contact Description
Some FundWare Basics 
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DEFINING YOUR PARAMETERS AND STAGES

There are a number of tasks that you must complete to define and customize your 
Accounts Payable module. Many of these tasks (e.g., defining the Basic Setup 
parameter) must be completed before you can access any AP functionality:

• Basic Setup parameter
• Extended Setup parameter
• Purchase Order Basic parameter
• Purchase Order Extended Setup parameter
• Stages
• Check formats

This chapter addresses these required setup tasks. Once defined, you will probably 
access these parameters only occasionally. Other tasks (e.g., defining city locations) are 
optional and may be accessed more frequently and are addressed in Chapter 3—
Completing Additional AP Setup Tasks on page 1.101.
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CUSTOMIZING YOUR VENDOR RECORD SETTINGS
Before you begin to define your AP system, you should familiarize yourself with the 
ways in which the settings in the Basic Setup parameter (Figure 2.1) allow you to 
customize the vendor record to meet the needs of your organization. 

Figure 2.1—Field 1 of the Basic Setup Parameter
Customizing Your Vendor Record Settings 
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Figure 2.2 details how you can customize the Vendor tab of the vendor record. 

Figure 2.2—Diagram of the Vendor Record Settings—Vendor Tab

If the Auto Vendor # setting in field 1 of the Basic Setup parameter 
is “Y,” FundWare will default this entry to the next available number.

You can enable or disable the Sort Key field using the Sortkey setting in field 1 of the Basic Setup 
parameter. You can also allow changes to existing entries but disable the field for future entries.

You can enable or disable the Phone and Fax fields using the Phone setting in field 1 of the Basic 
Setup parameter. You can also allow changes to existing entries but disable the fields for future 
entries.

You can enable or disable the Name field using the Name setting in field 1 of the Basic Setup 
parameter. You can also allow changes to existing entries but disable the field for future entries. 
However, we recommend that you always set this field to “Y.”

You can enable or disable the Alternate Name field using the Alt Address setting in field 1 of the 
Basic Setup parameter (which also controls the Alternate Address fields on the Address tab). You 
can also allow changes to existing entries but disable the field for future entries.
Blackbaud, Inc. 1.41
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Figure 2.3 details how you can customize the Address tab of the vendor record. 

Figure 2.3—Diagram of the Vendor Record Settings—Address Tab

Figure 2.4 details how you can customize the Discounts tab of the vendor record. 

Figure 2.4—Diagram of the Vendor Record Settings—Discounts Tab

You can enable or disable the Main 
Address fields using the Address setting 
in field 1 of the Basic Setup parameter. 
You can also allow changes to existing 
entries but disable the fields for future 
entries. However, we recommend that 
you always set this field to “Y.”

You can enable or disable the Alternate 
Address fields using the Alt Address setting 
in field 1 of the Basic Setup parameter (which 
also controls the Alternate Name field on the 
Vendor tab). You can also allow changes to 
existing entries but disable the fields for 
future entries.

You can enable or disable the Net Day fields using the Terms setting in field 1 of the Basic Setup 
parameter. You can also allow changes to existing entries but disable the field for future entries.

You can enable or disable the Discounts 
given by Vendor check box and 
Percentage and Days fields using the 
Discounts setting in field 1 of the Basic 
Setup parameter. You can also allow 
changes to existing entries but disable the 
fields for future entries.
Customizing Your Vendor Record Settings 
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Figure 2.5 details how you can customize the Notes tab of the vendor record. 

Figure 2.5—Diagram of the Vendor Record Settings—Notes Tab

Turn to Defining the Basic Setup Parameter on page 1.48 for instructions to define the 
Basic Setup parameter and customize your vendor records.

You can enable or disable the 
five Notes fields using the 
Notes setting in field 1 of the 
Basic Setup parameter. You 
can also allow changes to 
existing entries but disable the 
fields for future entries. 
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CUSTOMIZING YOUR OBLIGATION FORMS
Before you begin to define your AP system, you should familiarize yourself with the 
ways that you can customize the obligation entry form through the Basic Setup 
parameter and the stage definition (Figure 2.6). Each stage has a different definition, 
therefore, the obligation form can reflect the specific needs of your organization at that 
specific stage in your AP process. 

Figure 2.6—Example Stage Settings and Basic Setup Parameter
Customizing Your Obligation Forms 
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Figure 2.7 details how you can customize the first part of the Header tab of an 
obligation entry form. 

Figure 2.7—Diagram of the Obligation Form Settings—Part 1

You can display, hide, or disable the Vendor information using 
the Vendor setting in field 7 of the stage definition.

The number of lines displayed is defined in field 2 of the Basic Setup parameter and applies to 
all stages. You can display, hide, or disable the description lines using the Description setting 
in field 7 of the stage definition.
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Figure 2.8 details how you can customize the second part of the Header tab of an 
obligation entry form. 

Figure 2.8—Diagram of the Obligation Form Settings—Part 2

You can display, hide, or disable the Total Amount using 
the Amount setting in field 7 of the stage definition.

The label for this field is defined in field 3 of the stage definition (History desc). In addition, you can 
display, hide, or disable the field using the Amount setting in field 7 of the stage definition.

The label for this field is defined in field 4 of the stage definition (Date desc). In addition, you can 
display, hide, or disable the field using the Stage date setting in field 7 of the stage definition.

You can display, hide, disable, or calculate the invoice date field using the Invoice Date setting in 
field 7 of the stage definition. See Adding Stage Definitions on page 1.75 for more information.

You can display, hide, or disable the Discount Type field using the Discount info setting in field 7 of 
the stage definition. Additional discount information may display. See Applying Vendor Discounts to 
Obligations on page 2.87.
Customizing Your Obligation Forms 
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The Data Items tab is divided into two areas: Editable Data Items and Display Only 
Data Items (Figure 2.9). Field 8 of the stage definition allows you to define those 
obligation references that are automatically added to the Data Items tab, either allowing 
the user to enter or edit the value or as display only. 

Figure 2.9—Data Items Tab
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Figure 2.10 details how you can control access distribution tables on the Detail Lines 
tab (combined entry) or Distribution tab (separate entry). 

Figure 2.10—Detail Lines and Distribution Tabs

Turn to Defining the Basic Setup Parameter on page 1.48 and Working With Stages on 
page 1.67 for instructions to define the Basic Setup parameter and your stages, 
customizing your obligation forms.

DEFINING THE BASIC SETUP PARAMETER
The Accounts Payable module allows you to customize the vendor record and the 
obligation entry screens using the Basic Setup parameter. This parameter also holds 
your journal posting settings for General Ledger.
You must define the basic setup parameter before you can complete any other setup 
tasks. Since the parameter controls how AP will work for your organization, you should 
think carefully about what you need and be very careful in making any changes after 
you complete the setup. 

Note that changes to the parameter are recorded by business date and user 
number in the fields displayed in the upper right hand corner of the screen.

You can display, hide, or disable the Auto button on the 
Detail Lines tab (combined entry) or Distribution tab 
(separate entry), which gives access to distribution tables, 
using the Dist table setting in field 7 of the stage definition.
Defining the Basic Setup Parameter 
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Use the following instructions to define the Basic Setup parameter. (Customizing Your 
Vendor Record Settings on page 1.40 shows the impact of certain settings on your 
vendor record.)

1.  Click Setup > Basic Setup on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > Setup > 
Basic Setup from the menu bar. The task option menu displays. 

2. Type A to add the Basic Setup parameter. The first page of the task displays 
(Figure 2.11). 

Figure 2.11—Define Basic Setup, Page 1 of 2

3. Complete the required fields according to Table 2.1. 

Table 2.1—Defining Basic Setup—Vendor Entry Fields

Field Name Description

Auto 
vendor #

Indicate whether you will assign vendor numbers manually or if FundWare will assign 
vendor numbers automatically.
• Y—Assigns a number to the record automatically when you add a new vendor. 
• N—Prompts you to enter a number when you add a new vendor.
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Sortkey The sortkey allows you to enter an additional name or reference for the vendor. 
• Y—Enables the Sortkey field on the vendor record.
• N—Disables the Sortkey field on the vendor record.
• C—Allows you to change existing sortkeys, but deactivates the Sortkey field on new 

vendor records.
For example, if the vendor name is officially “Invesco Field at Mile High Stadium,” but you 
know you always call it “Mile High,” you could enter this in the Sortkey.

Name While you can disable the Name field, we strongly recommend that you always enable 
this field.
• Y—Enables the Name field on the vendor record.
• N—Disables the Name field on the vendor record.
• C—Allows you to change existing names, but deactivates the Name field on new 

vendor records.

Address This is the Main Address in the vendor entry window. Information entered here prints on 
purchase orders for the vendor. Also, if there is no alternate address defined for a 
vendor, the Main Address prints on checks.
• Y—Enables the Address fields on the vendor record.
• N—Disables the Address fields on the vendor record.
• C—Allows you to change existing addresses, but deactivates the Address fields on 

new vendor records.
Always set to Y.

Alt address Allows you to enter an alternate vendor name or address (i.e., the fields will be enabled 
on the vendor record). If there is an alternate address defined for a vendor, that address 
prints on checks.
• Y—Enables the Alt Name and Alt Address fields on the vendor record.
• N—Disables the Alt Name and Alt Address fields on the vendor record.
• C—Allows you to change existing alternate name and address information, but 

deactivates the Alt Name and Address fields on new vendor records.
Note: Regardless of the setting in the Vendor Entry Fields, any information in the 
alternate vendor name or address will print on checks and check registers. For example, 
if you enable this function and enter information then disable the setting, the information 
will still print on your checks and registers.

Phone Indicate if the Phone and Fax fields are enabled on the vendor record:
• Y—Enables the Phone and Fax fields on the vendor record.
• N—Disables the Phone and Fax fields on the vendor record.
• C—Allows you to change existing phone and fax numbers, but deactivates the Phone 

and Fax fields on new vendor records.

Table 2.1—Defining Basic Setup—Vendor Entry Fields (Continued)

Field Name Description
Defining the Basic Setup Parameter 
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Notes You can use the five Notes fields to store special information about the vendor.
• Y—Enables the five Notes fields on the Notes tab of the vendor record.
• N—Disables the five Notes fields on the Notes tab of the vendor record.
• C—Allows you to change existing notes, but deactivates the five Notes fields on the 

Notes tab of new vendor records.
Note 1 is often used to store the vendor tax ID number for 1099s. (The 1099 program will 
automatically pick up any information in the Note 1 field.) To use a Note field for such a 
purpose, you must enter the data consistently from vendor to vendor. See Using Notes 
for 1099 and Minority Vendors on page 2.56.

Discounts The Discounts field allows you to indicate that the vendor grants a discount, what the 
percentage should be, and how long (in days) after the obligation is entered will the 
discount be offered. 
• Y—Enables the fields on the Discounts tab of the vendor record. 
• N—Disables the fields on the Discounts tab of the vendor record.
• C—Allows you to change existing discount information, but deactivates the fields on 

the Discounts tab of new vendor records.
The Discounts field works in conjunction with the Discounts field in the Obligation Entry 
settings (page 2 of the Basic Setup parameter). For more information on applying 
discounts, see Applying Vendor Discounts to Obligations on page 2.87.

Terms Indicate if the Net Days field on the Discounts tab of the vendor record is enabled, 
disabled, or editable. 
• Y—Enables the Net Days field.
• N—Disables the Net Days field.
• C—Allows you to change existing term information, but deactivates the Net Days field 

on the Discounts tab of new vendor records. See Calculating Obligation Due Dates on 
page 1.84 for more information.

Table 2.1—Defining Basic Setup—Vendor Entry Fields (Continued)

Field Name Description
Blackbaud, Inc. 1.51



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.52
4. Press PAGE DOWN or press ENTER to access page 2 of the Basic Setup parameter 
(Figure 2.12). 

Figure 2.12—Define Basic Setup, Page 2 of 2

5. Complete the required obligation entry fields according to Table 2.2. 

The Oblig Entry fields control some of the fields that make up the 
invoice entry screens. If fields are not used, they do not appear on the 
screens. Remember that additional fields can be controlled by the stage 
definitions. 

Table 2.2—Defining Basic Setup—Obligation Entry Fields

Field Name Description

Description Enter the number of description lines that are displayed on the Header tab of the 
obligation. (See Figure 3.3—Separate Entry—Header Tab or Figure 3.11—Combined 
Entry—Header Tab.)
• 1—One description line.
• 2—Two description lines.
• 3—Three description lines.

Discounts Works in conjunction with the Discounts field in the Vendor Entry settings (page 1 of the 
Basic Setup parameter).
• Y—Displays the discount options on the Header tab of the obligation. 
• N—Hides the discount options on the Header tab of the obligation (i.e., they do not 

display on the Header tab of the obligation).
Defining the Basic Setup Parameter 
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6. Complete the required General Ledger posting fields according to Table 2.3. 

Dist tables Indicate if FundWare will allow you to apply distribution tables to obligations: 
• Y—Allows you to apply distribution tables to obligations by displaying the Auto button 

on the Detail Lines tab for combined entry or the Distribution tab for separate entry.
— For more on separate and combined entry, see Separate and Combined Entry on 

page 1.5.
• N—Hides the Auto button on the Detail Lines tab for combined entry or the 

Distribution tab for separate entry.

Table 2.3—Defining Basic Setup—Ledger Options

Field Name Description

Ledger post Unless your organization is not using the FundWare General Ledger module, this setting 
should be Y.
• Y—Allows posting to a financial reporting system (normally General Ledger).
• N—Does not allow posting to a financial reporting system.

Expense jnl Enter the name of your expense (purchasing) journal. 
• The journal must already exist. (See the Blackbaud FundWare General Ledger Guide 

for instructions to add a journal.)

Expense 
post

Specify how expense entries are posted to the General Ledger. 
• N—Post everything in detail.
• 1—Compress distribution detail only.
• 2—Compress AP only.
• 3—Compress both distribution and AP control.
• 4—Compress AP line detail (each distribution line is posted individually, except for 

control accounts which are summarized).
• 5—Post AP line detail (each distribution line is posted individually, including control 

accounts).

AP acct 
mask

Enter an account number or account mask for your AP account.

Paid jnl Enter the name of your paid (cash disbursements) journal. 
• You must define the journal before you can enter the journal name in this field. (See 

the Blackbaud FundWare General Ledger Guide for instructions to add a journal.)

Table 2.2—Defining Basic Setup—Obligation Entry Fields (Continued)

Field Name Description
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For more information on posting to General Ledger, please see 
Appendix A—Posting Transactional Data Items on page 1.201.

When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

7. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

8. Type E save the parameter and close the window.

MODIFYING THE EXTENDED SETUP PARAMETER
Once you define the Basic Setup parameter, FundWare will define the Extended Setup 
parameter with default settings. The Extended Setup parameter includes settings for 
stages, trace reports, check writing, batches, and miscellaneous items. The parameter 
also stores system information, which cannot be accessed by users. 
Use the following instructions to customize the parameter.

1.  Click Setup > Extended Setup on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > Setup > 
Extended Setup from the menu bar. The task option menu displays.

Paid post Specify how entries are posted when checks are produced 
• N—Post everything in detail.
• 1—Compress AP control only.
• 2—Compress Cash only.
• 3—Compress both AP control and cash.
• 4—Compress AP line detail (each distribution line is posted individually, except for 

control accounts which are summarized).
• 5—Post AP line detail (each distribution line is posted individually, including control 

accounts).

Discount 
mask

Enter a valid account number or account mask for your Discounts Earned account. Do 
not use this field if your organization does not use discounts. 

Table 2.3—Defining Basic Setup—Ledger Options (Continued)

Field Name Description
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2. Type C to change the default Extended Setup parameter settings. The first page 
of the parameter record displays (Figure 2.13). 

Figure 2.13—Define Extended Setup, Page 1 of 3

3. Complete the required fields according to Table 2.4. 

Table 2.4—Extended Setup Parameter—Page 1 of 3

Field Name Definition

Ledger Post Stages

Expense 
stage

Enter the stage number at which you will post expenses to General Ledger–Project/
Grant (i.e., incur the expense) or accept the default (Stage 30—Invoice).

Paid stage Accept the default (stage 60—Paid) for the stage number at which you will post paid 
transactions to General Ledger–Project/Grant (i.e., relieve the expense). 
• This must be defined as stage 60—Paid.

Invoice Stages

From: Enter the range of stages at which you can enter invoices.
• For example, in the sample divisions, the only invoice stage is 30, so you would enter 

30 in both From and To. If you added customized stages, your invoice range might be 
from 30 to 35.

• The “To” stage (i.e., the high end of the range) should be the same stage that you 
define as Ready for Pay.

To:
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Vendor Lock Stage

Lock at 
stage

Enter the stage number that specifies the stage at which the vendor number is locked 
and can no longer be modified.

Check Writing Stages

Ready to 
pay

Enter the stage number that allows invoices to be marked for payment if you don’t want 
to accept the default (stage 30—Invoice).
• This should be the last stage listed in the range of invoice stages (field 2, Figure 2.13).
• This should also be the same stage that you define as Voided.
• You should not specify any stages after the Ready to Pay stage as they will not appear 

on the folder tree.

Mark for pay Accept the default (stage 50—Marked for Payment) for the stage number that allows 
invoices to be paid.
• This must be defined as stage 50—Marked for Payment.
• Once you mark an invoice for payment at the Ready for Pay stage, FundWare moves 

the obligation to the Marked for Pay stage. From this stage, you will write your checks.

Paid Accept the default (stage 60—Paid) for the stage number that holds paid transactions 
(i.e., a check has been written and logged for the obligation).
• This must be defined as stage 60—Paid.

Reconciled Accept the default (stage 70—Reconciled) for the stage number that holds reconciled 
transactions.
• This must be defined as stage 70—Reconciled.

Voided Enter the stage number where invoices go when a check is voided or accept the default 
(stage 30—Invoice).
• This should be the same stage that you define as Ready for Pay.

Table 2.4—Extended Setup Parameter—Page 1 of 3 (Continued)

Field Name Definition
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4. Press PAGE DOWN or press ENTER to access page 2 of the Extended Setup 
parameter (Figure 2.14). 

Figure 2.14—Define Extended Setup, Page 2 of 3

5. Complete the required fields according to Table 2.5. 

Table 2.5—Extended Setup Parameter—Page 2 of 3

Field Name Definition

Trace Report Options

Description Indicate what information should include in the description on the trace report:
• 1—Vendor name. This is the default.
• 2—Obligation Description.
• 3—Distribution description.
Blackbaud, Inc. 1.57



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.58
Reference 1
Reference 2
Reference 3

The reference fields allow you to specify AP data items that will post to General 
Ledger–Project/Grant. See Posting Data Items to GL–P/G on page 1.168 for more 
information.
• A–Z—Reference code assigned to an obligation reference. A (Obligation) is the 

default for Reference 1.
• 1—A description of the activity type, e.g. transfer if the posting was caused by a 

transfer task. This is the default for Reference 2.
• 2—Nothing.
• 3—The internal check number.
• 4—The external check number. This is the default for Reference 3.
• 5—The session batch number.
The information in these reference fields can be included in the trace report, as well as 
the GL–P/G ledger (CSLEDGR) and account detail (CSACDTL) reports. (The settings in 
field 3 of the Basic Setup parameter determine the amount of detail included in the trace 
report.)

Data item 1
Data item 2
Data item 3

These fields will only display if:
• You selected Y—Post to GL in field 3 of the Basic Setup task.
• The journal to which you are posting is configured to use additional data items. See 

Posting Data Items to GL–P/G on page 1.168 for more information.
If you selected N—Do not post to GL, you will only see the Description and Reference 
fields.
For more information on designing your system to post transactional data items, see 
Appendix A—Posting Transactional Data Items on page 1.201

• 0—Nothing
• 1—Description line 1
• 2—Description line 2
• 3—Description line 3
• 4—Internal check #

• 5—External check #
• 6—Invoice date
• 7—Vendor name
• A–Z—Specific obligation reference (see Data 

Items—Obligation References on page 1.165)

Check Options

Int check 
title

Enter a term used internally (i.e., for your use before and after a check number is 
assigned) when referring to each payment (1–7 alphanumeric characters). 
• For example, the Int check title in the sample divisions is “Control.” Therefore, each 

payment has a Control number as well as a check number.

Ext check 
title

Enter a term used for your payment form (e.g., check, cheque, warrant). This term is 
used on screens and reports (1–7 alphanumeric characters).

Table 2.5—Extended Setup Parameter—Page 2 of 3 (Continued)

Field Name Definition
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6. Press PAGE DOWN or press ENTER to access page 3 of the Extended Setup 
parameter (Figure 2.15). 

Figure 2.15—Define Extended Setup, Page 3 of 3

Date format Enter the format for month, day, and year on checks.

• N—MM/DD/YYYY
• A—DD Mth, YYYY

• B—Mth DD, YYYY
• C—DD-Mth-YYYY

Amount 
format

Enter the code to indicate how the dollar amount will print on your checks.

• S—Spell check amount • N—Print numeric amount

Table 2.5—Extended Setup Parameter—Page 2 of 3 (Continued)

Field Name Definition
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7. Complete the required fields according to Table 2.6. 

When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

8. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

Table 2.6—Extended Setup Parameter—Page 3 of 3

Field Name Definition

Batch Options

Save batches Use this field to specify whether or not batches of new invoices may be saved without 
posting. Valid entries are:
• Y—Data entry may be saved.
• N—Data entry may not be saved.
While an entry is required, Blackbaud FundWare Pro/Enterprise does not provide this 
functionality. This functionality is not available in the current version of Accounts 
Payable.

Save imports Use this field to specify whether or not batches of imported invoices may be saved 
without posting. Valid entries are:
• Y—Import entry may be saved.
• N—Import entry may not be saved.

Miscellaneous Options

Report dup ref Used to report duplicate entries for obligation references for the same vendor. For 
example:
• Define “I” as the obligation reference for storing the invoice number.
• Define stage 30 (Invoices) to display reference I for editing on the Data Items tab.
• Enter “I” as a Report Dup. Ref option in the Extended Setup parameter. 
• AP compares the entries between obligations. If the entries in this field are 

duplicate, AP displays a warning message when you save the obligation and a 
warning on the Cash Requirements, Preliminary Check Register, and Check 
Register reports. 

System 
Information

The information listed in the System Information is for your information only and 
includes:
• The number of the last obligation created,
• The last run number,
• The last vendor number used, and
• The AP last batch number.
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9. Type E to save the parameter and close the window.

MODIFYING THE PURCHASE ORDER BASIC SETUP PARAMETER
Once you define the AP Basic Setup parameter, FundWare will define the Purchase 
Order Basic Setup parameter with default settings. The PO Basic Setup parameter 
allows you to define certain fields for the purchase order entry form. 
Use the following instructions to customize the parameter.

1.  Click Setup > PO Setup > PO Basic Setup on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > PO Setup > PO Basic Setup from the menu bar. The 
parameter window displays (Figure 2.16). 

Figure 2.16—Purchase Order Define Basic Setup
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2. Complete the required information according to Table 2.7. 

Table 2.7—Purchase Order Setup

Field Name Description

Obligation Entry Fields

Detail & Dist For more information on this setting, see Separate and Combined Entry on page 1.5. 
By default, this setting is Combined.
• S—Separate detail and accounting distribution entered on two screens.
• C—Combined detail and accounting distribution entered on same screen.

Detail desc Indicate if the Description field will be available on the Detail Entry window (launched 
from the Line Items tab in separate entry) or Distribution Entry window (launched from 
the Detail Lines tab in combined entry).
• Y—Description field displays.
• N—Detail description field does not display.
Depending on your AP setup, this field may be tied to the Dist desc. field on the same 
page: 
• Combined entry—This setting will match the Dist desc. setting (i.e., both will be Y or 

both will be N).
• Separate entry—This setting is independent from the Dist desc. setting.

Stock nbr Indicate if the Stock nbr field will be available on the Detail Entry window (launched 
from the Line Items tab in separate entry) or Distribution Entry window (launched from 
the Detail Lines tab in combined entry).
• Y—Stock number field displays.
• N—Stock number field does not display.

Unit/unit price Indicate if the Unit Description and Unit Price fields will be available on the Detail Entry 
window (launched from the Line Items tab in separate entry) or Distribution Entry 
window (launched from the Detail Lines tab in combined entry).
• Y—Unit description and unit price fields display.
• N—Unit description and unit price fields do not display. 

Dist desc Indicate if the Description field will be available on the Distribution Entry window 
(launched from the Distribution tab in separate entry). (If you are using combined 
entry, this setting will match the Dist desc. setting because there is only one 
description field).
• Y—Distribution description field displays.
• N—Distribution description field does not display.
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When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

3. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

Ledger Options

Commitment 
jnl

Enter the name of the commitments journal. 
• This journal must already be defined through General Ledger.
• Leave blank if your organization does not post commitments.

Commitment 
post

Indicate how the information should be posted to the to the commitment journal.
• N—Post everything in detail.
• 1—Compress distribution detail only.
• 2—Compress Reserve for Commitments Only (control).
• 3—Compress both distribution and control.
• 4—Compress line detail (each distribution line is posted individually, except for 

control accounts which are summarized).
• 5—Post AP line detail (each distribution line is posted individually, including control 

accounts).

Res Comm 
mask

Identify the Reserve for Commitments account number or mask.

Encumber jnl Enter the name of the encumbrance journal. 
• This journal must already be defined through General Ledger.
• Leave blank if your organization does not post encumbrances.

Encumber 
post

Indicate how the information should be posted to the to the encumbrance journal.
• N—Post everything in detail.
• 1—Compress distribution detail only.
• 2—Compress Reserve for Commitments Only (control).
• 3—Compress both distribution and control.
• 4—Compress AP line detail (each distribution line is posted individually, except for 

control accounts which are summarized).
• 5—Post AP line detail (each distribution line is posted individually, including control 

accounts).

Res Encum 
mask

Identify the Reserve for Encumbrance account number or mask.

Table 2.7—Purchase Order Setup (Continued)

Field Name Description
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4. Type E to save the parameter and close the window.

MODIFYING THE PURCHASE ORDER EXTENDED SETUP PARAMETER
Once you define the AP Basic Setup parameter, FundWare will define the Purchase 
Order Extended Setup parameter with default settings. The Purchase Order Extended 
Setup parameter includes settings for stages and miscellaneous items. 

Before beginning this process, you may want to define your stages. See 
Working With Stages on page 1.67 for more information.

Use the following instructions to customize the parameter.
1.  Click Setup > PO Setup > PO Extended Setup on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > PO Setup > PO Extended Setup from the menu bar. The 
parameter window displays (Figure 2.17). 

Figure 2.17—Define PO Extended Setup, Page 1 of 2
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2. Complete the required information according to Table 2.8. 

Table 2.8—Define PO Extended Setup, Page 1 of 2

Field Name Description

Ledger Post Stages

Commit stage Enter the stage number at which you will post commitments to General Ledger.

Encumber stage Enter the stage number at which you will post encumbrances to General 
Ledger or accept the default (stage 20—Purchase order).

 PO Stages

From stage Enter the first stage number (of a range) at which you will enter initial orders 
and purchase orders.
• The default entry is stage 10—Initial order.

To stage Enter the last stage number (of a range) at which you will enter initial orders 
and purchase orders.
• The default entry is stage 20—Purchase order.

Forms Options

Print POs on Indicate the type of form on which you will print your purchase orders:
• B—Blank stock
• S—Standard forms

Special forms Indicate if you will use any special forms:
• NUN—No special forms
• MI1—Special forms for Mississippi
• NM1—Special forms for New Mexico
• WI1—Special forms for Wisconsin

Scramble PO’s The option to encrypt (or “scramble”) your purchase orders is explained further 
in Encrypting Checks and Purchase Orders on page 1.127.
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3. Press PAGE DOWN or press ENTER to access page 2 of the PO Extended Setup 
parameter (Figure 2.18). 

Figure 2.18—Define PO Extended Setup, Page 2 of 2

4. Complete the required information according to Table 2.9. 

When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

5. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

6. Type E to save the parameter and close the window.

Table 2.9—Define PO Extended Setup, Page 2 of 2

Field Name Description

Misc Options

Log encumbrance Indicate if you need to store information for specific custom state forms. (Most 
clients will not use this feature.)
• Y—Log encumbrance
• N—Do not log encumbrance

Stock # title If your organization uses purchasing detail, enter the title of the stock or 
commodity code number entered (up to 15 alphanumeric characters).
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WORKING WITH STAGES
FundWare uses “stages” to mark each step in your AP process. For example, FundWare 
creates the following default stages for you when you define the Basic Setup and PO 
Basic Setup parameters:

• Initial Order (10)—Created when you define the PO Basic Setup parameter 
(Setup > PO Setup > PO Basic Setup).

• Purchase Order (20)—Created when you define the PO Basic Setup parameter 
(Setup > PO Setup > PO Basic Setup).

• Invoice (30)—Created when you define the Basic Setup parameter (Setup > 
Basic Setup).

• Approved for Payment (40)—Created when you define the Basic Setup 
parameter (Setup > Basic Setup).

• Marked for Payment (50)—Created when you define the Basic Setup parameter 
(Setup > Basic Setup).

• Paid (60)—Created when you define the Basic Setup parameter (Setup > Basic 
Setup).

• Reconciled (70)—Created when you define the Basic Setup parameter (Setup > 
Basic Setup).

You can modify these existing stages to meet the needs of your organization or you can 
add new stages.

For example, the most common change that is required for stage definitions is 
modifying the entry options (i.e., the fields that are activated in the invoice entry 
screens). 

Another possible modification is to activate stage 40, Approved for Payment 
which is non-posting. Invoices are entered at stage 30, then transferred to stage 
40 when they are approved for payment. When activated, stage 40 is the only 
stage where an invoice can be Marked for Pay.

However, do not add any stages after the system-required stage 50—Marked for 
Payment. At this point, FundWare follows specific steps to take an obligation from 
marked for pay to reconciled. Any additional stages can impact FundWare’s ability to 
process correctly.

WHEN DO STAGES APPEAR ON THE FOLDER TREE?
FundWare will add a stage to the Obligations folder on the tree when the stage meets 
the following criteria:
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• The stage is defined as the Ready for Pay stage in the Extended Setup 
parameter, or the stage number is less than the Ready for Pay stage. The Ready 
for Pay stage is the last stage folder displayed in the Obligations folder of the 
tree. (For example, in Division 95, the Ready for Pay stage is 30. We have also 
defined stage 40, which cannot display on the folder tree unless we change the 
Ready for Pay stage to 40.)
— See Modifying the Extended Setup Parameter on page 1.54 or Modifying the 

Purchase Order Extended Setup Parameter on page 1.64 for more 
information.

• At least one of the Allow Options (field 6 of the stage definition) is set to “Y” 
(i.e., allowed). 
— See Modifying Your Existing Stage Definitions on page 1.68 or Adding 

Stage Definitions on page 1.75 for more information.
Once you have defined you stage and parameters settings correctly, you must open 
System Administration HomePage, which automatically synchronizes your stages. (If 
the HomePage is already open, you can close and re-open it to synchronize your stages.) 
You should also review and/or modify the stage security settings for each user to ensure 
that they have the appropriate rights for a new or modified stage. See the Blackbaud 
FundWare System Administration Guide for more information.

MODIFYING YOUR EXISTING STAGE DEFINITIONS

Use the following instructions to modify an existing stage definition. (Customizing Your 
Obligation Forms on page 1.44 shows the impact of certain stage settings on your 
obligation entry forms.)

Remember: Stages 50, 60, and 70 are required settings for FundWare. You can 

1.  Click Setup > Master Records > Stages on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > Master Records > Stages from the menu bar. The 
Distribution Tables window displays.
Working With Stages 
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2. Type C to change the stage. The system asks you to identify the stage number 
that you want to change (Figure 2.19). (You can use the Scroll or Display 
options to review your existing stages before you begin to change the 
definitions.) 

Figure 2.19—Enter Stage Number

3. Type the stage number and press ENTER. The first page of the stage definition 
displays (Figure 2.20). 

Figure 2.20—Define Stages, Page 1 of 3
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4. Modify the settings as necessary, according to Table 2.10. 

Table 2.10—Define Stages Field Definitions, Page 1 of 3

Field Definition

Description Enter the stage description used on report headings (up to 30 alphanumeric characters). 
Note: The description may be truncated on some reports that allow less than 30 
characters.

Short desc Enter the short description displayed on screens (up to 5 alphanumeric characters). 

History 
desc

Enter the label for the history note field on the obligation entry form (up to 15 
alphanumeric characters). 
• The default is “Authorized by” for most stages.
• This field can be displayed, hidden, or disabled based on the History Note setting in 

field 7 of the stage definition. 
This label is unrelated to the History Note field displayed with you transfer obligations.

Date desc Enter the label for the stage date field on the obligation entry form (up to 15 alphanumeric 
characters).
• This field can be displayed, hidden, or disabled based on the Stage Date setting in field 

7 of the stage definition.

Batch 
totals

While an entry is required, this functionality is not applicable to current versions of 
FundWare. We recommend that you enter N—Batch totals not entered at stage.

Allow options—The allow options determine what actions can be taken on obligations at each stage.

• Allow 
enter

When this setting is Y (new obligations can be entered at this stage), the New button on 
the folder’s detail pane is enabled.
• For the check writing stages (50, 60, and 70), the system automatically sets this option 

to N since you cannot enter obligations after the Mark for Pay stage (defined in field 3 of 
the Extended Setup parameter).

• Allow 
modify

When this setting is Y (obligations can be modified at this stage), the Edit button on the 
folder’s detail pane is enabled.
• Many organizations design their AP process so that obligations cannot be modified 

after the invoice stage (defined in field 2 of the Extended Setup parameter).

• Allow 
cancel

When this setting is Y (obligations can be cancelled at this stage), the Void button on the 
folder’s detail pane is enabled.

• Allow 
transfer

When this setting is Y (obligations can be transferred to or from this stage), the Transfer 
button on the folder’s detail pane is displayed.
• The default selection is N for the check writing stages (50, 60, and 70) since the 

transfer is done automatically. 
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5. Press PAGE DOWN or press ENTER to access page 2 (Figure 2.21). 

Figure 2.21—Define Stages, Page 2 of 3

The Entry options on page 2 allow you to further customize the obligation entry 
screen. For obligation entry, FundWare creates a template that is used for all 
obligations entered in the system. Note that these fields are defined for each 
stage, depending on your definition of the Extended Setup parameter.

6. Complete the required fields according to Table 2.11. 

• Allow 
split

When this setting is Y (you can create a new obligation by splitting an existing obligation; 
the existing or new obligation can be at this stage), the Split button on the folder’s detail 
pane is displayed.
• Many organizations design their AP process so that obligations cannot be split after the 

invoice stage (defined in field 2 of the Extended Setup parameter).

Table 2.11—Define Stages Field Definitions, Page 2 of 3

Field Definition

Vendor While you can control access to the Vendor number, name, and address fields on the 
Header tab, we strongly recommend that you do not hide the Vendor field.
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).

Table 2.10—Define Stages Field Definitions, Page 1 of 3 (Continued)

Field Definition
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Description Select the level of access to the invoice description field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
You can define the number of lines allowed in the description through field 2 of the 
Basic Setup parameter.

History note Select the level of access to the 30-character history description field on the Header 
tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
You can define the field label through field 3 (History desc) of the stage definition. 
(The default label is “Authorized by.”)

Stage date Select the level of access to the stage date field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
• C—Field is calculated. The system calculates an invoice due date from the invoice 

date and the vendor’s net days (from the vendor record). See Calculating Obligation 
Due Dates on page 1.84 for more information.

You can define the field label through field 4 (Date desc) of the stage definition (e.g., 
Date ordered, Due date).

Invoice date Select the level of access to the Invoice date field on the Header tab. The date 
entered is printed on the obligation.
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).

Take discount Select the level of access to the Take discount regardless of date check box, which 
can display when an obligation is in the New Mark folder for a bank (i.e., it has been 
marked for pay but not posted to the bank’s Mark for Payment folder).
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
For more information on this feature, see The “Take Discount” Override on page 2.89.

Table 2.11—Define Stages Field Definitions, Page 2 of 3 (Continued)

Field Definition
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Discount info Select the level of access to the Discount Type field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
For more information on discounts, see Applying Vendor Discounts to Obligations on 
page 2.87.

Dist table Select the level of access to the Auto button on the Detail Lines tab (combined entry) 
or the Distribution tab (separate entry). This button provides access to distribution 
tables:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).

Amount Select the level of access to the Total Amount field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed). 
• D—Field is displayed only (i.e., displayed but disabled).
When you enter Y, FundWare validates the entry in the Total Amount field with the 
user’s entries on the Detail Lines tab (combined entry) or the Line Items/
Distribution tabs (separate entry). 
When you enter N or D, FundWare calculates the obligation total based on the entries 
on the Detail Lines tab (combined entry) or the Line Items/Distribution tabs 
(separate entry).

Detail Indicate if users must enter account detail information when adding an obligation:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
This field is linked to the Distribution field. Any setting defined for one applies to both. 
We recommend that this setting is Y.

Distribution Indicate if users must enter account detail information when adding an obligation:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
This field is linked to the Detail field. Any setting defined for one applies to both. We 
recommend that this setting is Y.

Table 2.11—Define Stages Field Definitions, Page 2 of 3 (Continued)

Field Definition
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7. Press PAGE DOWN or press ENTER to access page 3, which contains the 
references available for entry and display at each stage (Figure 2.22). 

Figure 2.22—Define Stages, Page 3 of 3

8. Complete the required fields according to Table 2.12. (These fields are mutually 
exclusive, i.e., if you enter a reference in the Entry field, you cannot also enter 
the reference in the Display field.) 

Table 2.12—Define Stages Field Definitions, Page 3 of 3

Field Definition

Entry At this stage, FundWare will display the user-defined references listed in this field in the 
Editable Data Items area of the Data Item tab of the obligation. During obligation entry, you 
can enter or modify the values for these references. 
• For example, we define a required obligation reference called P for PO number. At 

Stage 20 (our purchase order stage), we define this as an Entry data item. When users 
enter a PO, they must enter a PO number on the Data Item tab.

Enter the letter code for one or more obligation references to be displayed and editable on 
the Data Item tab for obligations at this stage. Valid entries are:
• * (asterisk)—All user-defined references are accessible. You will not be able to define any 

references as display only.
• Codes G–Z—List of user-defined references that can be accessed at this stage. 

(Reference identifiers A–F are reserved for system use and cannot be entered here.)
See Customizing Your Obligation Entry Forms by Stage on page 1.10 and Data Items—
Obligation References on page 1.165 for more information.
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When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

9. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

10. Type E save the parameter and close the window.

ADDING STAGE DEFINITIONS

Before you can add a new stage to your AP system, you must complete an override 
program. 

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

Display At this stage, FundWare will display these user-defined references and any associated 
values in the Display Only Data Items area the Data Item tab of the obligation. During 
obligation entry, you cannot enter or modify the values for these references. 
• For example, our users have been required to enter a PO number at Stage 20 (our 

purchase order stage). In Stage 30 (our invoice stage), we move this data item to the 
Display Only Data Items area. It is there for informational purposes, but cannot be edited.

Enter the letter code for one or more obligation references to be displayed on the Data Item 
tab for obligations at this stage. Valid entries are:
• * (asterisk)—All user-defined references are accessible. You will not be able to define any 

references as editable.
• Codes G–Z—List of user-defined references that can be accessed at this stage. 

(Reference identifiers A–F are reserved for system use and cannot be entered here.)
See Customizing Your Obligation Entry Forms by Stage on page 1.10 and Data Items—
Obligation References on page 1.165 for more information.

Table 2.12—Define Stages Field Definitions, Page 3 of 3 (Continued)

Field Definition
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 2.23). 

Figure 2.23—System Utilities Window

4. In the Execute Program area, enter the required information according to Table 
2.13 to run the override. 

Table 2.13—Running the Override Program

Field Entry

Program Name OTS208

Switches 20

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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5. Click Run. The program will execute and the Define Stages menu options 
display (Figure 2.24). 

Figure 2.24—Adding a Stage

Do not add any stages after the system-required stage 50—Marked for 
Payment. At this point, FundWare follows specific steps to take an 
obligation from marked for pay to reconciled. Any additional stages can 
impact FundWare’s ability to process correctly.

6. Enter A to add a stage. The system asks you to identify the stage number that 
you want to change (Figure 2.25). (You can use the Scroll or Display options to 
review your existing stages before you begin to change the definitions.) 

Figure 2.25—Enter Stage Number
Blackbaud, Inc. 1.77



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.78
7. Type the stage number and press ENTER. The first page of the stage definition 
displays (Figure 2.20). 

Figure 2.26—Adding Stages, Page 1 of 3

8. Enter the stage definition settings, according to Table 2.14. 

Table 2.14—Define Stages Field Definitions, Page 1 of 3

Field Definition

Description Enter the stage description used on report headings (up to 30 alphanumeric characters). 
Note: The description may be truncated on some reports that allow less than 
30 characters.

Short desc Enter the short description displayed on screens (up to 5 alphanumeric characters). 

History 
desc

Enter the label for the history note field on the obligation entry form (up to 15 
alphanumeric characters). 

• The default is “Authorized by” for most stages.
• This field can be displayed, hidden, or disabled based on the History Note setting in 

field 7 of the stage definition. 
This label is unrelated to the History Note field displayed with you transfer obligations.

Date desc Enter the label for the stage date field on the obligation entry form (up to 15 alphanumeric 
characters).
• This field can be displayed, hidden, or disabled based on the Stage Date setting in 

field 7 of the stage definition.

Batch 
totals

While an entry is required, this functionality is not applicable to current versions of 
FundWare. We recommend that you enter N—Batch totals not entered at stage.
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Allow options—The allow options determine what actions can be taken on obligations at each stage.

• Allow 
enter

When this setting is Y (new obligations can be entered at this stage), the New button on 
the folder’s detail pane is enabled.
• For the check writing stages (50, 60, and 70), the system automatically sets this option 

to N since you cannot enter obligations after the Mark for Pay stage (defined in field 3 of 
the Extended Setup parameter).

• Allow 
modify

When this setting is Y (obligations can be modified at this stage), the Edit button on the 
folder’s detail pane is enabled.
• Many organizations design their AP process so that obligations cannot be modified 

after the invoice stage (defined in field 2 of the Extended Setup parameter).

• Allow 
cancel

When this setting is Y (obligations can be cancelled at this stage), the Void button on the 
folder’s detail pane is enabled.

• Allow 
transfer

When this setting is Y (obligations can be transferred to or from this stage), the Transfer 
button on the folder’s detail pane is displayed.
• The default selection is N for the check writing stages (50, 60, and 70) since the 

transfer is done automatically. 

• Allow 
split

When this setting is Y (you can create a new obligation by splitting an existing obligation; 
the existing or new obligation can be at this stage), the Split button on the folder’s detail 
pane is displayed.
• Many organizations design their AP process so that obligations cannot be split after the 

invoice stage (defined in field 2 of the Extended Setup parameter).

Table 2.14—Define Stages Field Definitions, Page 1 of 3 (Continued)

Field Definition
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9. Press PAGE DOWN or press ENTER to access page 2 (Figure 2.21). 

Figure 2.27—Adding Stages, Page 2 of 3

The Entry options on page 2 allow you to further customize the obligation entry 
screen. For obligation entry, FundWare creates template that is used for all 
obligations entered in the system. Note that these fields are defined for each 
stage, depending on your definition of the Extended Setup parameter.

10. Complete the required fields according to Table 2.15. 

Table 2.15—Define Stages Field Definitions, Page 2 of 3

Field Definition

Vendor While you can control access to the Vendor number, name, and address fields on the 
Header tab, we strongly recommend that you do not hide the Vendor field.
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).

Description Select the level of access to the invoice description field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
You can define the number of lines allowed in the description through field 2 of the 
Basic Setup parameter.
Working With Stages 
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History note Select the level of access to the 30-character history description field on the Header 
tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
You can define the field label through field 3 (History desc) of the stage definition. 
(The default label is “Authorized by.”)

Stage date Select the level of access to the stage date field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
• C—Field is calculated. The system calculates an invoice due date from the invoice 

date and the vendor’s net days (from the vendor record). See Calculating Obligation 
Due Dates on page 1.84 for more information.

You can define the field label through field 4 (Date desc) of the stage definition (e.g., 
Date ordered, Due date).

Invoice date Select the level of access to the Invoice date field on the Header tab. The date 
entered is printed on the obligation.
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).

Take discount Select the level of access to the Take discount regardless of date check box, which 
can display when an obligation is in the New Mark folder for a bank (i.e., it has been 
marked for pay but not posted to the bank’s Mark for Payment folder).
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
For more information on this feature, see The “Take Discount” Override on page 2.89.

Discount info Select the level of access to the Discount Type field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
For more information on discounts, see Applying Vendor Discounts to Obligations on 
page 2.87.

Table 2.15—Define Stages Field Definitions, Page 2 of 3 (Continued)

Field Definition
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Dist table Select the level of access to the Auto button on the Detail Lines tab (combined entry) 
or the Distribution tab (separate entry). This button provides access to distribution 
tables:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).

Amount Select the level of access to the Total Amount field on the Header tab:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed). 
• D—Field is displayed only (i.e., displayed but disabled).
When you enter Y, FundWare validates the entry in the Total Amount field with the 
user’s entries on the Detail Lines tab (combined entry) or the Line Items/
Distribution tabs (separate entry). 
When you enter N or D, FundWare calculates the obligation total based on the entries 
on the Detail Lines tab (combined entry) or the Line Items/Distribution tabs 
(separate entry).

Detail Indicate if users must enter account detail information when adding an obligation:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
This field is linked to the Distribution field. Any setting defined for one applies to both. 
We recommend that this setting is Y.

Distribution Indicate if users must enter account detail information when adding an obligation:
• Y—Field is accessible (i.e., displayed and enabled).
• N—Field is not shown (i.e., not displayed).
• D—Field is displayed only (i.e., displayed but disabled).
This field is linked to the Detail field. Any setting defined for one applies to both. We 
recommend that this setting is Y.

Table 2.15—Define Stages Field Definitions, Page 2 of 3 (Continued)

Field Definition
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11. Press PAGE DOWN or press ENTER to access page 3, which contains the 
references available for entry and display at each stage (Figure 2.22). 

Figure 2.28—Define Stages, Page 3 of 3

12. Complete the required fields according to Table 2.16. (These fields are mutually 
exclusive, i.e., if you enter a reference in the Entry field, you cannot also enter 
the reference in the Display field.) 

Table 2.16—Define Stages Field Definitions, Page 3 of 3

Field Definition

Entry At this stage, FundWare will display the user-defined references listed in this field in the 
Editable Data Items area of the Data Item tab of the obligation. During obligation entry, you 
can enter or modify the values for these references. 
• For example, we define a required obligation reference called P for PO number. At 

Stage 20 (our purchase order stage), we define this as an Entry data item. When users 
enter a PO, they must enter a PO number on the Data Item tab.

Enter the letter code for one or more obligation references to be displayed and editable on 
the Data Item tab for obligations at this stage. Valid entries are:
• * (asterisk)—All user-defined references are accessible. You will not be able to define any 

references as display only.
• Codes G–Z—List of user-defined references that can be accessed at this stage. 

(Reference identifiers A–F are reserved for system use and cannot be entered here.)
See Customizing Your Obligation Entry Forms by Stage on page 1.10 and Data Items—
Obligation References on page 1.165 for more information.
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When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

13. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

14. Type E save the parameter and close the window.

CALCULATING OBLIGATION DUE DATES

You can define your AP system to calculate the due date for your invoices. (This feature 
applies to any obligation; however, you will most often use it for invoices.) Use the 
following general instructions to define your system to calculate due dates.

1.  Click Setup > Basic Setup on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > Setup > 
Basic Setup from the menu bar. The task option menu displays.

2. Type D to display or C to change the parameter.

Display At this stage, FundWare will display these user-defined references and any associated 
values in the Display Only Data Items area the Data Item tab of the obligation. During 
obligation entry, you cannot enter or modify the values for these references. 
• For example, our users have been required to enter a PO number at Stage 20 (our 

purchase order stage). In Stage 30 (our invoice stage), we move this data item to the 
Display Only Data Items area. It is there for informational purposes, but cannot be edited.

Enter the letter code for one or more obligation references to be displayed on the Data Item 
tab for obligations at this stage. Valid entries are:
• * (asterisk)—All user-defined references are accessible. You will not be able to define any 

references as editable.
• Codes G–Z—List of user-defined references that can be accessed at this stage. 

(Reference identifiers A–F are reserved for system use and cannot be entered here.)
See Customizing Your Obligation Entry Forms by Stage on page 1.10 and Data Items—
Obligation References on page 1.165 for more information.

Table 2.16—Define Stages Field Definitions, Page 3 of 3 (Continued)

Field Definition
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3. Confirm that the Terms option on the Basic Setup parameter is defined as Y—
Used. This setting enables the Net Days field on the Discounts tab of the vendor 
record and is found in field 1 on page 1 of the parameter (Figure 2.29). 

Figure 2.29—Example Basic Setup Parameter Defined to Allow Terms

4. If necessary, modify the parameter to enable this feature.

5. Exit the parameter, saving any changes.

6. Click Setup > Master Records > Stages on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > Master Records > Stages from the menu bar. The task 
option menu displays.

7. Type C to change the stage.

8. Enter the stage to be modified.
Blackbaud, Inc. 1.85



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.86
9. Modify the stage definition so that the setting for field 7: Stage Date is C—Field 
is calculated (Figure 2.30). See Modifying Your Existing Stage Definitions on 
page 1.68 for specific instructions to define your stages. 

Figure 2.30—Defining the Stage Date for Calculation

10. On the Discounts tab of the vendor record, enter the Net Days that the program 
will use to calculate the due date (i.e., the number of days after the invoice date 
that payment is due) (Figure 2.31). 

Figure 2.31—Example Discounts Tab Defined for Vendor 800
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11. When you create an obligation and enter the obligation date (e.g., invoice date), 
the system adds the net days to the obligation date to determine the due date. As 
shown in Figure 2.31, we defined a Net Days of 10 for vendor 800. Therefore, 
when we create an obligation at Stage 30 (i.e., invoice) for vendor 800, 
FundWare adds 10 days the stage date (i.e., the Invoice Date in Division 95) 
(Figure 2.32). 

Figure 2.32—Example Invoice for Vendor 800 With Calculated Due Date

DEFINING YOUR CHECK FORMAT
Accounts Payable provides a standard check format that is 8½” wide by 7” long with the 
stub on top and the check on the bottom. This check format is selected automatically 
when you add the check format parameter. (This parameter does not exist until you add 
it to the system.)
However, since many organizations want to format their own checks, the Define Check 
Format task allows for modification to the standard form. 

ADDING THE STANDARD CHECK FORMAT

Use the following steps to add the check format parameter, which defines the standard 
check format.
Blackbaud, Inc. 1.87



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.88
1.  Click Setup > Master Records > Check Format on the module navigator (if 
the module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > Master Records > Check Format from the menu bar. The 
task option menu displays.

2. Type A to add the record.

3. Press ENTER, use the down arrow, or PAGE DOWN to move through the fields, 
accepting the default entries. When you have completed your entries, the system 
offers you the chance to return to a field or accept your entries.

4. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

5. Type E to end the session and close the window.

MODIFYING THE STANDARD CHECK FORMAT

If your organization wants to format your own checks, the Accounts Payable > Setup > 
Master Records > Check Format task allows you to define:

• Size and position of the stub portion of check,
• Stub contents,
• Sorting options for checks: vendor number or data item,
• Position of information on actual check portion, and
• Use of laser printing.

Formatting the check requires the entry of character positions and field sizes for the 
various fields printed on the check. A print layout form is helpful when formatting your 
checks. If you have preprinted checks, your printer may be able to furnish print layout 
information.
The following terms are used in the Define Check Format task:

• Column—The starting vertical position of a piece of information in characters. 
If you enter zero (0), FundWare will not print the field. Valid values are 0 (zero) 
to 132. For example, a Column value of 6 places information six characters 
from the left margin.

• Length—Defines the number of allowed characters for a field. For example, a 
Length of 10 means that 10 characters are allowed for the field on the check.

• Line—The horizontal position of a piece of information. Lines are counted from 
the top of the form. You can enter zero (0) to suppress printing of the field.
Defining Your Check Format 
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• Option—Field specific information. Press F1 for a list of valid options.
• Laser printing—This option is now handled through the FundWare Print 

Manager. You will be asked to enter a negative setting.
Use the following instructions to modify the standard check format.

1.  Click Setup > Master Records > Check Format on the module navigator (if 
the module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > Master Records > Check Format from the menu bar. The 
task option menu displays.

2. Type C to change the check format. The first page displays (Figure 2.33), which 
allows you to define the stub options, sorting options, and miscellaneous 
printing settings.

Figure 2.33—Define Check Format, Page 1 of 7

3. Complete page 1 of the check format options according to Table 2.17. 

Table 2.17—Define Check Format Field Definitions—Page 1 of 7

Field Definition

Stub print opts

Nbr stub 
lines

Indicate the number of individual obligation detail lines (this number does not include 
the five lines required for stub field descriptions):
• 0—No stub is printed.
• 3–99—Indicates the number of detail lines printed on the stub. 
The default value is 16.
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Nbr check 
lines

Indicate the number of lines on the check portion of the check (also referred to as the 
form definition in field 3, define check format).
• The default value is 22; however, we recommend that you use 21 instead.

Overflow 
lines

Indicate how FundWare will handle obligations where the detail lines exceed the 
allowed maximum in Nbr stub lines. 
• 1—Standard overflow. Stub is printed with as many detail lines as possible, check is 

voided and additional obligations are printed on the next check. As many checks as 
necessary are used until all detail lines are printed. Voided checks are automatically 
marked as unused when checks are logged. The final check amount will be for the 
total amount of all obligations for the vendor.

• 2—Compress overflow to one line. Detail lines are printed for the number of stub lines 
minus one. Obligations that will not fit on stub are summed into one line printed with 
the description *** Remaining Detail ***. Only one check is used.

• 3—Produce overflow print file (OTOVFLO.L##). Detail lines are printed for obligations 
up to the number of stub lines minus one and the check is printed for the total amount. 
A separate print file is created with the obligation detail that would not fit on the check 
stub. Only one check is used. (This is the recommended selection.)
— If the Distribution option in field 2, Stub Print Defs, is set to print the General 

Ledger account number on the check stub, this Overflow Lines option is 
automatically set to 3. Overflow information then prints to a file rather than to the 
physical check stubs.

Suppress 
hdngs

Select the applicable option for printing the column headings: 
• Y—Suppress stub column headings.
• N—Do not suppress headings (i.e., FundWare will print column headings).

Suppress 
Ffeed

Select the applicable option for the initial form feed:
• Y—Suppress initial form feed. The first check prints on the check form currently in the 

printer. The waste of check forms is determined by the printer and the operating 
system.

• N—Do not suppress initial form feed. Advances one form, then prints the first check.

Suppress 
Fcount

Indicate if FundWare should print or suppress the number of lines printed:
• Y—Suppress the **** Number of lines printed **** message.
• N—Do not suppress the **** Number of lines printed **** message. One form is lost at 

the end since it contains this message.

Table 2.17—Define Check Format Field Definitions—Page 1 of 7 (Continued)

Field Definition
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You can only print one check stub through Accounts Payable. 
However, you can use the Advanced Printer Control add-on feature to 
print two stubs if needed by your organization. Please contact your 
FundWare sales representative or Value-Added Reseller for more 
information.

4. Press PAGE DOWN or press ENTER to access page 2 of the check format (Figure 
2.34), which defines the placement of the stub items. 

Figure 2.34—Define Check Format, Page 2 of 7

5. Complete page 2 of the check format options according to Table 2.18. 

Table 2.18—Define Check Format Field Definitions—Page 2 of 7

Field Definition

Stub print defs—This field defines the contents and placement of information on the print stub. For each 
possible field on the check stub, a Column and Length must be specified.

Control nbr Determine the location of the system-assigned control number. This number is in 
three portions: run number, internal control number, and form sequence of check. 
• The field length must be 21 characters or greater. 
• This value is always printed in the second line of the stub title.

Obligation nbr Determine the location of the system-assigned obligation number. 
• The field length must be 9 characters or greater.
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Obligation 
desc

Determine the location of the Description Line 1 from the obligation (up to 30 
characters).
• The obligation allows up to 35 characters. Therefore, the description may be 

truncated on the check stub.
• The description may also be truncated on certain reports that allow fewer than 

30 characters. 
• Enter zero (0) to suppress printing of the field.

Ref 1, 2, and 3 Determine the location of the references (up to three) defined on the By Use tab of 
Financial Institutions account definition. Each field can display up to 15 characters.
• The description displayed is taken from the data item definition.
• If you specify a length less than 15 characters, the reference may be truncated.
• Enter 0 (zero) to suppress printing of the field.

Obligation amt Determine the location of the total obligation, discount, if taken, and net amounts. 
• Maximum field size in the obligation record is 999,999,999,999,999.99. 

Distribution Determine the location of the general ledger account number(s) to which the 
purchase is charged. 
• The default value for the field is 0 (zero). 
• If this option is set to print the General Ledger account number on the check stub, 

the Overflow Lines item in field one, Stub Print Opts, is automatically set to 
option 3, Produce Overflow Print File. Overflow information then prints to a file 
rather than to the physical check stubs.

Check date Determine the location of the date of the check. This date is ALWAYS printed in the 
second line of the stub title. The default value for the field is 0 (zero). 
• Note: The date prints on the same line as the control number. 

Table 2.18—Define Check Format Field Definitions—Page 2 of 7 (Continued)

Field Definition
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6. Press PAGE DOWN or press ENTER to access page 3 of the check format (Figure 
2.35), which defines the placement of items on the check portion of the form. 

Figure 2.35—Define Check Format, Page 3 of 7

7. Complete page 3 of the check format options according to Table 2.19. 

Table 2.19—Define Check Format Field Definitions—Page 3 of 7

Field Definition

Form print defs—This field defines how the check portion of the form is printed. For each field Line, 
Column, Length, and Option values may be entered. Not all of these options are entered in every field.

Control nbr Determine the location of the system-assigned control number. This number is in 
three portions: run number, internal control number, and form sequence of check. 
• The field length must be 21 characters or greater. 
• This value is always printed in the second line of the stub title.

Amount 
(alpha)

Determine the location of the dollar amount of the check (minimum 40 characters). 
• The format for the date is determined by the setting in field 5 (Amount format) of the 

Extended Setup parameter.
• An additional option for this setting is to allow the amount to print on one line or two.
• If amount does not require the maximum size, this area of the check is filled with 

asterisks (*) to prevent modification of amount.

Date Determine the location of the date of the check. The format for the date is determined 
by the setting in field 5 (Date format) of the Extended Setup parameter.
• The Define Extended Setup task defines the date format. 
• Minimum length is 12 characters.
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8. Press PAGE DOWN or press ENTER to access page 4 of the check format (Figure 
2.36), which defines the use of laser printing and placement of the stub and 
check. 

Figure 2.36—Define Check Format, Page 4 of 7

Amount 
(number)

Determine the location of the numeric amount of check (minimum 21 characters). 
• If amount does not require the maximum size, this area of the check is filled with 

asterisks (*) to prevent modification of check amount.

Address 1–5 Determine the location of the name and address of vendor. 
• See Adding Vendor Records on page 2.39 for information about maximum field 

sizes. 
• If you specify a length less than length allowed on the vendor record, the 

information may be truncated.

Table 2.19—Define Check Format Field Definitions—Page 3 of 7 (Continued)

Field Definition
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9. Press PAGE DOWN or press ENTER to access page 5 of the check format (Figure 
2.37), which defines the use of laser codes. 

Figure 2.37—Define Check Format, Page 5 of 7

10. Complete page 4 of the check format options according to Table 2.20. 

Table 2.20—Define Check Format Field Definitions—Page 4 of 7

Field Definition

Laser Print Select—The laser print functions are now accessed through Print Manager templates

Laser format • Enter N—Laser format for checks is not used. 
— This option is no longer used by the system; therefore, you cannot choose Y.

Check vertical • Enter N—Check vertical position is not used. A standard check with stub on the top 
is used. 
— This option is no longer used by the system; therefore, you cannot choose Y.

Stub vertical • Enter N—Stub vertical position is not used. A standard check with stub on the top is 
used. 
— This option is no longer used by the system; therefore, you cannot choose Y.
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11. Complete page 5 of the check format options according to Table 2.21. 

Table 2.21—Define Check Format Field Definitions—Page 5 of 7

Field Definition

Laser Printing—This field defines the use and position of numerous laser codes. However, because 
laser printing is not supported, 

Send init code Enter N—Do not use initial codes. This feature is no longer supported.

Check symbol Enter N—Check symbol is not printed. This feature is no longer supported.

Signature Enter N—Do not print signature. This feature is no longer supported.

Logo Enter N—Do not print company logo. This feature is no longer supported.

Bank logo Enter N—Do not print bank logo. This feature is no longer supported.

AUX on-us Enter N—Do not print auxiliary on-us codes. This feature is no longer supported.

Transit (MICR) Enter N—Do not print transit codes. This feature is no longer supported.

On-us (MICR) Enter N—Do not print on-us codes. This feature is no longer supported.

MICR font Enter N—MICR font is not used. This feature is no longer supported.

Send addit code Enter N—Additional codes are not used. This feature is no longer supported.

Send term code Enter N—Do not send termination codes. This feature is no longer supported.
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12. Press PAGE DOWN or press ENTER to access page 6 of the check format (Figure 
2.38), which defines the laser codes. 

Figure 2.38—Define Check Format, Page 6 of 7

13. Complete page 6 of the check format options according to Table 2.22. 

Table 2.22—Define Check Format Field Definitions—Page 6 of 7

Field Definition

Laser Codes—This field defines the actual laser codes. You are only prompted for fields that were 
activated in the Laser Printing field. For all of these fields, a single pipe symbol (|) indicates an escape 
character; a double pipe symbol (||) indicates a carriage return/new line sequence.

Init codes Select “Not in use.” This feature is no longer supported.
• The initial codes (20 characters).

Check symb code Select “Not in use.” This feature is no longer supported.
• The check symbol codes.

Signature code Select “Not in use.” This feature is no longer supported.
• The codes that make up the signature (55 characters).

Logo code Select “Not in use.” This feature is no longer supported.
• The codes that define the company logo (55 characters).

Bank logo codes Select “Not in use.” This feature is no longer supported.
• The codes that define the bank logo (55 characters).
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AUX on-us codes Select “Not in use.” This feature is no longer supported.
• The auxiliary on-us codes in the MICR line.

— space = prints space
— 0 through 9 = print nbr
— & = transit symbol
— $ = amount symbol
— / = on-us symbol
— - = dash symbol
— @ = check number

Transit codes Select “Not in use.” This feature is no longer supported.
• The transit codes in the MICR line.

— space = prints space
— 0 through 9 = print nbr
— & = transit symbol
— $ = amount symbol
— / = on-us symbol
— - = dash symbol
— # = bank number

On-us codes Select “Not in use.” This feature is no longer supported.
• The on-us codes in the MICR line.

— space = prints space
— 0 through 9 = print nbr
— & = transit symbol
— $ = amount symbol
— / = on-us symbol
— - = dash symbol
— @ = check number

MICR font code Select “Not in use.” This feature is no longer supported.
• The font for the MICR line (55 characters).

Additn’l codes Select “Not in use.” This feature is no longer supported.
• The additional codes (55 characters).

Terminate codes Select “Not in use.” This feature is no longer supported.
• The termination codes (20 characters).

Table 2.22—Define Check Format Field Definitions—Page 6 of 7 (Continued)

Field Definition
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14. Press PAGE DOWN or press ENTER to access page 7 of the check format (Figure 
2.39), which defines the data item by which FundWare sort checks. 

Figure 2.39—Define Check Format, Page 7 of 7

15. Complete page 7 of the check format options according to Table 2.23. 

Once you have entered all of the information for formatting your check, it is important 
that you test it. The Produce Sample Checks task allows you to test your format. We 
suggest that you print the sample checks on regular paper before testing on check stock.

Fields 4, 5 and 6 are ignored during the Produce Sample Checks process.

Table 2.23—Define Check Format (Page 7 of 7) Field Definitions

Field Definition

Sort checks by This field allows you to specify a data item to sort checks by—this determines the 
order in which the checks are printed. You may want to print in alphabetical order 
(sort by sortkey) or by postal code. Press F1 to see a list of all current data items.

Data item The data item to sort by.

Scramble checks The option to encrypt (or “scramble”) your checks is explained further in 
Encrypting Checks and Purchase Orders on page 1.127.
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PRINTING SAMPLE CHECKS

Once you have entered your new check format, you should test the design. The Print 
Sample Checks option will completely fill each field on the check with a value (not 
actual data, but usually the field name) so that you can see where the data will appear on 
the form. This can be very helpful when trying to determine if you have aligned the 
fields correctly. 

If you are not comfortable using this option, you can copy your existing data to 
a test division (Division Maintenance task) and print sample checks from this 
division.

You cannot complete this task until you define your Financial Institution 
accounts (FIAs). Please see Chapter 4—Using the Financial Institutions 
Feature on page 1.135 for more information.

1.  Click Setup > Master Records > Print Sample Checks on the module 
navigator (if the module is not expanded, click Accounts Payable first) or 
select Accounts Payable > Setup > Master Records > Print Sample Checks 
from the menu bar. 

2. Enter the bank (or FIA) name. To see a list of the FIAs defined through 
Financial Institutions, press F1 (Figure 2.40). 

Figure 2.40—Selecting an FIA

3. If your entry is correct, press ENTER through the screen. The sample checks will 
print to your default printer.

 

Defining Your Check Format 
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COMPLETING ADDITIONAL AP SETUP TASKS

In addition to the required setup tasks (e.g., defining the Basic Setup parameter), you 
will also define the following additional tasks to complete the configuration of your AP 
system:

• Custom forms
• Distribution tables
• City and location abbreviations
• Check and Purchase Order encryption
• Distribution report parameter (discussed Defining the Distribution Report 

Parameter on page 1.130)
This chapter addresses these additional tasks. For more information on the required 
tasks, see Chapter 2—Defining Your Parameters and Stages on page 1.39.

DEFINING CUSTOM FORMS
By defining custom forms, you can tailor forms to meet the specific needs of your 
organization. Use the following instructions to customize the forms parameter.

The FORM1 example shown in the following figures was copied from the 
standard purchase order form. 

1.  Click PO Forms > Define Custom Form on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > PO Forms > Define Custom Form from the menu bar. 

2. Type A to add a form or C to change an existing form. The system asks you to 
enter the name of the form.

3. Enter up to 5 alphanumeric characters and press ENTER. If you are adding a 
form, the system asks if you are copying the new form from an existing form.
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4. If necessary, enter the name of the form that you are copying. The first page of 
the parameter displays (Figure 3.1). 

Figure 3.1—Define Custom Form, Page 1 of 6

5. Complete the required information according to Table 3.1. 

Table 3.1—Define Custom Form, Page 1 of 6

Field Definition

Form name Enter the name of the form (up to 5 alphanumeric characters).

Description Enter a description of the form.

Miscellaneous

Form

• Lines Enter the number of lines on the form (up to 66 lines).

• Columns Enter the width of the form in characters (up to 132 characters allowed).
Defining Custom Forms 
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 Detail

• Spacing Enter the spacing for the detail area of your form. Each number equals the spacing, and 
you can enter up to 9. For example:
• 0—No line prints
• 1—Single spacing
• 2—Double spacing

• Lines Enter the maximum number of detail lines per form (up to 66 lines). 

• Titles Enter the applicable option for titles on your custom form.
• N—No title, can be used with pre-printed forms.
• 1—One title line
• 2—Two title lines

Distribution

• Spacing Enter the spacing for the distribution area of your form. Each number equals the 
spacing, and you can enter up to 9. For example:
• 0—No line prints
• 1—Single spacing
• 2—Double spacing

• Lines Enter the maximum number of obligation lines per form (up to 66 lines). Excess lines 
print on the next form.

• Titles Select the applicable option for titles on your custom form:
• 0—No line prints, can be used with pre-printed forms.
• 1—Single spacing
• 2—Double spacing.

Next form 
from

Select the source of the form numbering:
• N—No form number is printed
• U—User-defined numbering set up in the Produce Custom Forms task.
• P—A 9-digit number maintained by the system.

Update form This option allows you to update a specified reference with the form number.
• N—No form number updating.
• R—Update reference with form. You must then specify the reference.

Table 3.1—Define Custom Form, Page 1 of 6 (Continued)

Field Definition
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6. Press PAGE DOWN or press ENTER to access page 2 of the Define Custom Forms 
task (Figure 3.2), which defines the header information. 

Figure 3.2—Define Custom Form, Page 2

Auto transfer If you activate the Auto transfer option, FundWare will transfer the selected obligations 
to a new stage when you produce the custom form. Specifically, FundWare will:
• Transfer the obligation to the new stage automatically when you produce the custom 

form. (The obligations included in the report are determined when you produce 
custom forms.)

• Create a General Ledger posting.
• Create a journal entry.
• Create a trace report.
Your options are:
• N—No automatic transfer.
• Y—Automatic transfer allowed. You are prompted for a From stage (i.e., current stage 

for the PO) and To stage (i.e., the stage to which the obligations will be transferred). 

Table 3.1—Define Custom Form, Page 1 of 6 (Continued)

Field Definition
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7. Complete the required information for the form header according to Table 3.2. 

Table 3.2—Define Custom Form, Page 2 of 6

Field Definition

Form 
number

Select the option for printing the form number.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

width of field (up to 15 characters), and number of lines used (i.e., “count”).
• R—Field will be printed from a reference. You must identify the print location on the 

form—line, column, width of field (up to 15 characters), and reference.

Invoice to Select the option for printing the Invoice To information. 
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

width of field, and number of lines used (i.e., “count”). You can use up to 5 lines with 
35 characters each.

• R—Field will be printed from a reference. You must identify the print location on the 
form—line, column, width of field, and reference. You can use up to 5 lines with 
35 characters each.

Ship to Enter option for printing the Ship To information. 
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

width of field, and number of lines used (i.e., “count”). You can use up to 5 lines with 
35 characters each.

• R—Field will be printed from a reference. You must identify the print location on the 
form—line, column, width of field, and reference.

Ship 
attention

Enter option for printing the Ship Attention information. 
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field. You can use up to 5 lines with 35 characters each.
• R—Field will be printed from a reference. You must identify the print location on the 

form—line, column, width of field, and reference. You can use up to 5 lines with 
35 characters each.
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8. Press PAGE DOWN or press ENTER to access page 3 of the Define Custom Forms 
task (Figure 3.3), which formats vendor header information. 

Figure 3.3—Define Custom Form, Page 3

9. Complete the required information for the vendor information according to 
Table 3.3. 

Terms Enter option for printing the Terms information. You can use up to 5 lines with 
35 characters each.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field. You can use up to 5 lines with 35 characters each.
• R—Field will be printed from a reference. You must identify the print location on the 

form—line, column, width of field, and reference. You can use up to 5 lines with 
35 characters each.

Table 3.3—Define Custom Form, Page 3 of 6

Field Definition

Number Enter option for printing the vendor number. You can use up to 9 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field.

Table 3.2—Define Custom Form, Page 2 of 6 (Continued)

Field Definition
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Name Enter option for printing the vendor name. You can use up to 35 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field.

Address Enter option for printing the vendor address. You can use up to 5 lines with 
35 characters each.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

width of field, and number of lines used (i.e., “count”).

Alt address Enter option for printing the alternate vendor address. You can use up to 5 lines with 
35 characters each.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

width of field, and number of lines used (i.e., “count”).

Phone 
number

Enter option for printing the phone number. You can use up to 14 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field.

Fax number Enter option for printing the fax number. You can use up to 14 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field.

Notes 1–5 Enter option for printing Notes 1 through 5. You can use up to 20 characters per note
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, column, 

and width of field.

Table 3.3—Define Custom Form, Page 3 of 6 (Continued)

Field Definition
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10. Press PAGE DOWN or press ENTER to access page 4 of the Define Custom Forms 
task (Figure 3.4), which formats obligation header information. 

Figure 3.4—Define Custom Form, Page 4

11. Complete the required information for the obligation header according to Table 
3.4. 

Table 3.4—Define Custom Form, Page 4 of 6

Field Definition

Obl desc line 1 Enter option for printing obligation description line 1. You can use up to 30 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

History note Enter option for printing a history note. You can use up to 30 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Stage date Enter option for printing the stage date. You can use up to 12 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.
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Invoice date Enter option for printing the invoice date. You can use up to 12 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Stage total (1) Enter option for printing the Stage total (1). You can use up to 
999,999,999.99 digits. 
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Stage total (2) Enter option for printing the Stage total (2). You can use up to 
999,999,999.99 digits. This total prints at the defined location.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Obl total (1) Enter option for printing the Obligation total (1). You can use up to 
999,999,999.99 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Obl total (2) Enter option for printing the Obligation total (2). You can use up to 
999,999,999.99 digits. This total prints at the defined location.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

All references Enter option for printing all obligation references. You can use up to 15 characters 
each. (Each reference will print on a separate line.)
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, width of field, and number of lines used (i.e., “count”).

Table 3.4—Define Custom Form, Page 4 of 6 (Continued)

Field Definition
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12. Press PAGE DOWN or press ENTER to access page 5 of the Define Custom Forms 
task (Figure 3.5), which formats obligation detail. 

Figure 3.5—Define Custom Form, Page 5

13. Complete the required information for the obligation detail and distribution 
information according to Table 3.5. 

Table 3.5—Define Custom Form, Page 5 of 6

Field Definition

Obl Detail

Item number Enter option for printing the item number. You can use up to 30 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Description Enter option for printing the item description. You can use up to 12 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Stock nbr Enter option for printing the stock number. You can use up to 12 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.
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Quantity Enter option for printing the quantity. You can use up to 14 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Units Enter option for printing the units. You can use up to 999,999,999.99 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Unit price Enter option for printing the unit price. You can use up to 999,999,999.99 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Amount Enter option for printing the obligation amount. You can use up to 
999,999,999.99 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.
• 1—Account description is printed.
• 2—Account number and description are printed.
• 3—Alias 1 is printed.
• 4—Alias 2 is printed.

Obl Distribution Print

Item number Enter option for printing the item number. You can use up to 9,999 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Account Enter option for printing the account. You can use up to 30 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Description Enter option for printing the description. You can use up to 55 characters.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Table 3.5—Define Custom Form, Page 5 of 6 (Continued)

Field Definition
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14. Press PAGE DOWN or press ENTER to access page 6 of the Define Custom Forms 
task (Figure 3.6), which formats obligation detail. 

Figure 3.6—Define Custom Form, Page 6

15. Complete the required information for printing references 1–10 according to 
Table 3.6. 

Amount Enter option for printing the distribution amount. You can use up to 
999,999,999.99 digits.
• N—Field will not be printed.
• Y—Field will be printed. You must identify the print location on the form—line, 

column, and width of field.

Table 3.6—Define Custom Form, Page 6 of 6

Field Definition

Reference 
1–10

Enter option for printing the applicable reference (i.e., 1–10). 
• N—Reference will not be printed.
• R—Reference will be printed. You must identify the print location on the form—line, 

column, width of field, and reference (press F1 to select from a list of references).
• T—Reference will be printed with a title. You must identify the print location on the 

form—line, column, width of field, and reference.

Table 3.5—Define Custom Form, Page 5 of 6 (Continued)

Field Definition
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When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

16. Type 0 to accept your entries. Once your settings have been loaded, the option 
menu displays.

17. Type E to save the parameter and close the window.

WORKING WITH DISTRIBUTION TABLES
A distribution table is a set of up to 99 accounts/account masks and percentages that 
specify how to allocate an obligation. Once created, distribution tables are selectable 
when you enter obligations. This reduces data input and the possibility of errors. You 
can define as many distribution tables as necessary for your organization. However, you 
can only assign one table to each obligation.

HOW DISTRIBUTION TABLES BUILD ACCOUNTS

When you apply a distribution table, FundWare determines the accounts impacted by the 
action using the following formula:

1.  The process begins with the accounts or account masks in the distribution table. 
If no masking characters (X) exist in the table, the accounts in the table are used 
exactly as defined.

2. When you apply a distribution table to an obligation, you can enter an account 
number or mask (necessary if any of the distribution table entries are masked). 

3. AP replaces any masked characters in the distribution table accounts with 
values from the account number/mask entered when you apply a distribution 
table to an obligation (see Figure 3.10—Auto Distribution Window).

4. The percentages entered on the lines of the distribution table do not need to total 
100%. If you enter less than 100%, the extra amount required to total 100% is 
stored as the surplus percentage.

DEFINING DISTRIBUTION TABLES

Use the following steps to add a distribution table.
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1.  Click Maintenance > Distribution Tables on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Distribution Tables from the menu bar. A list of the 
current distribution tables displays (Figure 3.7). 

Figure 3.7—Current Distribution Tables

You can click a column heading to sort the distribution tables by the 
column entries. You can also find a specific table by typing the name 
(or first few characters) in the Locate Distribution by Name field; 
FundWare will search for the matching table.
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2. Click New or right-click and select New from the shortcut menu. The entry 
window displays (Figure 3.8). 

Figure 3.8—Adding a Distribution Table

3. Complete the window using the definitions in Table 3.7.

Table 3.7—Adding a Distribution Table

Field Description

Name Name of the distribution table. Maximum size = 10 characters.

Description Description displayed for data entry. Maximum size = 30 characters.

Last Updated Date this table was last updated. 
• Read only (i.e., not editable).

By User The User ID of the last person who updated the table. 
• Read only (i.e., not editable).

Surplus Mask Account or account mask to use for the remainder if the total distribution is less 
than 100%.
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4. Click OK. FundWare saves your entries and closes the distribution table 
definition.

APPLYING A DISTRIBUTION TABLE TO AN OBLIGATION

Once you add a distribution table, the table is available when you enter an obligation. 

Surplus Percentage The percentage remaining if less than 100% is assigned. AP calculates this 
number as each account line is added to the table. 
• Read only (i.e., not editable).

Distribution—Enter up to 99 distribution lines.

• Account Account number or mask. 
• Do not enter just part of the account number or mask. 

• Description Account or mask description.

• Percentage Percentage of obligation amount to allocate to this account.

Table 3.7—Adding a Distribution Table (Continued)

Field Description
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1.  Access the Distribution tab (separate entry) or Detail Lines tab (combined 
entry) of the new obligation (Figure 3.9). 

Figure 3.9—Distribution and Detail Lines Tabs

2. Click Auto. The Auto Distribution window displays (Figure 3.10). 

Figure 3.10—Auto Distribution Window

3. Select the distribution table from the Table drop-down list.

4. In the Account mask field, enter the numbers necessary to resolve the accounts 
in the distribution table. (For information on how FundWare applies this entry, 
see How Distribution Tables Build Accounts on page 1.113.) 
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• Type zero (0) in the positions where the distribution table account has non-
masked characters (i.e., 0–9). 

• Click  to access your distribution tables and review the account masks 
defined.

5. Click OK.

EDITING A DISTRIBUTION TABLE 
Use the following steps to edit an existing distribution table.

1.  Click Maintenance > Distribution Tables on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Distribution Tables from the menu bar. The 
Distribution Tables window displays (Figure 3.11). 

Figure 3.11—Editing a Distribution Table

2. Select the table you want to edit.

You can click a column heading to sort the distribution tables by the 
column entries. You can also find a specific table by typing the name 
(or first few characters) in the Locate Distribution by Name field; 
FundWare will search for the matching table.

3. Double-click, click Edit, or right-click and select Edit from the shortcut menu.
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4. The distribution table definition displays.

5. Edit the distribution table, as necessary.

6. Click OK. FundWare saves your changes and closes the distribution table 
definition.

DELETING A DISTRIBUTION TABLE

Use the following steps to delete an existing distribution table.
1.  Click Maintenance > Distribution Tables on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Distribution Tables from the menu bar. The 
Distribution Tables window displays.

2. Select the distribution table you want to delete.

3. Click Delete or right-click and select Delete from the shortcut menu. A 
confirmation message displays.

4. Click Yes to delete the table. The distribution table is deleted from the division.

DEFINING CITY ABBREVIATIONS
City abbreviations can cut down on your data entry when you have a number of vendors 
with common city addresses. When you apply a city abbreviation to the city field of a 
vendor record or obligation for a one-time vendor, FundWare automatically enters the 
city, state, postal code, and country. You are saved the time of retyping the city every 
time.
Use the following steps to add a city abbreviation.
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1.  Click Maintenance > Cities on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > 
Maintenance > Cities from the menu bar. The AP City Maintenance data 
window displays (Figure 3.12).

Figure 3.12—Adding A City Abbreviation

2. Click New or right-click and select New from the shortcut menu. The City 
Abbreviation Maintenance window displays (Figure 3.13). 

Figure 3.13—City Abbreviation Maintenance
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3. Enter the required information according to Table 3.8. 

4. Click Apply to save the information or OK to save the information and exit the 
window.

EDITING CITY ABBREVIATIONS

Use the following steps to edit a city abbreviation.
1.  Click Maintenance > Cities on the module navigator (if the module is not 

expanded, click Accounts Payable first) or select Accounts Payable > 
Maintenance > Cities from the menu bar. The AP City Maintenance data 
window displays.

2. Select the city abbreviation to be edited from the data window.

3. Double-click, click Edit, or right-click and select Edit from the shortcut menu. 
The City Abbreviation Maintenance window displays.

4. Edit the information as necessary.

5. Click Apply to save the information or OK to save the information and exit the 
window.

DELETING CITY ABBREVIATIONS

Use the following steps to delete a city abbreviation.
1.  Click Maintenance > Cities on the module navigator (if the module is not 

expanded, click Accounts Payable first) or select Accounts Payable > 
Maintenance > Cities from the menu bar. The AP City Maintenance data 
window displays.

Table 3.8—City Abbreviation Maintenance

Field Name Description

Abbreviation A unique abbreviation for the city (up to 3 alphanumeric characters).

City City name (up to 19 alphanumeric characters).

S/T/P State, territory, or province (up to 5 alphanumeric characters).

Postal Code Postal code (US zip code) (up to 9 alphanumeric characters).

Country Country name (up to 35 alphanumeric characters).
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2. Select the city abbreviation to be deleted from the data window.

3. Click Delete or right-click and select Delete from the shortcut menu. A 
confirmation message displays.

4. Click Yes to delete. The city abbreviation is deleted from the division.

WORKING WITH LOCATION ABBREVIATIONS
Location abbreviations can reduce your data entry when you print purchase orders. 
Once you define a location (e.g., abbreviation, company name, address lines, city, state, 
contact name), you can select the abbreviation in a drop-down list in the Custom PO 
Form parameter window. When you select the abbreviation, the address information is 
entered into the PO form automatically (Figure 3.14). 

Figure 3.14—Example Custom PO Form With Location Abbreviation
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USING LOCATION ABBREVIATIONS WITH OBLIGATION REFERENCES

You can also define obligation references that are validated against your location 
abbreviations. When this reference appears on an obligation, the user must enter a value 
that matches one of the location abbreviations, effectively assigning the obligation to 
one of your locations. Then you can print all the obligations for a specific location.
Let’s look at an example:

1.  Our organization has five locations, so we create five location abbreviations 
with all the address and contact information:

• Main Library,
• Littleton Branch,
• 10th St. Branch,
• Lakewood Branch, and
• Parker Branch.

2. We also add an obligation reference called Location with the following settings:

• Entry is required.
• Validate against the location file (i.e., location abbreviations).

3. Finally, we modify field 8 of the stage 20 definition to include the Location 
reference in the list of Editable Data Items on the Data Items tab. 

When users enter an purchase order, they must enter their location. If that location does 
not match one of the location abbreviations (e.g., Lakewood Branch), the entry is not 
accepted. Once this value is assigned to the purchase order, we can choose to print all 
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the purchase orders generated by single location (e.g., “print all Lakewood Branch POs” 
where the location abbreviation is LAK) and apply the same location abbreviation to 
define the address information (Figure 3.15). 

Figure 3.15—Example Custom PO Form Using Obligation Reference

For more information about creating obligation references, see Defining Obligation 
References on page 1.166.

DEFINING LOCATION ABBREVIATIONS

Use the following steps to add a location abbreviation.
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1.  Click Maintenance > Locations on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > 
Maintenance > Locations from the menu bar. The AP Location Maintenance 
data window displays (Figure 3.16).

Figure 3.16—Adding a Location Abbreviation

2. Click New. The Location Abbreviation Maintenance window displays (Figure 
3.17). 

Figure 3.17—Location Abbreviation Maintenance
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3. Enter the required information according to Table 3.9. 

4. Click Apply to save the information or OK to save the information and exit the 
window.

EDITING LOCATION ABBREVIATIONS

Use the following steps to edit a location abbreviation.
1.  Click Maintenance > Locations on the module navigator (if the module is not 

expanded, click Accounts Payable first) or select Accounts Payable > 
Maintenance > Locations from the menu bar. The AP Location Maintenance 
data window displays.

2. Select the location abbreviation to be edited from the data window.

3. Click Edit. The Location Abbreviation Maintenance window displays.

4. Edit the information as necessary.

5. Click Apply to save the information or OK to save the information and exit the 
window.

Table 3.9—Location Abbreviation Maintenance

Field Name Description

Location A unique abbreviation for the location (up to 3 alphanumeric characters).
• Because this abbreviation is only 3 characters, you must design your use of 

this feature carefully.

Name Organization name (up to 35 alphanumeric characters).

Street 1 Street address, first line (up to 35 alphanumeric characters). 

Street 2 Street address, second line (up to 35 alphanumeric characters).

City City name (up to 19 alphanumeric characters).

S/T/P State, territory, or province (up to 5 alphanumeric characters).

Postal Code Postal code (US zip code) (up to 9 alphanumeric characters).

Country Country name (up to 35 alphanumeric characters).

Attention Person or department (up to 35 alphanumeric characters).
Working With Location Abbreviations 
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DELETING LOCATION ABBREVIATIONS

Use the following steps to delete a location abbreviation.
1.  Click Maintenance > Locations on the module navigator (if the module is not 

expanded, click Accounts Payable first) or select Accounts Payable > 
Maintenance > Locations from the menu bar. The AP Location Maintenance 
data window displays.

2. Select the location abbreviation to be deleted from the data window.

3. Click Delete or right-click and select Delete from the shortcut menu. A 
confirmation message displays.

4. Click Yes to delete. The location abbreviation is deleted from the division.

ENCRYPTING CHECKS AND PURCHASE ORDERS
The Accounts Payable module allows you to encrypt (or “scramble”) your checks and 
purchase orders. Using this option, your check print file displays and prints normally 
with Print Manager. However, when opened in any other program (e.g., Word, 
Notepad), the information is encrypted to protect your check and purchase order 
information.

Once this option is activated, it cannot be de-activated without the assistance of 
Blackbaud FundWare Support (800-227-7575).
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Use the following instructions to activate the encryption option. When complete, the 
setting is reflected in field 8 of the check definition (for checks) and in field 3 of the 
purchase order extended setup definition (for purchase orders) (Figure 3.18). 

Figure 3.18—Example Scrambled Check Settings

Use the following instructions to define your system to encrypt checks and/or purchase 
orders.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)
Encrypting Checks and Purchase Orders 
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 3.19). 

Figure 3.19—System Utilities Window

4. In the Execute Program area, enter the required information according to Table 
3.10 to encrypt checks or purchase orders. 

5. Click Run. The option menu for the applicable document (i.e., checks or 
purchase orders) displays.

6. Type C for Change and press ENTER. 

7. Type the applicable field number (8 for checks, 3 for purchase orders) to access 
this field and press ENTER.

Table 3.10—Activating the Encryption Option

Field Entry—Checks Entry—Purchase Orders

Program name OCW207 OCW206

Switches 23 238

Parameters

Business Date Defaults to the current date. Accept 
default.

Defaults to the current date. Accept 
default.

Division Select the applicable division from the 
drop-down list.

Select the applicable division from the 
drop-down list.
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8. Type Y for Yes (or press F1 and select the option from the menu) (Figure 3.20). 

Figure 3.20—Type the Field Number

9. Press ENTER. When you have completed your entries, the system offers you the 
chance to return to a field or accept your entries.

10. Type 0 to accept your entries. Once your settings have been saved, the option 
menu displays.

11. Type E save the parameter and close the window.

DEFINING THE DISTRIBUTION REPORT PARAMETER
The Invoice Distribution by Account report (stored in the PO/Invoice Reports category) 
is a list of obligation information by account number. The distribution report parameter 
allows you to define break and report options, giving you greater control over the report 
format (e.g., on what fields the report breaks).
Defining the Distribution Report Parameter 
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For a thorough explanation of break (i.e., page break) and report (i.e., totalling) 
settings, see the Blackbaud FundWare General Ledger Guide.

Use the following instructions to define the distribution report parameter.
1.  Click Setup > Distribution Report Params on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Setup > Distribution Report Params from the menu bar. The task 
option menu displays.

2. Type A to add the parameter. The report parameter displays the default values 
(Figure 3.21). 

Figure 3.21—Define Distribution Report Parameter

3. Define the break and report settings for each level of reporting:

• Break—Enter one or more dimension numbers. The system will enter a 
page break at each change in value for the dimension. For example, if you 
break on the fund dimension (1), changing from fund 01 to fund 02 would 
trigger a page break.

• Report—Enter one or more dimensions that you want to print on each row 
of the report. For example, if we enter 2-3 4, account number A02 01-03 
7110 would print as “01-03 7110” on the row of the report.

4. Press ESC to display the option menu.

5. Type E to save the parameter and close the window.
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REFRESHING VENDOR NAME CAPITALIZATION
If you are an organization upgrading from versions of the software earlier than 7.20, you 
may find that vendor names will display in the Vendor Name drop-down list on the 
obligation form in a mix of capitalization—some will be all capitalized and some will 
reflect the capitalization used when you entered the name.
Use the following instructions if you want to “refresh” your system to recognize the 
original capitalization (i.e., not display as all caps).

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 3.22). 

Figure 3.22—System Utilities Window

4. In the Execute Program area, enter the information required to run the override, 
according to Table 3.11. 

Table 3.11—Running the Override Program

Field Entry

Program Name OTS990

Switches Leave blank
Refreshing Vendor Name Capitalization 
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5. Click Run. The system asks you to confirm that you want to refresh your 
vendor names (Figure 3.23). 

Figure 3.23—System Utilities Window

6. Type Y or press ENTER to begin the task. When complete, you return to the 
System Utilities window.

 

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

Table 3.11—Running the Override Program (Continued)

Field Entry
Blackbaud, Inc. 1.133



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.134
 Refreshing Vendor Name Capitalization 



C H A P T E R  4

USING THE FINANCIAL INSTITUTIONS FEATURE

The Financial Institutions feature provides a way for you to manage your cash and cash-
equivalent accounts. It is the central location for banking information for the Accounts 
Payable, Payroll/Personnel, and modules. 

Figure 4.1—Financial Institutions Diagram

Use this feature to manage your banking process, including:
• Add information (e.g., multiple addresses, phone numbers, and account 

numbers) for each financial institution (e.g., bank, savings and loan).

Financial Institutions FundWare AccountsFinancial Institution Accounts

84-200-18899, 
checking acct 1

85-1987, 
checking acct 2

85-2355, 
savings acct

884-992, 
checking acct

112 075-88, 
savings acct

A01 00-00 1111

A01 01-00 1111

A02 01-00 1110

A01 00-00 1110

A01 01-00 1110

A01 00-01 1110

A02 01-00 1110

Banko Uno

Cranberry National Bank

Alpenglow Federal Bank

100-999, 
checking acct A01 00-00 1112
Blackbaud, Inc. 1.135



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.136
• Define each financial institution account (e.g., checking account, savings 
account) for the financial institution.

• Link each financial institution account to Accounts Payable, Payroll/Personnel, 
and/or accounts through General Ledger.

For example, the City of Megalopolis does business with Cranberry National Bank (the 
financial institution). The City has four accounts (financial institution accounts, or FIAs) 
with Cranberry National Bank:

• Checking account 1—Used for Payroll, paid from GL account A01 00-00 1111.
• Checking account 2—Used for Accounts Payable, paid from GL account A01 

00-00 1112. Also receives normal Accounts Receivable payments from GL 
cash account A01 00-00 1113. 

• Savings account—Receives payments from all modules; GL cash accounts are 
A01 00-00 1111; A01 00-00 1112; A01 00-00 1113.

• Money market account—Receives all donations via from GL cash account A01 
00-00 1114.

Each module is associated to each applicable FIA (e.g., Payroll is associated to checking 
account 1 and the savings account).

The following acronyms are used throughout the Financial Institutions feature: 
APE (Accounts Payable), PYL (Payroll/Personnel), CRS. 

This chapter provides you with the information needed to:
• Run the account mapping utility (for existing customers), and 
• Operate Financial Institutions.

HINTS FOR CLIENTS CONVERTING FROM CLASSIC
• In the FundWare Classic Edition, each module had a separate method of 

defining a bank.
• Each “bank” represented an account.
• A Financial Account for a Financial Institution may encompass more than one 

“bank” from an FundWare Classic Edition module.
• “Banks” in the Classic Edition will automatically be converted to Financial 

Accounts by FundWare.
Hints for Clients Converting From Classic 
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MAPPING VERSION 5.8/5.9 BANKS TO THE ACCOUNTS
If you have existing bank information, the first time that you open the Financial 
Institutions feature, FundWare will have you map the existing information through two 
main steps: mapping the old bank to a new Financial Institutions account (FIA), and 
mapping that FIA to the modules that use it and to General Ledger. Use the following 
steps to accomplish these tasks.

1.  Select Maintenance > Financial Institutions > Financial Institutions from 
the menu bar. The Verify GL cash accounts/masks window displays. 

Figure 4.2—Mapping Existing Banks to Accounts

A fourth column, Message, displays only if a GL account/mask has a 
problem. In this event, the problem is described in the column.
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2. When the account information is all correct, click Next. The Assign Banks 
window displays. 

Figure 4.3—Assigning the Banks

Source Module—The module in the FundWare Classic Edition in 
which the bank was defined.

Name Defined in Module—The name used in the FundWare Classic Edition to 
define the bank.

3.
To associate the name of the Financial Institution to the name defined for the 
associated module, click the right side of the cell to activate the drop-down 
arrow, then click the arrow. If you have mapped other Financial Institutions 
during this process, the names will display in the drop-down list. 

4. Select the appropriate Financial Institution from the list or a New Institution, as 
necessary. If you select a Financial Institution from the drop-down list, proceed 
to step 7 on page 139.
Mapping Version 5.8/5.9 Banks to the Accounts 
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If you select a New Institution, the Add Financial Institution window displays. 
Figure 4.4—Add Financial Institution Dialog Box

The Name text box defaults to the value for the Name Defined in Module.
5. Modify the name of the financial institution, if necessary.

6. Click OK. The Add Financial Institution window closes and you return to the 
Assign Banks window.

7. Repeat these steps, as necessary, until all accounts have an assigned financial 
institution.

There should now be entries for all the Financial Institutions. 
Figure 4.5—All Financial Institutions Assigned

8. Click Next. The Assign Bank Accounts window displays, containing entries 
from the previous window, as well as a new column: Financial Institution 
Account. The cells in the Financial Institution Account column will be 
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populated by either a default account number and description or --- Not Mapped 
---. The defaults are supplied by the FundWare Classic Edition based on the 
original information.

This window provides you with a way to map financial institution accounts. 
Figure 4.6—Mapping Financial Institution Accounts

Multiple instances of the same General Ledger cash account number 
must be assigned to the same financial institution account (by 
definition, this also means assigned to the same financial institution).

9. To edit default Financial Institution Account information, double-click the cell. 
The edit Financial Institution Account window displays.

10. Edit the Account Description and Account #, as necessary.

11. In the Financial Institution Account column, click the right side of a cell to 
activate the drop-down arrow, then click the arrow.

12. Select the appropriate account description from the drop-down list or a New 
Account, as necessary. If you select an account description from the drop-down 
list, proceed to step 16 on page 141.
Mapping Version 5.8/5.9 Banks to the Accounts 
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If you select New Account from the drop-down list within the Financial Institution 
fields, the Add Financial Institution Account window displays. 

Figure 4.7—Add Financial Institution Account

13. Enter the Account Description and Account # (the account number that appears 
on your statement). 

14. If FundWare has not already inserted the appropriate account number, enter the 
account number corresponding to the description in the Account # field.

15. Click OK. The Add Financial Institution Account window closes and you 
return to the Assign Bank Accounts window.

16. Repeat these steps, as necessary, until all accounts have an assigned financial 
institution account.

There should now be entries for all the Financial Institutions. 
Figure 4.8—Entries for All Financial Institution Accounts

17. Click Next.
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When all assignments are complete, the Review Assignments window displays. 
Figure 4.9—Review Assignment

If a Financial Institution is only mapped to one or more General Ledger masked 
account, you will not be able to view or edit that information until an actual 
General Ledger account has been associated to the FI.

Each entry in the Financial Institution Account column corresponds to a Financial 
Institution Account where a module account has been mapped. 

If a Financial Institution Account entry spans more than one source module, this 
indicates that all the source modules have been associated with that Financial 
Institution Account. In the example above, the Cranberry National Bank Payroll 
Account spans APE and PYL, indicating that the account is associated with 
Accounts Payable and Payroll/Personnel.

• Click Previous to return to earlier windows if you need to make any 
assignment changes.

• Click Cancel to exit the Review Assignments window without saving the 
information.

• Click Finish to save the information and proceed further into the Financial 
Institutions feature. 
Mapping Version 5.8/5.9 Banks to the Accounts 
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VIEWING FINANCIAL INSTITUTIONS
The main Financial Institutions window can display the FIA information in a variety of 
ways. When you open the Financial Institutions feature, the window displays the Type 
and Name of each financial institution entered in the system. 

Figure 4.10—Displaying Financial Institution Information

You can remove either of these columns from the display by using the following steps.
1.  Move the cursor anywhere in the Financial Institutions window.

2. Right-click. The drop-down list displays. 

Figure 4.11—Right-Click Menu

3. Select the category to be displayed or hidden (a check mark indicates that the 
category will display).

RE-ORDERING THE DISPLAY

The information in the main Financial Institutions window can be displayed in 
alphanumeric or reverse alphanumeric order, based on each column. To sort on a 
column, click the column heading. The information will be re-ordered based on an 
alphanumeric sort of that column. To display in reverse alphanumeric order, click the 
heading a second time.
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ADJUSTING COLUMN SIZE

To adjust the column size, right-click and select Autosize Columns. Move the cursor to 
the edge of the column in the heading. The arrow will change to a line and two smaller 
arrows. 

Figure 4.12—Adjusting the Column Size

Holding the mouse button down, move the cursor left or right to adjust the column width 
as desired.

ADDING A FINANCIAL INSTITUTION
Use the following steps to add a financial institution (FI).

If, while creating an FI, you decide to cancel the action, the information will be 
retained. There is no function to delete an FI; therefore, even though you cancel 
the action, the FI is permanently part of your system. An FI added this way will 
not cause any errors.

1.  Select File > Financial Institutions > Maintenance from the menu bar. The 
Financial Institutions window displays. 

Figure 4.13—Adding an FIA
Adding a Financial Institution 
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2. Click New. The New Financial Institution window displays, defaulting to the 
General tab. Three tabs display behind the General tab: Address, Phone, and 
Account. 

Figure 4.14—New Financial Institution Record

3. Enter the required information according to the following table:. 

4. Click Apply to save.

Table 4.1—Required Information
Text Box Description

Name Enter the name of the financial institution. This information is used for 
verification purposes of screens and reports. Maximum 40 alphanumeric 
characters.

Type Select the type of financial institution from the drop-down list: Bank or 
Savings and Loan.
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5. Select the Address tab. If addresses have been added, the tab displays the 
window and text boxes, populated with the information for the first entry in the 
window. If no addresses have been entered, no fields display. 

Figure 4.15—Address Tab
Adding a Financial Institution 
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6. Click New to add an address (optional). The expanded Address tab displays. 

Figure 4.16—Expanded Address Tab

7. Enter the information according to the following table:

8. Click Apply to save. If you have another address to enter for this financial 
institution, click New and repeat step 7. If you do not have another address to 
enter, proceed to the next step.

Table 4.2—Address Tab Information
Text Box Description

Type Select the type of address from the drop-down list (e.g., Business, Home, or Other).
Street 1
Street 2

Enter the street address for this location of the financial institution. Maximum 35 alphanume
characters for each.

City Enter the city for this address. Maximum 19 alphanumeric characters.
State Select the US state from the drop-down list, or enter up to 5 characters for the state, provinc

territory. 
Zip Enter the zip or post code. Maximum 50 alphanumeric characters.
Country Enter the country, if desired. Maximum 35 alphanumeric characters.
Description Enter a description of the location, e.g., main office of the financial institution. Maximum 50 

alphanumeric characters.
Default Select this check box if this address is to be used as the default address when mailing some

to the financial institution.

As you add 
addresses for t
FI, they will 
display in the 
window.
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9. Select the Phone tab. If phone numbers have been added, the tab displays the 
window and text boxes, populated with the information for the first entry in the 
window. If no phone numbers have been entered, no fields display. 

Figure 4.17—Phone Tab
Adding a Financial Institution 
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10. Click New to add a phone number (optional). The Expanded Phone tab 
displays. 

Figure 4.18—Expanded Phone Tab

11. Enter the information according to the following table

12. Click Apply to save. If you have another phone number to enter for this 
financial institution, click New and repeat step 11. If you do not have another 
phone number to enter, proceed to the next step.

Now you have defined the financial institution. You must add the accounts for the FI 
(e.g., two checking accounts and a savings account) on the Account tab. These accounts 
are “FIAs” (financial institution accounts). 

Table 4.3—Expanded Phone Tab
Text Box Description

Type Select the type of phone number from the drop-down list (e.g., Business, Home, or Other).
Number Enter the phone number. Maximum 50 alphanumeric characters.
Description Enter a description of the phone number, e.g., most helpful customer service representative.

Maximum 50 alphanumeric characters.
Default Select this check box if this is to be used as the default phone number when calling the finan

institution.

As you add ph
numbers for th
they will displa
the window.
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ADDING FINANCIAL INSTITUTION ACCOUNTS
You can add as many financial institution accounts (i.e., actual accounts at your banking 
entity) as necessary for each financial institution (i.e., the banking entity).

1.  Select the Account tab. If accounts have been added, the tab displays the 
window and text boxes, populated with the information for the first entry in the 
window. If no accounts have been entered, no fields display. 

Figure 4.19—Account Tab
Adding Financial Institution Accounts 
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2. Click New to add an account (required to use this financial institution). The 
expanded Account tab displays. 

Figure 4.20—Expanded Account Tab

3. Enter the required information according to the following table. 

4. Click Apply to save. If you have another account to enter for this financial 
institution, click New and repeat step 3. (You can also make associations for 
your account at this time. See Associating the Accounts on page 1.152 for more 
information.) If you have completed your entry of accounts, click OK to save 
the changes and return to the Financial Institutions main window.

At this point, your financial institution exists, however, the financial institution accounts 
have not been associated with General Ledger accounts. This mapping can be done at 
any time, however, you will not be able to access the FIAs through Accounts Payable, 
Payroll/Personnel, or until this task is done. 

Table 4.4—Expanded Account Tab
Text Box Description

Type Select the type of account from the drop-down list: Checking Account, or Savings Accou
Number Enter the account number. Maximum 20 alphanumeric characters.
Description Enter a description of the account, e.g., petty cash account. Maximum 30 alphanumeric 

characters.

As you add 
accounts for t
they will displ
the window.
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ASSOCIATING THE ACCOUNTS
You can associate as many General Ledger accounts as you need to your Financial 
Institutions account (FIA), however, a General Ledger account may only be associated 
with one Financial Institution account. The process that you will follow for associating 
your accounts involves a few main tasks:

Once you associate a GL account to a financial institution account, that GL 
account may not be associated with any other FIA.

• Determine the GL cash accounts that will be associated to the FIA.
• Enter the accounts as “GL cash accounts.” (Masked accounts are not allowed. 

To mimic the effect of an account mask, you can define all accounts resulting 
from the mask as GL cash accounts.)

• Associate one or more accounts, or account masks, to the FIA by module (i.e., 
Accounts Payable, Payroll/Personnel, or.)

The following sections provide instructions for associating one or more General Ledger 
accounts to your selected Financial Institutions account. 

1.  Select the Account tab of the applicable financial institution.

2. Select the FIA to be associated from the upper window. The text boxes are 
populated with the information specific to the selected FIA.
Associating the Accounts 
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3. Select the By GL Cash Account radio button. 

Figure 4.21—Expanded Account Tab

4. Click Add. The Add GL Account pop-up displays. 

Figure 4.22—Add GL Account Dialog Box

5. Enter the GL Cash Account in the text box, or click  to browse for the correct 
account. The Account Selector window displays. Use the selector to select the 
appropriate account.

6. Click OK to save. A confirmation message displays.

7. Click Yes. The Add GL Account pop-up closes and you return to the Account 
tab.

8. Click Apply to save.

9. If you have another General Ledger account to map to this Financial Institution 
account, repeat these steps.
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10. Select the By Use radio button.

11. Click Add. The Select Module window displays. 

Figure 4.23—Select Module Dialog Box

12. Select the appropriate module from the drop-down list: Accounts Payable, 
Payroll/Personnel, or.

13. Click OK. The module-specific window displays. 

See the following sections for instructions to complete the module-specific window.
Associating the Accounts 
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ASSOCIATING THE ACCOUNTS—ACCOUNTS PAYABLE

Use the following instructions to complete the Accounts Payable By Use window 
Figure 4.24—Accounts Payable “By Use” Associations

As accounts are added, they 
are displayed in this window.

For reference, this is the Financial Institutions 
account to which you are mapping.

Usage Information displays a brief list of the most recent activities in this 
account.
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1.  Enter the required information according to the following table 

Table 4.5—AP User Required Information
Accounts Payable Text 

Box Description

Usage Definition—GL 
Cash Acct

Select the GL cash account to be associated with this financial institution account 
the drop-down list or enter an account mask. 
• You cannot create new accounts through FI. The account or accounts must exis

GL.
Usage Definition—
Usage ID

Enter a unique identifier for this association. This ID will be used to identify the acc
when you produce checks. 
• Maximum 10 alphanumeric characters.
When you produce checks, FundWare will create a unique file for each FIA by 
attaching the ID number to “OTCK.” For example, if the usage ID is 146983, the fi
name is OTCK146983.L## (where ## represents your division number).
• If the usage ID is fewer than four characters, the file name will include Xs. For 

example, if the usage ID is 135, the file name is OTCK135X.
Usage Definition—
Description

Enter a unique description for this association. This description will display in the 
Accounts Payable module when you select the account from which to draw funds
• Maximum 35 alphanumeric characters.

Usage Information Summary information concerning the usage of the account association displays in
window.

Data Items Printed on 
Check Stub

Click the right side of the text box to activate a drop-down arrow. From the drop-d
list, select three data items to be printed on the Accounts Payable checks. 
• Data items are optional. 

Distribution Report—
Reporting Option

Select one of six options to define the amount of detail included with the check reg
• N—No accounting distribution report
• Y—With all check registers
• 1—With preliminary register only
• 2—With final check register only
• 3—With reprint register only
• 4—With final check and reprint registers

Distribution Report—
Report ID Type

This would normally be the General Ledger ID type.

Distribution Report—
Break Dimension/
Description

In the grid that displays when you select a report ID type, click the Break Dimensi
and select a dimension on which the register will enter a page break from the drop
down list.
Enter a Description for each Break Dimension. This text that will print on the repo
the break line. 
• Maximum 20 characters for both selections.
Associating the Accounts 
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2. If you have additional Accounts Payable accounts that you would like to map to 
this FIA, click New. If not, click OK. The Accounts Payable By Use window 
closes and you return to the Account tab.

3. Click Apply to save the financial institution. If you have another account to 
enter for this financial institution, click New and repeat the necessary steps. If 
you have completed your entry of accounts, click OK to save the changes and 
return to the Financial Institutions main window.

User Options Select a check option from the drop-down list: System Numbered, User Numbere
Laser Checks.
• System Numbered—Checks are automatically numbered by the computer. If 

needed, this number can be changed through the check parameters. Use this o
for pre-printed checks.

• User Numbered—For each batch of checks that you print, you must enter the fi
check number. Use this option for pre-printed checks.

• Laser Checks—Checks are automatically numbered. You cannot change the ch
number. Use this option for blank check stock.

Last Check Number Enter the last check number in this text box. Subsequent checks will be numbered
starting with the next number (e.g., you type 1220 in this text box, the checks will b
with 1221).
If you leave this field blank, the system applies 0 to the field. When you begin writ
checks, the system starts counting from 1.

Table 4.5—AP User Required Information (Continued)
Accounts Payable Text 

Box Description
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ASSOCIATING THE ACCOUNTS—PAYROLL/PERSONNEL

Use the following instructions to complete the Payroll/Personnel By Use window. 
Figure 4.25—Payroll/Personnel “By Use” Associations

As accounts are added, they are 
displayed in this window.

For reference, this is the Financial Institutions 
account to which you are mapping.

Usage Information displays a brief list of the most recent activities in this 
account.
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1.  Enter the required information according to the following table:. 

2. If you have additional Payroll/Personnel accounts that you would like to map to 
this Financial Institutions account, click New. If not, click OK. The Payroll/
Personnel By Use window closes and you return to the Account tab.

3. Click Apply to save. If you have another account to enter for this financial 
institution, click New and repeat the necessary steps. If you have completed 
your entry of accounts, click OK to save the changes and return to the Financial 
Institutions main window.

Table 4.6—Payroll/Personnel Required Information
Payroll/Personnel Text Box Description
Usage Definition—GL 
Cash Acct

Select the GL cash account or enter a GL account mask to be associated with t
financial institution account from the drop-down list. (You cannot create new acco
through FI. The account or accounts must exist in GL.)

Usage Definition—Usage 
ID

Enter a unique identifier for this association. This ID will be used to identify the 
account when you produce checks. 
• Maximum 10 alphanumeric characters.
When you produce checks, FundWare will create a unique file for each FIA by 
attaching the ID number to “OTCK.” For example, if the usage ID is 146983, the
name is OTCK146983.L## (where ## represents your division number).
• If the usage ID is fewer than four characters, the file name will include Xs. For

example, if the usage ID is 135, the file name is OTCK135X.
Usage Definition—
Description

Enter a unique description for this association. This description will display in th
Payroll/Personnel module when you select the account from which to draw fund
Maximum 35 alphanumeric characters.

Usage Information Summary information concerning the usage of the account association displays
this window. 

Data Items Printed on 
Check Stub

Click the right side of the text box to activate a drop-down arrow. From the drop-
list, select three data items to be printed on the Payroll/Personnel checks. 
• Your selections will print in the lower left quadrant of the check stub.

User Options—Auto 
Number Checks

Select this check box to have the payroll/personnel checks numbered automatic
by the system. If you do not select this check box, you will need to enter the firs
check number for each batch of checks that you print.

User Options—Last Check 
Number

If you selected to auto number your payroll/personnel checks, enter the last che
number in this text box. Subsequent checks will be numbered starting with the n
number (e.g., you type 1220 in this text box, the checks will begin with 1221).
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ASSOCIATING THE ACCOUNTS—
Accounts Receivable and Cash Receipts customers: Accounts Receivable 
includes Cash Receipts, which also uses the Financial Institutions feature. 
While the process is the same for both modules, the interface will reflect the 
module for which you are licensed. However, this guide will display the 
Accounts Receivable screens by default.

Figure 4.26—Accounts Receivable Cash Receipts By Use Associations
As accounts are added, they 
are displayed in this window.

For reference, this is the Financial Institutions 
account to which you are mapping.
Associating the Accounts 
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1.  Enter the required information according to the following table:. 

2. If you have additional accounts that you would like to map to this Financial 
Institutions account, click New. If not, click OK. The By Use window closes 
and you return to the Account tab.

3. Click Apply to save. If you have another account to enter for this financial 
institution, click New and repeat the necessary steps. If you have completed 
your entry of accounts, click OK to save the changes and return to the Financial 
Institutions main window.

EDITING AN FIA
Use the following steps to edit the information concerning a financial institution.

1.  From the Financial Institutions main window, select the financial institution that 
you want to edit and click Edit, or double-click the institution in the window.

The window displays with the text boxes populated with the information specific to 
the selected financial institution. 

2. Select the tab containing the desired information. For addresses and phone 
numbers, select the entry in the window. The specific address or phone 
information populates the text boxes.

3. Edit the information, as necessary.

4. Click Apply to save the changes on each tab. 

5. Click OK to save when you have completed your edits. You return to the 
Financial Institutions main window.

Table 4.7—Required Information
Text Box Description

GL Cash Acct Select the GL cash account or enter a GL account mask to be associated with this fina
institution account from the drop-down list. (You cannot create new accounts through F
The account or accounts must exist in GL.)
• If you enter an account mask, the valid account will be determined using the masked

account digits in the account.
Description Enter a unique description for this association. This description will display in the mod

when you select the account to which you will deposit funds. Maximum 35 alphanume
characters.
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EDITING AN ASSOCIATION
Use the following steps to edit the association information concerning a financial 
institution.

1.  From the Financial Institutions main window, select the financial institution that 
you want to edit and click Edit, or double-click the institution in the window.

The window displays with the text boxes populated with the information specific to 
the selected financial institution. 

2. Select the Account tab.

3. Select the FI account to be edited.

4. Select the By Use radio button. The accounts display in the lower window. 

Figure 4.27—Displaying Accounts

5. Select the account to be edited.
Editing an Association 
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6. Click Edit. A window displays, defined by the module associated with the 
account selected. 

Figure 4.28—Dialog Box as Defined by the Module

All the accounts associated to that module display in the window above. The 
information concerning the selected account populates the text boxes below.

7. Edit the information, as necessary.

8. Click Apply to save the information or click OK to save the information and 
exit the window.

9. Repeat these steps, as necessary.

10. When you have completed your edit of the association information, click OK.
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DELETING AN FIA
You cannot delete a financial institution from FundWare. Any financial institution for 
which you add information and save is permanently retained in the system. This is true 
even if you cancel out of the action at a later point in the creation. For example, you 
create a new financial institution and enter the name and type, then click Apply to save 
the information. If you then click Cancel, that financial institution is still retained.

If you add this information and click Cancel (not Apply), the financial institution 
displays in the list of Financial Institutions, but will disappear if you close, then re-open, 
the application.

DELETING A GL CASH ACCOUNT ASSOCIATION
To delete an association, that association cannot be in use elsewhere in the program. Use 
the following steps to delete an association.

1.  From the Financial Institutions main window, select the financial institution that 
you want to edit and click Edit, or double-click the institution in the window.

The window displays with the text boxes populated with the information specific to 
the selected financial institution. 

2. Select the Account tab.

3. Select the FI account to be modified.

4. Select the association from the lower window.

5. Click Delete. The association is removed from the lower window.

If the association is used elsewhere in the program, a message will 
display and the action will not be completed.

 

 

Deleting an FIA 



C H A P T E R  5

DEFINING AND USING DATA ITEMS

Data items are pieces of information stored by FundWare. There are two types of data 
items in AP:

• Obligation reference data items—Store information with a transaction. For 
example, you can store the vendor invoice number, due date, or contract number 
with each invoice. This information can be very useful as selection criteria for 
filtering or reporting obligations.

• Vendor data items—Store additional information with the vendor record (e.g., e-
mail address, alternate contact name). This information can be included in user-
defined vendor reports.

DATA ITEMS—OBLIGATION REFERENCES
Obligation reference data items are used to store information with a transaction (e.g., 
purchase order, invoice), such as the vendor invoice number, due date, or contract 
number. They can be very useful as selection criteria for filtering or reporting 
obligations. For example, you could use a data item to select obligations for a specific 
contract number or due date range.
Each reference item has a single-letter designation. Some reference items are system 
defined, while others can be entered by and customized for your organization. The 
reference items are described in Table 5.1. 

Table 5.1—Obligation Reference Data Items

Reference Name Description

A Obligation Number Number given to each obligation (system defined).

B Vendor Number Vendor number (system defined).
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The four main parts to working with reference items are:
• Defining the item (Maintenance > Obligation References).
• Defining the stage to display the data item on the Data Items tab of the 

obligation. (These settings are found in field 8 of the stage definition.)
• Entering a value for the item on the Data Items tab when you create the 

obligation.
• Using the reference item as selection criteria in a report or filter.

DEFINING OBLIGATION REFERENCES

Use the following steps to add an obligation reference.

C Original Obligation 
Number

When you split an invoice, the new invoice gets a new obligation 
number (Reference A). FundWare stores the original invoice 
number for the new obligation in this obligation reference (system 
defined). 

D Group Name If your organization uses the Advanced Security feature, 
FundWare stores the group name in this obligation reference 
(system defined).

E–F Reserved for 
FundWare

Reserved for future development.

G–Z Unassigned. Can be defined by each organization to meet 
information needs.

While each organization can set up references to meet its specific needs, we recommend that you set 
up I, R, and J, as described below.

• I Vendor’s Invoice 
Number

The number on the physical form. This reference creates an easy 
way to look up and reconcile invoices.

• R Memorized Invoice 
Schedule

Enter a value to reflect when to pay the invoice. Examples: 
• Pay the first of the month, value = M1 
• Pay the 15th of the month, value = M15
• Pay quarterly, value = QUARTER

• J Invoice Due Date Enter the date in a consistent format if you want to use it as 
selection criteria. 
• Example: mm/dd/yyyy.

Table 5.1—Obligation Reference Data Items (Continued)

Reference Name Description
Data Items—Obligation References 
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1.  Click Maintenance > Obligation References on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Obligation References from the menu bar. The 
Obligation Reference Data Items window displays (Figure 5.1). 

Figure 5.1—Obligation Reference Data Items

You can click a column heading to sort the obligation references by the 
column entries. You can also find a specific reference by typing the 
name (or first few characters) in the Locate Obligation Reference by 
Reference field; FundWare will search for the matching data item.

2. Click New. The Reference Maintenance Sheet displays (Figure 5.2). 

Figure 5.2—Reference Maintenance Sheet

3. Enter the Reference letter, which must be unique. 

4. Enter the Description (up to 15 alphanumeric characters).

5. Select the entry option from the drop-down list (i.e., either required or optional). 
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• Required—The user will not be allowed to move off the Data Items tab of 
the obligation until he or she enters a value for this reference. 

• Optional—The user can enter a value for this reference on every new 
obligation, but is not required.

6. Select the applicable validation setting. (In other words, if you want this 
obligation reference to be validated against your location abbreviations, select 
Validate against location file. For most obligations, you will select Do not 
validate.) 

For more information, see Using Location Abbreviations With 
Obligation References on page 1.123.

7. Click OK.

POSTING DATA ITEMS TO GL–P/G
You can define up to three data items to post to General Ledger–Project/Grant via your 
Accounts Payable journals. Use the following general steps.

1.  Define a data item in General Ledger–Project/Grant (General Ledger > 
Maintenance > Data Items). The data type for the data item must be one of the 
alphanumeric options: 

• 10-character keyword,
• 35-character text, or
• 55-character extended text.
See the Blackbaud FundWare General Ledger–Project/Grant Guide for specific 
instructions to define data items.

2. Add the data item to all journals used by Accounts Payable (General Ledger > 
Maintenance > Journals). See the Blackbaud FundWare General 
Ledger–Project/Grant Guide for specific instructions to define journals.

You must add the data item to all AP journals using the same item 
number (i.e., item 1, 2, or 3 on the General tab of the journal 
definition). 

The GL data items assigned to the journal impact the system in two ways:

• They enable the Data Items fields available in Extended Setup, allowing 
you to assign obligation references. It is through the obligation references 
that you are actually entering information to post to GL–P/G.
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• The GL data item description (not the description of the obligation 
reference) prints with the AP information in the trace report.

3. Define a corresponding obligation reference (Accounts Payable > 
Maintenance > Obligation References). See Defining Obligation References 
on page 1.166 for specific instructions to define obligation references.

Because the description for the GL–P/G data item prints on the trace 
report, not the description of the obligation reference, you should 
ensure that both data items (the GL–P/G data item and corresponding 
AP obligation reference) are named in a similar, logical fashion.

4. Apply the obligation reference as a data item in field 4 of the Accounts Payable 
extended setup parameter (Accounts Payable > Setup > Extended Setup). See 
Modifying the Extended Setup Parameter on page 1.54 for instructions.

APPLYING AN REFERENCE ITEM TO AN OBLIGATION

Use the following steps to enter a value for an obligation reference item.
1.  Open the Purchase Order or Invoice folder.

2. Click New.

3. Complete the Header tab.

4. Go to the Data Items tab. The current data items are displayed (Figure 5.3). 

Figure 5.3—Invoice Edit

5. Enter values in the selected reference items.
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6. Complete the obligation and click OK.

USING OBLIGATION REFERENCE DATA ITEMS IN REPORTING

FundWare allows you to use your obligation references to enhance certain AP reports:
• Add references to the report results (Figure 5.4). 

Figure 5.4—Example Selections for Print References

• Specify a range of values for a reference to filter the report contents. (For 
example, the report in Figure 5.5 will include information for only one vendor.) 

Figure 5.5—Example Range of Reference Values

FILTERING WITH OBLIGATION REFERENCE DATA ITEMS

You can use obligation references to specify which transactions are displayed by 
following these steps.

1.  In any of the Obligation subfolders, select the Filter check box (Figure 5.6). 

Figure 5.6—Selecting the Filter Option From the Invoices Folder
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The Filter window displays (Figure 5.7). 

Figure 5.7—Filter Window

2. Select a data item from the Obl. Reference the drop-down list.

3. Enter a range of values in the fields next to the data item. To select a single 
value, enter the value in both fields.

4. Click OK. The obligations for the selected project numbers are listed in the 
detail pane.

To view all obligations, select the Filter check box to remove the check 
mark. All obligations will display in the detail pane. 

If no obligations display, your filter settings may be too narrow (i.e., no 
obligations meeting the requirements).

For more information on filtering, see Filtering Obligations on page 1.18.

EDITING OBLIGATION REFERENCES

Use the following steps to edit an obligation reference.
1.  Click Maintenance > Obligation References on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Obligation References from the menu bar. The 
Obligation Reference Data Items window displays.
Blackbaud, Inc. 1.171



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.172
2. Select a division. The Obligation Reference Data Items window displays 
(Figure 5.8). 

Figure 5.8—Obligation Reference Data Items

You can click a column heading to sort the obligation references by the 
column entries. You can also find a specific reference by typing the 
name (or first few characters) in the Locate Obligation Reference by 
Reference field; FundWare will search for the matching data item.

3. Select the obligation reference.

4. Double-click, click Edit, or right-click and select Edit from the shortcut menu. 
The obligation reference definition displays in the Reference Maintenance 
Sheet window (Figure 5.9). 

Figure 5.9—Reference Maintenance Sheet

5. Edit the information, as necessary.

6. Click Apply to save your information and remain in the Reference Maintenance 
Sheet window, or click OK to save your information and return to the 
Obligation Reference Data Items window.
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DELETING OBLIGATION REFERENCES

Use the following steps to delete an obligation reference.
1.  Click Maintenance > Obligation References on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Obligation References from the menu bar. The 
Obligation Reference Data Items window displays.

2. Select a division. The Obligation Reference Data Items window displays 
(Figure 5.10). 

Figure 5.10—Deleting Obligation References

You can click a column heading to sort the obligation references by the 
column entries. You can also find a specific reference by typing the 
name (or first few characters) in the Locate Obligation Reference by 
Reference field; FundWare will search for the matching data item.

3. Select the obligation reference and click Delete (or right-click and select Delete 
from the shortcut menu). A confirmation message displays.

4. Click Yes to delete the reference.

DATA ITEMS—VENDORS
The purpose of a vendor data item is to allow additional information to be stored with a 
vendor record (e.g., e-mail address, alternate contact name). That information can then 
be included in user-defined vendor reports. There are two categories of data items:
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• System-defined—Created during setup and, with minor exceptions, cannot be 
changed. They are identified by a dot preceding the name. For example 
.VHOLD and .NOTE1.

• User-defined—Can be added, edited, and deleted using Vendor Data Items.

HOW DO YOU USE VENDOR DATA ITEMS?
Using a data item is a two-step process:

1.  Create a vendor data item.

2.  Assign it to a vendor in Vendor maintenance. 

For example, our organization is a municipality and many of our vendors are department 
specific—only the Police department uses Vendors A and H, the Fire department uses 
Vendors B and J, but both departments use Vendor C. We would like to be able to 
produce a reports that sort our vendors based on the departments with which they do 
business.
We create a vendor data item called DEPT and add edit values to reflect the vendor use 
categories (i.e., Only used by Fire department, Only used by Police department, and 
Used by both departments) (Figure 5.11). (See Defining Vendor Data Items on page 
1.177 for instructions to add a vendor data item.) 

Figure 5.11—Example Vendor Data Item
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Then we can add the data item and select a value on the Vendor Data Items tab of the 
vendor record (Figure 5.12). 

Figure 5.12—Example Vendor Data Item in Vendor Record
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Now that the information is associated with the vendor, we can create user-defined 
vendor reports that include columns that display the data item information (Figure 
5.13). 

Figure 5.13—Example Report Definition Columns for Data Items

SYSTEM-DEFINED VENDOR DATA ITEMS

FundWare provides three system-defined vendor data items for your use:
• .VACCT—Use this data item to set up a default account number for obligation 

entry. 
• .VHOLD—Use this data item to add or remove a vendor from hold status. 

If you put a vendor on hold, you may not:

— Add new obligations
— Mark for pay
— Transfer existing obligations for that vendor. 
However, you may:

— Cancel an obligation
— Produce checks for obligations already marked for pay
— Log
— Reconcile checks for that vendor. 

Currently, this report will 
only have two columns—
the data item value and 
lookup column 1.
Data Items—Vendors 



Chapter 5—Defining and Using Data Items
• .VPAYMENT—Use this data item allows to indicate that the vendor should, by 
default, receive separate or combined checks when you are processing a check 
run. In other words, if one vendor has three obligations in a check run, and if the 
.VPAYMENT data item value is Separate for the vendor, AP will (by default) 
create three checks for the vendor (one for each obligation).

You can override this setting when you create or modify the obligation 
or when you mark obligations for pay. AP will look to the obligation 
setting to create separate or combined checks.

If you are an existing FundWare customer upgrading from a version 
earlier than 7.20, you must modify the Accounts Payable parameter 
before .VPAYMENT will be available. See Modifying the AP 
Parameter—For Upgrading Customers Only on page 2.96 for more 
information.

DEFINING VENDOR DATA ITEMS

Use the following steps to add a vendor data item.
1.  Click Maintenance > Vendor Data Items on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Vendor Data Items from the menu bar. The AP 
Data Items Maintenance window displays (Figure 5.14). 

Figure 5.14—AP Data Items Maintenance Window
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2. Click New. The Accounts Payable Data Item Maintenance window displays, 
open to the General tab (Figure 5.15). 

Figure 5.15—Accounts Payable Data Items Maintenance, General Tab

3. Enter the name of the data item (up to 10 characters). The remaining fields in 
the definition heading are read only and maintained by the system.

4. Enter the required information according to Table 5.2. 

Table 5.2—Data Item Maintenance, General Tab

Field Description

• Description Item description (up to 30 characters).

• Short Description Short description for fields and columns (up to 15 characters).

• Data Type List of predefined data formats:
• Text (30)
• Number (15)
• Dame mm/dd/yyyy
• Phone Number (10)

• Attribute (3)
• Keyword (20)
• Extended Text (55)
• Account Mask (55)
Data Items—Vendors 
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• Format Set up a format (up to 64 characters) to control the types of characters that can 
be entered. 
• 9 = numeric only, 
• X = alphabetic only, and 
• A = alphanumeric.
This option is only available for the following data types: 
• Text (30) 
• Attribute (3)
• Keyword (20) 
• Extended Text (55)

If the format is: 
• X9999
You can enter:
• C2936 or F6149
You can’t enter:
• 9ASDF

If the format is: 
• 999999
You can enter:
• 777214 or 223494
You can’t enter:
• ASDFGH

If the format is: 
• AAAA
You can enter:
• GDL4 or 88B2
You can’t enter:
• 9876

If the format is: 
• 999A
You can enter:
• 788C or 3443
You can’t enter:
• ASD3

• Default Value Enter the value to use as a default.
• Must comply with the format if one is defined.

• Entry required Determines if the user is required to enter a value for the data item during 
obligation entry.

• Enter Date Define whether the date should be entered and, if entered, how it will be stored.

• Enter Number Select if single or multiple values are allowed for the data item. 
• Single occurring.
• Multiple occurring using entry nbr.
• Multiple occurring using military time.

Table 5.2—Data Item Maintenance, General Tab (Continued)

Field Description
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5. When you have added the necessary information, click Apply to save your 
information and remain in the vendor data item record, or click OK to save your 
information and return to the AP Data Items Maintenance window.

The functionality of the Help tab is not applicable in the current version 
of FundWare.

VENDOR DATA ITEM ADDITIONAL TAB

You can use the entries on the Additional tab to activate lookup columns for any edit 
values assigned to the data item. By activating the lookup columns on the Additional 
tab, you can then add additional information to each edit value on the Edit Values tab. 
This information is displayed on user-defined reports.

The Additional and Edit Values tabs are only enabled when:

• The Data Type is Number, Date, Phone Number, Attribute, or Keyword; 
and

• The Edit Data setting is “Edit input entered by user, allows lookup.”
You do not need to activate lookup columns to enter edit values. The lookup 
column entries work as additions to the edit values. 

• Scroll Data Allows you to use the data item to sort Inquiry results. You selection determines 
how the system will store the information.
• Do not maintain an inverse.
• Maintain an inverse, no duplicates.
• Maintain inverse.

• Auto Add Determines if the data item is automatically added to all future vendors, which 
acts as a prompt to the user.
• Prompt—The data item is added to all future obligations.
• Do not prompt—The user must add the data item manually.

• Edit Data Allows you to determine how FundWare validates the entry. This field is only 
enabled when the Data Type is Number, Date, Phone Number, Attribute, or 
Keyword.
• Do not validate input entered by user.
• Edit input entered by user, allows lookups—When selected, the Additional and 

Edit Values tabs are enabled and accessible.
• Field is validate by another file.

Table 5.2—Data Item Maintenance, General Tab (Continued)

Field Description
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Use the following steps to activate the lookup columns.
1.  Select the Additional tab (Figure 5.16). 

Figure 5.16—Accounts Payable Data Items Maintenance, Additional Tab

2. Select the format (e.g., date, phone number, keyword) of the lookup columns 
from the drop-down arrow. For example, you can select Date mm/dd/yyyy, 
which only allows numeric entry and formats the entry in date style. Each entry 
displays the maximum characters allowed for that format:

• Date—mm/dd/yyyy 
• Phone number—10 characters
• Attribute—3 characters
• Keyword—20 characters
• Text—30 characters
• Extended text—55 characters
• Account Mask—55 characters
You will enter the actual value for each edit value on the Edit Values tab.

3. When you have added all the necessary information, click Apply to save your 
information and remain in the vendor data item record, or click OK to save your 
information and return to the AP Data Items Maintenance window.
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VENDOR DATA ITEM EDIT VALUES TAB

If you enter edit values for a data item on the Edit Values tab, those values are the only 
allowed entry for the data item. For example, if you enter edit values of Y and N (for 
Yes and No), you will not be able to enter M for Maybe. Also, if you activated lookup 
columns on the Additional tab, you can enter lookup information (i.e., additional 
information that appears only on user-defined reports).

The Additional and Edit Values tabs are only enabled when:

• The Data Type is Number, Date, Phone Number, Attribute, or Keyword; 
and

• The Edit Data setting is “Edit input entered by user, allows lookup.”
1.  Select the Edit Values tab (Figure 5.17). Any existing edit values display in the 

data window. 

Figure 5.17—Accounts Payable Data Items Maintenance, Edit Values Tab
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2. Click New. The Edit Values window displays (Figure 5.18). 

Figure 5.18—Edit Values

3. Enter the edit value (i.e., the value that will appear in the drop-down list for this 
data item).

4. Select the Active check box to enable or disable this feature. (By default, the 
edit value is active, as indicated by the check mark.)

If you activated 
lookup columns 
on the 
Additional tab, 
the only 
associated 
fields will be 
active on this 
window. 

In this example, 
we activated 
Columns 1, 2, 
and 3 on the 
Additional tab.
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5. Enter any lookup values in the enabled lookup text boxes. (Figure 5.19 shows 
an example from Division 95. In the DIS GIVEN data item, we have two edit 
values: N and Y. The text entered for the lookup columns explains how these 
options are used.) 

Figure 5.19—Example Edit and Lookup Values (Discounts Given Data Item)

6. Click Apply to save your information and remain in the Edit Values window, or 
click OK to save your information and return to the Edit Values tab.

Remember: By entering edit values (an option enable by your selection 
on the General tab), you are indicating that the edit values are the only 
entry allowed for the data item. You will normally enter more than one.

7. When you have added all the necessary edit values, click Apply to save your 
information and remain in the vendor data item record, or click OK to save your 
information and return to the AP Data Items Maintenance window.

EDITING VENDOR DATA ITEMS

Use the following steps to edit a vendor data item.
Data Items—Vendors 
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1.  Click Maintenance > Vendor Data Items on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Vendor Data Items from the menu bar. The AP 
Data Items Maintenance window displays (Figure 5.20).

Figure 5.20—Editing a Vendor Data Item

2. Select the vendor data item to be edited.

You can click a column heading to sort the vendor data items by the 
column entries. You can also find a specific reference by typing the 
name (or first few characters) in the Locate Data Items by Name field; 
FundWare will search for the matching data item.

3. Double-click, click Edit, or right-click and select Edit from the shortcut menu. 
The Accounts Payable Data Item Maintenance window displays.

4. Edit the information as necessary.

5. Click Apply to save the information and remain in the Accounts Payable Data 
Item Maintenance window. Click OK to save and return to the AP Data Items 
Maintenance data window.

DELETING A VENDOR DATA ITEM

1.  Click Maintenance > Vendor Data Items on the module navigator (if the 
module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Vendor Data Items from the menu bar. The AP 
Data Items Maintenance window displays.

2. Select the vendor data item to be deleted. 
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You can click a column heading to sort the vendor data items by the 
column entries. You can also find a specific reference by typing the 
name (or first few characters) in the Locate Data Items by Name field; 
FundWare will search for the matching data item.

3. Click Delete (or right-click and select Delete from the shortcut menu). A 
confirmation message displays.

4. Click Yes. The data item is deleted.

 

Data Items—Vendors 



C H A P T E R  6

AP MAINTENANCE TASKS

To maintain your Blackbaud FundWare AP system, you may occasionally need to clear 
in-use flags on obligations or purge paid invoices and inactive vendors.

RESETTING AP OBLIGATION FLAGS
If your FundWare system shuts down while you are processing Accounts Payable 
obligations (e.g., the power goes out), any obligations that were open at that time will 
have an in-use flag. This in-use flag means that you will not be able to edit or modify the 
obligation until the flag is cleared. Use the following steps to remove in-use flags. 

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Ensure that all users are logged out of Accounts Payable. (Current FundWare 
users are displayed on the System Administration HomePage.)
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4. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 6.1). 

Figure 6.1—Division Maintenance Window

5. In the Clear AP Flags area, click Clear Flags. When the system has cleared the 
AP flags on all your divisions, a confirmation message displays.

If a flag could not be cleared, FundWare will produce the 
OTFLAG.L## report (where ## represents your division number). This 
report will list temporary subfolders (e.g., New, Edited) that contain 
obligations. You must post these obligations and re-run the Clear AP 
Flags task.

6. Click OK. The in-use flags are removed.

PURGING PAID INVOICES
You can purge paid invoices as long as the following things are true:

• Everyone is logged out of Accounts Payable.
Purging Paid Invoices 
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• You are at the reconciled stage—If you do not reconcile your checks as part of 
your Accounts Payable process, you can review a document on the web site 
(Support > Answers Online) with instructions for purging at the Paid stage 
(i.e., defined in field 3 of the Extended Setup parameter). In Division 95, this is 
Stage 60.

• The reconciled date is on or before the date you enter in Purge Paid Invoices.
You should not use this function until all reports and tax forms (including 1099s) for 
purge candidates (i.e., paid invoices that you want to purge) have been produced and 
archived. You should always backup your data before purging anything. The purge task 
has two options:

• Preliminary—After you enter selection criteria, the invoices are reviewed and 
the purge candidates are reported. The Preliminary task does not purge invoices 
and it can be performed as often as you like.

• Final—After you enter selection criteria, the invoices are reviewed and those 
with no activity are purged.

Use the following instructions to purge paid invoices.
1.  Click Maintenance > Purge Paid Invoices on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Purge Paid Invoices from the menu bar. The Purge 
Paid Invoices screen displays (Figure 6.2). 

Figure 6.2—Purge Paid Invoices
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2. Complete the required information according to Table 6.1. 

When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

3. Type 0 to accept your entries. The program asks if you want to file a report.

4. Type Y to file the Purge report (OTPUR.L##, where ## represents your division 
number), or N to print the report directly to your printer.

If you type N, the print options window displays. Enter your printing 
options and click OK.

When the task is complete, FundWare closes the Purge Paid Invoices window.

Table 6.1—Purge Paid Invoices

Field Name Description

Preliminary We strongly suggest that you produce a preliminary report and review the selected 
invoices before purging them permanently from your system.
• Y = Produce the preliminary OTPUR report for the paid invoices that meet the 

selection criteria.
• N = Delete the paid invoices meeting the selection criteria and produce the OTPUR 

report.

Purge processing—Complete the following fields.

•  From stage This is always the reconciled stage (usually stage 70).

•  Before Include all invoiced reconciled on or before this date (not invoiced on or before this 
date).
• Date format must be mm/dd/yy.

•  Report Ref Reference used to sort invoices on the report. 
• Default = A (obligation).
Purging Paid Invoices 
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5. If you created a preliminary report, review the information (Figure 6.3). 

Figure 6.3—Example OTPUR Report

6. Repeat the purge process (step 1 through step 4), this time typing N for the 
Preliminary entry on the Purge Paid Invoices screen (i.e., indicating that this is a 
Final purge).

After you purge your paid invoices, you must rebuild the OTI and OCD 
files. 

When you do a Final purge of paid invoices, the purge information is 
appended to the OTPUR report.

7. Open an instance of FundWare.

8. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division when logging in, you must select System 
Administration.)
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9. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 6.4). 

Figure 6.4—System Utilities Window

10. In the Execute Program area, enter the required information according to Table 
6.2. This program will reset the vendor keys to ensure that they are associated 
with the correct vendors. 

Table 6.2—Resetting Vendor Keys

Field Entry

Program Name OTS990

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
Purging Paid Invoices 
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11. Click Run. The system ask you to confirm that you want to reset your vendor 
keys (Figure 6.5). 

Figure 6.5—System Utilities Window

12. Type Y or press ENTER to begin the task. When the task is complete, you return 
to the System Utilities window.

13. In the Execute Program area, enter the required information according to Table 
6.3. This program will cleanup your vendor summary data to reflect the purged 
information. 

14. Click Run. When the task is complete, you return to the Execute Program 
window.

Table 6.3—Updating Vendor Summary Data

Field Entry

Program Name OTS906

Switches 3

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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15. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 6.1). 

Figure 6.1—Division Maintenance Window

16. In the Clear AP Flags area, click Clear Flags. When the system has cleared the 
AP flags on all your divisions, a confirmation message displays.

If a flag could not be cleared, FundWare will produce the 
OTFLAG.L## report (where ## represents your division number). This 
report will list temporary subfolders (e.g., New, Edited) that contain 
obligations. You must post these obligations and re-run the Clear AP 
Flags task.

17. Click OK. The in-use flags are removed.

18. Close this instance of FundWare.

19. Locate the APCheckMaint.exe file in the FundWare > 7.40 > Bin folder.
Purging Paid Invoices 
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20. Double-click to open the IBR/AP Check Data Maintenance utility (Figure 6.2). 
This utility will synchronize your data following this purging process. 

Figure 6.2—IBR/AP Check Data Maintenance

21. Select the correct division from the drop-down list.

22. Click Start. When the process is complete, a message displays.

23. Click OK.

PURGING VENDORS
You can purge vendors as long as the following things are true:

• Everyone is logged out of Accounts Payable.
• The vendors that you want to purge have no obligations (i.e., no activity) at any 

stage.
• You have already run the Purge Paid Invoices task (see Purging Paid Invoices 

on page 1.188).
Once a vendor is purged, all the data about that vendor is deleted and cannot be 
displayed or included in reports.
You should not use this function until all reports and tax forms (including 1099s) for 
purge candidates have been produced and archived. You should always backup your 
data before purging anything. The purge has two options:
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• Preliminary—After you enter selection criteria, the vendors are reviewed and 
the purge candidates are reported. The Preliminary task does not purge vendors 
and it can be performed as often as you like.

• Final—After you enter selection criteria, the vendors are reviewed and those 
with no activity are purged.

Use the following instructions to purge inactive vendors.
1.  Click Maintenance > Purge Inactive Vendors on the module navigator (if the 

module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Maintenance > Purge Inactive Vendors from the menu bar. The 
Purge Inactive Vendors screen displays (Figure 6.3). 

Figure 6.3—Purge Inactive Vendors, Preliminary Option

2. Enter the appropriate option for a preliminary or final purge.

• Type Y to produce preliminary OTVPRG report for the vendors that meet 
the selection criteria.

• Type N to delete the inactive vendors meeting the selection criteria and 
produce the OTVPRG report.

We strongly suggest that you produce a preliminary report and review the 
selected vendors before purging them permanently from your system.
Purging Vendors 
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3. Press ENTER. The vendor selector screen displays (Figure 6.4). 

Figure 6.4—Vendor Selector Screen

4. Enter the field on which you will sort the vendors. The selection criteria 
associated with the field displays. For example, if we type 1 for the Vendor 
field, Figure 6.5 displays. 

Figure 6.5—Selection Criteria for Vendor Field

5. Complete the selection criteria to determine the vendors to be purged. When 
you have completed all fields, FundWare displays a message at the bottom of 
the window indicating that the selection has been added.

6. Press ESC to return to the Purge Inactive Vendors screen.
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7. Enter additional selection criteria, if required.

8. When complete, type E to end the task. The system offers you the chance to 
return to a field or accept your entries.

9. Type 0 to accept your entries. The program asks if you want to file a report.

10. Type Y to file the Purge report (OTVPRG), or N to print the report directly to 
your printer.

If you type N, the print options window displays. Enter your printing 
options and click OK.

When the task is complete, FundWare closes the Purge Inactive Vendors 
window.

11. If you created a preliminary report, review the information (Figure 6.6). 

Figure 6.6—Example OTVPRG Report

12. Repeat the purge process (step 1 through step 4), this time typing N for the 
Preliminary entry on the Purge Inactive Vendors screen (i.e., indicating that this 
is a Final purge).

After you purge your inactive vendors, you must rebuild the OTI file, as 
explained in the following steps.

When you do a Final purge of inactive vendors, the purge information 
is appended to the OTVPRG report.
Purging Vendors 
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13. Open an instance of FundWare.

14. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

15. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 6.7). 

Figure 6.7—System Utilities Window

16. In the Execute Program area, enter the required information according to Table 
6.4. This program will reset the vendor keys with their associated vendors (i.e., 
rebuild the OTI file). 

17. Click Run. When the task is complete, you return to the Execute Program 
window.

Table 6.4—Resetting Vendor Keys

Field Entry

Program Name OTS990

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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18. Close this instance of FundWare.

 

Purging Vendors 



A P P E N D I X  A

POSTING TRANSACTIONAL DATA ITEMS

Accounts Payable gives you the option of posting up to three transactional data items to 
General Ledger–Project/Grant (GL) through your AP journals (e.g., purchasing, cash 
disbursement). For example, you could post a description line, the check number 
(internal or external), the invoice date, or the vendor’s name. The information stored 
within these data items are then attached to the GL transaction.

Once you have configured your system for transactional data items, you can produce the 
following GL reports to include the additional data items:

• Ledger Report,
• Account Detail,
• Journals List, and
• Transactions by Reference Report.

Use the following instructions to configure your Accounts Payable system to use 
transactional data items.

1.  Click Setup > Basic Setup on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > Setup > 
Basic Setup from the menu bar. The task option menu displays.

2. Type D to display or C to change the parameter.
Blackbaud, Inc. 1.201



Blackbaud FundWare Accounts Payable Guide—Volume 1

1.202
3. Confirm that the Basic Setup parameter is defined to post to General Ledger. 
These settings are found in field 3 on page 2 of the parameter (Figure 1.1). 

Figure 1.1—Example Basic Setup Parameter Defined to Post to GL

4. If necessary, modify the parameter to define posting settings for General 
Ledger.

5. Exit the parameter, saving any changes.

6. Click General Ledger > Maintenance > Journals on the module navigator or 
the menu bar. The Journal window displays.
 



Appendix A—Posting Transactional Data Items
7. Define your AP journals to accept up to three additional data items (probably 
some or all of the data items identified in the Extended Setup parameter). For 
example, Figure 1.2 shows the definition for the Division 95 purchasing 
journal. 

Figure 1.2—Example Purchase Journal, Additional Data Items

The additional data items must already exist before you can add them to 
the journal definition.

You must define all AP journals to post the same additional data items. 
For example, in Division 95, the AP journals (PURCH, ENCUM, and 
CDIS) are all defined to post the invoice date, description line 1, and 
PO number as additional data items. (However, the PO number is 
actually an obligation reference, not a data item.)

8. Click Setup > Extended Setup on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > Setup > 
Extended Setup from the menu bar. The task option menu displays.

9. Type C to change the Extended Setup parameter. The first page of the parameter 
displays.
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10. Move to the second page of the parameter (Figure 1.3). 

Figure 1.3—Extended Setup Parameter—Page 2 of 3

11. In field 4, enter up to three additional data items that FundWare will post from 
Accounts Payable to General Ledger, according to Table A.1. 

Table A.1—Available Transactional Data Items

Entry Data Item

0 Post nothing.

1 Post description line 1.

2 Post description line 2.

3 Post description line 3.

4 Post the internal check number.

5 Post the external check number.

6 Post the invoice date.

7 Post the vendor name.

A–Z Post an obligation reference. (For more on obligation references, see 
Data Items—Obligation References on page 1.165.)
 



Appendix A—Posting Transactional Data Items
Figure 1.4 shows the Division 95 settings where we post the invoice date, 
description, and PO number. (The obligation reference for PO Number has a 
reference letter of “P.”) 

Figure 1.4—Example Data Item Settings

12. Save your settings and exit the task.

When you complete obligation entry tasks that post to GL, FundWare will automatically 
include the data items defined in the parameter per the definition of the journal involved 
in the transaction. No additional entry is required of the user unless you are posting a 
user-defined data item. For example, if the system is defined to post the PO Number 
(obligation reference P in Division 95), you must manually enter a value on the Data 
Items tab of the obligation. 
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GLOSSARY

Symbols or Numbers
1099 Form—The IRS tax form for reporting payments made to non-corporate service 
providers. The 1099 lists the payer and vendor names, addresses and tax ID numbers, 
and the amount paid and Federal income tax withheld during the year. 
1099 Vendor Record—The information extracted into the 1099 module for each 
vendor. Contains the vendor’s name, address, tax ID number, the amount paid, and 
Federal income tax withheld during the year.

A
Account Mask—Allows you to group accounts using only one entry. A mask uses a 
variable (X) in place of an actual number. See also Masking.
Account Number—The number that stores transaction information in a financial 
reporting system.
Adjusting Entry—An automatic correcting transaction made by Accounts Payable 
when an account number or amount changes for an obligation that has already been 
posted to the General Ledger module.

B
Business Date—Date selected when you sign on to FundWare. It is also called the 
posting date. It must exist in the date table, and it determines the period in which the 
transaction is posted. It is separate from the computer system date.

C
Change Date—The calendar date on which the obligation was last changed.
Check Number—The check’s preprinted number. 
Check Run—A group of obligations that are marked, paid, and logged in the same 
batch for the same bank.
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Check Status—The step in the check-writing process where a check currently resides.
City Abbreviation—A 1 to 3 character code that defines a city, state, and, optionally, 
postal code and country. The code is used as a data entry short cut.
Control Account—A General Ledger account that contains a summary of the 
transactions for a group of accounts with a similar characteristic. For example, the 
Accounts Payable account in the General Ledger summarizes the payable balances of 
many individual vendors. Accounts Payable uses control accounts to reserve for 
encumbrances and commitments, accounts payable, and cash.
Control Number—A number assigned by FundWare to a check before it is logged. The 
number may or may not equal the preprinted check number.
Credit Memo—A notification from a vendor of a reduction in the amount owed. You 
can enter a credit memo in Accounts Payable as an obligation for a negative (-) amount.
Cut Date—The business date on which a check was written. This is the date printed on 
the check and posted to Accounts Payable and the General Ledger.
Cut Status—Checks that have been produced but not yet logged.

D
Data Item—A piece of information applied to an obligation or vendor record. AP 
includes two types of data items: Obligation References and Vendor Data Items.
Default—The value used by FundWare if you do not enter your own.
Discount Date—The date used to figure if a discount is available, based on the Use 
Discount Date and the Mark for Pay date.
Distribution Table—An array of accounts and percentages that specify how to allocate 
an obligation distribution. The tables provide a data entry short cut.

F
Financial Institutions—A feature that contains records of information about each bank 
or savings and loan used to process payments in Accounts Payable. The record includes 
the General Ledger account number for the cash account represented by this bank.

I
Internal Check Number—See Control Number.
 



J
Journal—A chronological listing of transactions showing debits and credits to specific 
accounts.

L
Ledger—A collection of all the accounts for a specific financial category. For example, 
a General Ledger consists of accounts recording actual financial transactions.
Log Check Numbers—This task allows you to enter the preprinted check number into 
Accounts Payable. 

M
Marked for Pay Status—Invoices marked as ready for payment.
Mark for Payment—To approve an individual or group of obligations for payment. 
When you produce checks, all marked obligations are paid.
Memorized Obligation—A way to save an obligation and post it again without re-
entering the data. Referred to as a recurring obligation in earlier versions of Accounts 
Payable.
Model Division—A sample division that you can use to learn about the Accounts 
Payable module.

O
Obligation—Any payable in FundWare Accounts Payable (e.g., purchase order, 
invoice). As an obligation moves through its normal life cycle, it could have any status 
from an initial order to a reconciled check.
Obligation Number—A system-assigned number given to every payable. It is assigned 
when an obligation is created or when an existing obligation is split. Accounts Payable 
tracks all subsequent activity by the obligation number.
Obligation Records—A payable and all its associated information. An obligation 
record includes: references, banks, city and location abbreviations, vendors, distribution 
tables, and memorized status.
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Obligation Reference Data Items—Obligation reference data items are used to store 
information with a transaction (e.g., purchase order, invoice), such as the vendor invoice 
number, due date, or contract number. For example, you could use a data item to select 
obligations for a specific contract number or due date range. 

P
Purge—To delete obligation or vendor records permanently.

R
Reconciled Status—Mark a check to indicate that it has cleared the bank. This is the 
final check writing stage. 
Recurring Obligation—See Memorized Obligation.
Reference Data Item—Obligation reference data items are used to store information 
with a transaction (e.g., purchase order, invoice), such as the vendor invoice number, 
due date, or contract number. For example, you could use a data item to select 
obligations for a specific contract number or due date range. 
Reporting Date—The date used for history reports. It defaults to the current business 
date.
Run—A group of checks produced at the same time.

S
Scroll—To use a bar to move up/down or right/left in a window when there is more 
information than will fit on a single screen.
Sortkey—An alphanumeric abbreviation for each vendor that allows you to determine a 
sort order.
Split—To divide an obligation into two obligations. Often used to split dollars from an 
encumbrance as the money is actually spent. A split is different from a transfer in that all 
the parts of a transfer have the same obligation number, while a split is assigned a new 
obligation number.
Stage—A specific step in the life of an obligation. The stage indicates the obligation 
status and provides tracking information for each transaction.
 



Stage date—The stage date is a term encountered during setup; however, your 
organization probably renamed this field to reflect your usage. For example, the stage 
date could be the due date in the Invoice stage, or the date issued in the Purchase Order 
stage.

T
Tax ID Number—The identification number assigned by the US government to each 
taxpayer for reporting purposes. Individuals use their social security number, businesses 
use their employer identification number (EIN). 
Transaction—A recorded change in assets, liabilities, and equities, expressed in terms 
of money. In Accounts Payable, a transaction is two or more amounts posted to accounts 
in the General Ledger module due to changes in the status of payable amounts.
Transfer—To move an obligation from one stage to another.

U
Unmark for Payment—To remove an obligation from a check run so that it will not be 
paid.
Unused Check—A check that cannot be used as a manual or computer check. These 
include checks that are torn, mangled by the printer, or used to adjust the printer spacing.

V
Vendor—A record containing information about each vendor in the Accounts Payable 
system. The record includes the vendor name, address, and discount information.
Vendor Data Items—Store additional information with the vendor record (e.g., e-mail 
address, alternate contact name). 
Void Status—Checks that have been voided after being printed or written.

W
Wild Card—A character used to represent any other character(s). In searches, a wild 
card means “find any character or group of characters that occur at this point.” Accounts 
Payable uses an asterisk (*) as a wild card. For example, in field 8 of the stage definition 
and in Inquiry.
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C H A P T E R  1

INTRODUCTION

The Blackbaud FundWare™ Accounts Payable module provides complete payables 
processing, including: creating requisitions, purchase orders, and invoices; writing 
checks; and posting financial and AP information to your FundWare General Ledger.
With AP, you get the ability to:

• Implement budget controls for all users with three levels of user-defined 
thresholds (message, warning, and full lock-out) while entering obligations.

• Access vendor information quickly and easily, including obligation from 
requisition to check reconciliation.

• Define your system to reflect each step of your AP process (e.g., requisitions, 
purchase orders [encumbrances], invoices) and multiple approval levels.

• Generate automatic interfund transactions when expenses are coded to multiple 
funds.

• Automatically calculate purchase discounts and due dates.
• Add vendors easily, at any time.
• Manage multiple checking accounts.
Blackbaud, Inc. 2.1
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EXAMPLE AP PROCESS
Table 1.1 defines an example AP process for an organization that uses purchase orders, 
based on the setup provided in the sample divisions (Division 95 and Division 96). 
However, remember that you can fully customize the AP process to meet the needs of 
your organization.

Table 1.1—Example AP Process

Step Additional Information

Enter a new purchase order.
• The new purchase order is saved to the 

Purchase Orders > New temporary 
subfolder. 

• In Division 95, purchase orders are entered at stage 20.

Review the new purchase order and post 
to the main Purchase Orders folder.

• You can use this step as review process before posting 
(potentially to GL). Also, some organizations use this 
step as an approval process (e.g., using the Verify 
task).

• In Division 95, purchase orders post to the 
Encumbrance journal (ENCUM). (Not all stages post to 
GL. This will depend on how you define the Basic Setup 
parameter and PO Extended Setup parameter.) 

• Any time you post information to GL, you should print 
and review the GL posting trace report to verify your 
entries. You should also save the printed trace reports.

Transfer the purchase order to the invoice 
stage. 
• The transferred invoice moves to the 

Invoices > Transferred From P.O. 
temporary subfolder.

• In Division 95, invoices are transferred to or entered at 
stage 30. 

Review the transferred invoice and post to 
the main Invoices folder.

• You can use this step as review process before posting 
(potentially to GL). Also, some organizations use this 
step as an approval process (e.g., using the Verify 
task).

• In Division 95, the invoice information posts to the 
Purchasing journal (PURCH). (Not all stages post to 
GL. This will depend on your Basic and Extended 
Setup.)

• Any time you post information to GL, you should print 
and review the posting trace report to verify your 
entries. You should also save the printed trace reports.
Example AP Process 
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Mark for payment by a specific Financial 
Institution account (FIA). 
• The marked invoice moves to the 

Marked for Pay > New Mark temporary 
subfolder for the specified FIA.

• In all divisions, checks are marked for pay at stage 50. 

Review the marked invoice and post to the 
main Marked for Pay folder.

• You can use this step as review process before posting 
(potentially to GL). Also, some organizations use this 
step as an approval process (e.g., using the Verify 
task).

• This stage is not defined to post to GL.
• FundWare requires that you mark obligations for 

payment at stage 50.

Write and log checks. • In Division 95, information on paid obligations is posted 
to the Cash Disbursement journal (CDIS). (Not all 
stages post to GL. This will depend on your Basic and 
Extended Setup.)

• Any time you post information to GL, you should print 
and review the posting trace report to verify your 
entries. You should also save the printed trace reports.

• FundWare requires that paid obligations are stored at 
stage 60.

Reconcile checks. • You can reconcile checks using our Integrated Bank 
Reconciliation module (for more information, contact 
your Sales representative) or the reconciliation feature 
within AP.

• FundWare requires that reconciled checks are stored at 
stage 70.

Table 1.1—Example AP Process (Continued)

Step Additional Information
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EXAMPLE STAGES

FundWare uses “stages” to mark each step of your AP process (e.g., requisitions, 
purchase orders [encumbrances], invoices) and multiple approval levels. For example, 
Table 1.2 shows some example stages in their normal sequence.

Stages 10, 20, and 40 are optional, depending on how your organization 
manages its payables. 

Stages are defined in setup. For more specific information, see Working With Stages on 
page 67.

EXAMPLE POSTING TO GL–P/G JOURNALS

Table 1.3 shows you an example of the journal posting process in AP.

For instructions to define your system to post data items to General Ledger–Project/
Grant, see Posting Data Items to GL–P/G on page 168.

Table 1.2—Default Stages

Stage 10 20 30 40 50 60 70

Step Initial Order 
(Requisition)

Purchase 
Order

Invoice Approved Marked for 
Pay

Paid Reconciled

Table 1.3—Journal Posting

Task Journal Debit Credit

Post Purchase 
Order

Purchase or Encumbrance Expense Reserved for 
Encumbrance

Post Invoices Purchase Expense Accounts Payable

Cancel Invoices Purchase Accounts Payable Expense

Edit Invoices Purchase Varies (based on stage) Varies

Split Invoices Purchase Varies Varies

Produce Checks NA NA NA

Log Checks Cash Disbursements Accounts Payable Cash

Void Checks Cash Disbursements Cash Accounts Payable
Example AP Process 
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CUSTOMIZING AP
AP’s flexibility allows you to customize it to fit the needs of your organization. Table 
1.4 describes some of the customization tasks that you can define during Basic and 
Extended setup. 

SEPARATE AND COMBINED ENTRY

One of the most critical decisions you will make when you configure your system 
concerns the way in which you will enter obligation information:

Table 1.4—Customizing AP

Item Define

Vendors Will you use automatic or manual vendor numbering?
What entry fields should display on the vendor record?

Purchase Orders What printing options do you need to use for your purchase orders?

Obligations What entry fields should display on your obligations?

General Ledger posting What references to you want to include in your GL postings?
To what journals will you post information?
When will you post to GL (i.e., what stage)?
Are there account masks that the posting task will use?
What account or accounts masks will you use for the AP accrual account 
and cash disbursements?
• You can use a single account, or you can mask the account number 

(e.g., by fund).

Stages • What fields will be available at each stage?
• What data items will be displayed or editable at each stage?
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• Separate Entry—Obligation detail is entered on the Line Items tab, and 
accounting information is entered on the Distribution tab. The data on each tab 
is independent, allowing greater flexibility. 

Figure 1.1—Example Data Items Tab (Separate Entry)
Customizing AP 
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• Combined Entry—Both accounting distribution and obligation detail are 
entered on the Detail Lines tab. This provides faster data entry, but requires an 
exact match of the detail and account number. 

Figure 1.2—Example Data Items Tab (Combined Entry)

Once you have posted purchase orders using the “Combined” setting, you may change 
the parameter to “Separate” one time. However, you cannot change from Separate to 
Combined once you have posted obligations. 
To see how this setting will impact how you enter your obligations, see Entering 
Obligations—Separate Entry on page 64 and Entering Obligations—Combined Entry on 
page 74.
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CUSTOMIZING YOUR VENDOR RECORD SETTINGS

You can customize the vendor record to meet the needs of your organization. For 
example, you can enable or disable the Sort key, Name, Phone, Fax, and Alternate 
Name fields on the Vendor tab of the vendor record (Figure 1.3), although we strong 
discourage you from disabling the Name field. You can also allow changes to existing 
entries but disable the fields for future entries. 

Figure 1.3—Vendor Tab
Customizing AP 
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You can enable or disable the Main Address and Alternate Address fields on the 
Address tab of the vendor record (Figure 1.4), although we strong discourage you from 
disabling the Main Address fields. You can also allow changes to existing entries but 
disable the fields for future entries. 

Figure 1.4—Address Tab

You can enable or disable the discount options (Discounts given by Vendor, Percentage, 
and Days) and the Net Days field on the Discounts tab of the vendor record (Figure 
1.5). 

Figure 1.5—Discounts Tab
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You can enable or disable the five Notes fields on the Notes tab of the vendor record 
(Figure 1.6). You can also allow changes to existing entries but disable the fields for 
future entries. 

Figure 1.6—Notes Tab

See Customizing Your Vendor Record Settings on page 40 for instructions to customize 
your vendor record.

CUSTOMIZING YOUR OBLIGATION ENTRY FORMS BY STAGE

For each stage of your AP process, you can customize the obligation entry form to 
reflect the specific needs of your organization at that specific stage. You can display, 
hide, or disable most of the fields by stage, as well as define the label for certain fields. 
Customizing AP 
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For example, the label for the stage date can reflect the stage. In Figure 1.7, the stage 
date is labeled “Invoice Date.” Also, you can define the number of description lines for 
the obligation on the Header tab of the obligation using the Basic Setup parameter. 

Figure 1.7—Obligation Header Tab

At each stage, you can display obligation references (i.e., data items) on the Data Items 
tab of the obligation for user entry (Editable Data Items) or for information only 
(Display Only Data Items (Figure 1.8). 

Figure 1.8—Data Items Tab
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At each stage, you can enable, disable, or hide the Auto button on the Detail Lines tab 
(combined entry) or Distribution tab (separate entry) of the obligation (Figure 1.9). 

Figure 1.9—Detail Lines and Distribution Tabs

See Customizing Your Obligation Forms on page 44 for specific instructions to 
customize your obligation entry forms.

USING MASKS
A mask is an FundWare term for using a “wild card” in an account number to indicate a 
group of accounts. The best use of this feature is for processing and reporting. Where an 
X is placed in a mask, any value in that digit position will be accepted. 

In Sample Division 95, if you enter the mask A01 00-00 111X in the Account 
Selector, you will get five accounts (A01 00-00 1110, A01 00-00 1111; A01 00-
00 1112; A01 00-00 1114; A01 00-00 1115).

When posting, FundWare completes the account number by replacing the masked 
characters with the digit in the matching position of the account in the balancing side of 
the entry.
Using Masks 
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Your setup includes an Accounts Payable liability account of AXX 00-00 2110. 
When you post an expense to account A03 01-02 7135, the liability posts to 
A03 00-00 2110.

THE ACCOUNTS PAYABLE HOMEPAGE
The Accounts Payable HomePage helps you keep an eye on your upcoming activities 
and provides you with direct access to produce your reports. The following areas make 
up the AP HomePage:

• Activity Reminder area, and
• Reports area.

ACTIVITY REMINDERS

The Activity reminder area allows you to enter a text note and a due date (optional) for 
module tasks (Figure 1.10). The Activity reminder area is user-specific: only you can 
view the notes that you entered, and you only see your own notes. When you open the 
HomePage, any tasks with due dates earlier than the system date of your computer will 
display as red. 

Figure 1.10—Activity Reminder Area

Use the following instructions to use the Activity Reminder area.
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1.  On the Accounts Payable HomePage, enter up to 100 alphanumeric characters 
in the Activity field (Figure 1.11). 

Figure 1.11—Example Activity Reminder

2. If this task has a due date, enter the date in the Due Date field (Figure 1.12). 
Click the drop-down arrow to access the calendar. This field is optional. 

Figure 1.12—Example Activity Reminder With Due Date

If you do not have any text associated with a due date, the due date will 
not be saved when you exit the HomePage.

Your entries are saved when you close the HomePage or FundWare. You can edit the 
text or date information at any time.

PRINTING REMINDERS

Click Print to print the information in the Activity Reminder area. The report output 
will reflect the current sorting and displays in a preview window, from which you can 
print the information.

DELETING REMINDERS

Use the following instructions to delete a reminder.
1.  Highlight the row.

2. Click Delete. The reminder is removed from your display.
The Accounts Payable HomePage 
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REPORTS AREA
The same categories that you see in Report Manager for the module will also display in 
the Reports Area of the HomePage (Figure 1.13). Each category can expand and 
collapse to show or hide the reports contained within. A single click of a report title will 
display the report parameters screen. Once you enter the details of the report and click 
OK, your report is produced. 

Figure 1.13—Reports Area of the Accounts Payable HomePage

NAVIGATING THE FOLDER TREE
The Accounts Payable module organizes information in different categories, stored in 
the folder tree. At the highest level of the tree, you have three folders that will always 
display. However, the subfolders displayed within these folders are determined by your 
setup. The first-level folders in the Accounts Payable folder tree are described in Table 
1.5. 

Table 1.5—Navigation Tree Folders

Folder Description

Vendors Holds all your vendor records. From this folder you can add, delete, or edit these 
records.

Obligations Contains separate folders for each stage and sub-stage (e.g., purchase orders, 
invoices). The number and name of the folders is determined by how you define 
your stages. 
• The sub-stage folders (e.g., New, Transferred From) display only if they contain 

obligations. 
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These folders work similarly to folders in a Windows environment: when you click a 
folder, its contents display in the right pane of the window (called the detail pane) for 
viewing and manipulating. 
Each folder has a specific set of available options. For example, FundWare provides 
three ways to access an option, as described below and in Figure 1.14:

• Click one of the buttons at the bottom of the screen. They change according to 
what folder is currently open.

• Right-click on an obligation to display a menu, then select one of the options. 
They are the same options on the buttons at the bottom of the window.

Disbursements Holds subfolders for each AP use association defined by your Financial Institution 
accounts (FIAs). Within each subfolder, you will find the checks written from that 
account, divided into additional folders (e.g., Paid, Reconciled). 
• The subfolders (e.g., Paid, Reconciled) display only if they contain checks. 
• The only exception to this is the New Manual Checks subfolder. It always 

appears under each bank so that you can create manual checks.

Table 1.5—Navigation Tree Folders (Continued)

Folder Description
Navigating the Folder Tree 
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• Press the underlined letter while holding down the ALT key (to access an option 
with the keyboard). For example, to access Mark for Pay, press ALT+A. 

Figure 1.14—Folders

Some buttons are not accessible until you select an entry in the detail pane (e.g., an 
obligation or vendor). If a button remains disabled (i.e., grayed-out), your security level 
may not include access to this function. For more information on the Security feature, 
see the Blackbaud FundWare System Administration Guide.

TRANSFERRING OBLIGATIONS

You can use the “drag and drop” functionality to transfer obligations from one folder to 
another. The following rules apply when you move obligations:

• Folders that appear only when they hold obligations (e.g., Mark for Pay) must 
be on the navigation tree for you to drag and drop an obligation to them.

• Security restrictions are respected.
• You cannot drag and drop memorized obligations to create a new obligation.

See Transferring Obligations on page 125 for more information.

Right-click in the detail 
pane to display a menu, 
then select one of the 
options.

Access an option from the 
keyboard by pressing ALT plus 
the underlined letter on the 
button. For example, press 
ALT+A to access Mark for Pay.

Click one of the buttons. 
The set changes for 
each folder.
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THE DETAIL PANES

You have many options when it comes to how much information you want to display in 
the detail panes for the Vendors, Obligations, and Disbursements folders and their 
associated subfolders. You can:

• Reorder the records—Click the header of the category on which you want the 
sort based. Click a second time to reverse the order.

• Hide or display columns—Right-click and select the column to be hidden or 
displayed. A check mark indicates that a column is displayed in the detail pane.

• Adjust the column widths—Click the divider line between the column headings. 
The cursor will change. Move to the left or right until the column is the width 
you want.

• Reorder columns—Click the column heading and drag the column to a new 
position.
When you add or remove columns from the detail pane, the program remembers 
your settings (except column width) when you exit the folder.

FILTERING OBLIGATIONS
While in the obligation stage folders, you can filter the entries in the detail pane to 
match your needs. 

1.  In any of the Obligations subfolders, select the Filter check box (Figure 1.15). 

Figure 1.15—Selecting the Filter Option From the Invoices Folder
Filtering Obligations 
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The Filter window displays. The fields included on the window vary depending 
on the subfolder that you are in when you access the filter feature (Figure 1.16). 

Figure 1.16—Filter Windows

2. Complete the Filter window according to Table 1.6. 

Table 1.6—Filter Options

Option Description

Obl. Reference Select the data item on which you will filter (e.g., Obligation, Vendor number, Due 
date). By default, all matching records will be included in the filtered display (i.e., 
the All check box is selected).
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of values in the fields next to the data item.
• To select a single value, enter the appropriate alphanumeric text in both fields.

Vendor # Range By default, all vendors will be included in the filtered display (i.e., the All check box 
is selected).
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of vendor numbers in the From and To fields.
• To select a single value, enter the number in both fields.

“Stage” Date By default, all obligations will be included in the filtered display, regardless of stage 
date (e.g., “Date Ordered,” “Due Date”). In other words, the All check box is 
selected. Additionally, the From and To date fields are prefilled with the actual date 
(not the business date).
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of dates in the From and To fields. You can use the  
button to select a date from the calendar. 

• To select a single value, enter the number in both fields. You can use the  
button to select a date from the calendar.

Purchase 
orders and 
invoices

Memorized 
obligations
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3. Click OK. The filtered obligations are listed in the detail pane.

To view all obligations, select the Filter check box to remove the check 
mark. All obligations will display in the detail pane.

If no obligations display, your filter settings may be too narrow (i.e., no 
obligations meeting the requirements).

Last Used On 
Date Range

By default, all memorized obligations will be included in the filtered display, 
regardless of last date that the memorized obligation created a new obligation (i.e., 
the All check box is selected). Additionally, the From and To date fields are 
prefilled with the actual date (not the business date). 
• To narrow the scope of your filter, click the All check box to remove the check 

mark and enter a range of dates in the From and To fields. You can use the  
button to select a date from the calendar. 

• To select a single value, enter the number in both fields. You can use the  
button to select a date from the calendar.

This field only displays on a filter for memorized obligations.

Account Mask You can also filter based on the accounts on the obligations by entering an 
account number or mask. This field does not display on a filter for memorized 
obligations.

Table 1.6—Filter Options (Continued)

Option Description
Filtering Obligations 
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SETTING STAGE SECURITY
Accounts Payable allows you to set security restrictions at the stage level. For example, 
we create a group called “Invoice Data Entry” and restrict the users assigned to the 
group to Stage 30 (Invoice) (Figure 1.17). 

Figure 1.17—Security—Allowing Access to Stage 30 (Invoice)
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We can assign a user to this group, which applies the group’s stage restrictions to that 
user. However, we can also modify the default settings for that user (Figure 1.18). 

Figure 1.18—Security—Customizing Users Access to Stage 30 (Invoice)

For more information and instructions on defining your security settings, please see the 
Blackbaud FundWare System Administration Guide.

SOME FUNDWARE BASICS
The following sections provide you information and instructions for opening and 
working in FundWare.

OPENING FUNDWARE

As you begin using FundWare, certain information is saved by the program and offered 
as a default. This has been designed to help you save time and steps, but you can change 
these defaults at any time by entering new information or selecting from the available 
options (depending on the field).

• User name—The program will enter the user name (or user number) of the last 
person to log into FundWare on that computer.
Some FundWare Basics 
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— For security reasons, your password is not automatically entered. You must 
always enter your FundWare password.

• Business date—Defaults to the current system date (according to your 
computer’s operating system).

• Division—The program automatically selects the division you were working in 
the last time you were in FundWare. 
— If you have only one division (or have security rights to only one division) 

and do not have security rights to the System Administration area, the 
program will bypass the division selection window. 

— Or, if you only have security rights to the System Administration area, the 
program will bypass the division selection window and open directly to the 
System Administration HomePage.

• HomePage—The program automatically opens to the HomePage of the module 
in which you were working the last time you were in FundWare. 

Use the following instructions to open and log into FundWare.
1.  Double-click the FundWare icon on your desktop or select Blackbaud 

FundWare® Enterprise or Professional from your Windows Start menu. The 
Login window displays. 

Figure 1.19—FundWare Login Window

2. Enter your user name in the User Name text box. You can enter your user 
number instead of your user name, if preferred. 

The User Name field will default to the last entry on this computer and 
the system will move to the Password field.

3. Enter your password in the Password text box. Your password entries will 
display as asterisks (*) as you type to maintain the privacy of your password. 
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4. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

Figure 1.20—Selecting the Date

5. Click OK. If your User Name, Password, and Business Date are verified, the 
Select Division window displays, defaulting to the division you were working 
with the last time you were in FundWare. 

Figure 1.21—Selecting the Division

If your organization uses the password aging feature, you may receive a 
message indicating that your password will or has expired. You will be 
offered the chance to enter a new password at this time. See Changing 
Your Password During Login on page 25.

If you have only one division (or have security rights to only one 
division) and do not have security rights to System Administration, the 
program will bypass the Select Division window. Or, if you only have 
Some FundWare Basics 
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security rights to System Administration, the program will bypass the 
division selection window and open directly to the System 
Administration HomePage.

6. If necessary, select a different division (or System Administration) from the list. 

7. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

For users upgrading from earlier versions of FundWare, please note that you can only 
have one division open at a time in each instance of FundWare (a change in 
functionality). However, you can open the program multiple times for the same or 
different divisions and/or business dates.

CHANGING YOUR PASSWORD DURING LOGIN

If your organization uses the password aging feature (defined through System 
Administration), you may receive a message indicating that your password will or has 
expired. 

Figure 1.22—Password Expiring

Use the following instructions to change the password at this time.
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1.  Click Yes to the password expiration message. The Change Password window 
displays. 

Figure 1.23—Changing Your Password During Login 

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

You can also change your password from within the software. See Changing Your 
Password From the Software on page 29.

OPENING FUNDWARE MULTIPLE TIMES

Each “instance” of FundWare (i.e., each time you open the program) represents a single 
division on a single business date. However, you can open as many instances of 
FundWare as necessary to meet your needs. 
When dealing with multiple instances of FundWare, keep the following rules in mind:

• Each instance of FundWare represents a single user, division, and business date, 
or represents access to the System Administration features by a single user. 

• You can open as many instances of FundWare as necessary (i.e., for different 
users, business dates, or divisions).
Some FundWare Basics 
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• You can still change the business date for the current instance of FundWare 
without opening a new instance. See Changing the Business Date on page 28 
for more information.

OPENING ADDITIONAL INSTANCES—FROM THE DESKTOP/START MENU

If you have one or more instances of FundWare open already, you can open additional 
instances of the program from your desktop or the Windows Start menu. You will be 
asked to identify the user, password, business date, and division (the same steps as 
opening the first instance of FundWare).

OPENING ADDITIONAL INSTANCES—FROM THE PROGRAM

You can also open a new division or a new instance of the same division from within 
FundWare. Because you are opening this division from the program, the system applies 
the same user and password to the new instance and allows you to select a new division 
or business date.

If you want to open a new instance of FundWare for a new division or a new 
business date, you can open the program from the desktop or Windows Start 
menu or from the Change Business Date task. For instructions on changing the 
business date, or opening a second instance of the program with a different 
business date, see Changing the Business Date on page 28.

Use the following instructions to open a new instance of FundWare for the current user 
and business date.

1.  Select File > Open FundWare from the menu bar. The Open New Instance 
window displays, automatically selecting the division you were working with 
the last time you were in FundWare. 

Figure 1.24—Opening a New Instance of FundWare

2. If necessary, select a different division (or System Administration) from the list. 
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3. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

4. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

CHANGING THE BUSINESS DATE

You can change the business date for your current instance of FundWare or open a new 
instance of the same division with a different business date using the Change Business 
Date task. When you choose to open a new instance of the same division, the system 
applies the same user and password to the new instance and takes you directly to the 
HomePage for the module in which you were last working in that division.

1.  Select Edit > Change Business Date from the menu bar. The Change Business 
Date window displays. 

Figure 1.25—Changing the Business Date 

1 Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you can 
click the down-arrow to select a date from the calendar.

2 Select the applicable option for applying the new business date:
• Current Instance of FundWare—Changes the business date for the current 

instance of FundWare. This option does not apply any changes to other 
instances of FundWare and does not open a new instance of the program.

The “Classic” windows will not accept a changed business date. If you 
have any of the Classic screens open when you attempt to change the 
business date for the current instance of FundWare, the system will 
return a message and not allow you to proceed. Close the Classic 
windows and try again.
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• New Instance of FundWare—Opens a new instance of FundWare to the 
HomePage for the module in which you were last working, applying the 
same user, password, and division but using the new business date.

1.  Click OK. The program applies your selection.

CHANGING YOUR PASSWORD FROM THE SOFTWARE

Use the following instructions to change the password for the current user.
1.  Select Edit > Password from the menu bar. The Change Password window 

displays. 

Figure 1.26—Changing the Current User’s Password

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

If your organization uses the password aging feature (defined through System 
Administration) and your password is nearing or has passed the expiration date, you can 
also change your password during the login process. See Changing Your Password 
During Login on page 25.
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USING THE MENU BAR

Each module for which your organization is licensed and to which you have security 
rights displays in the menu bar. From these menu options, you can access all module-
specific tasks (e.g., General Ledger > Journal Entries > New). In addition, you will 
use the menu bar to access specific program tasks (e.g., changing the business date):

• File—Open divisions; access Print Manager, Report Manager, or Financial 
Institutions.

• Edit—Change the business date or your password.
• View—View or close Navigator bar; view full or abbreviated menu names; 

view logged in users.
• Window—See all currently open windows, switch between these windows.
• Help—Access online help for the current module and program information. 

KEYBOARD NAVIGATION

To help you navigate quickly through the program, FundWare allows you to use your 
keyboard instead of your mouse to access program tasks.

• Menu bar—You can access any task listed on the menus using a combination of 
the ALT key and a letter and the arrow keys.
— Press the ALT key.
— Press the underlined letter of the item to display the menu. The menu 

displays.
— Use the arrow key and press ENTER to select a task.

• Shortcut menus—Access any applicable shortcut menus (normally displayed 
when you right-click your mouse) from the keyboard by pressing either 
SHIFT+F10 or the Application key (offered on many newer keyboards, located 
between the WINDOWS key and the CTRL key, to the right of the spacebar).

• Shortcut keys—Shortcut keys combine the CTRL key with a letter to give you 
direct access to certain tasks. These shortcuts are listed on the menus with the 
applicable tasks. 

• Drop-down lists—You can access any drop-down list when focus is on the 
associated field by using a combination of the ALT key and the down arrow key. 
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IS YOUR MENU BAR TOO CROWDED?

If your organization is licensed for a number of FundWare modules, your menu bar may 
be too wide to use conveniently. You can change the module names that are listed in the 
menu bar to display as acronyms, which will decrease the width of the bar:

• Select View > Abbreviated Menu Names from the menu bar. To change back, 
select View > Full Menu Names from the menu bar.

HOW YOUR SECURITY RIGHTS IMPACT THE MENU BAR

Your individual security rights may impact the modules and tasks that you see on the 
menu bar. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the menu bar.

• If your security settings allow you to access some, but not all, tasks in a module, 
the restricted tasks will not be listed in the menu bar.

USING THE NAVIGATOR BAR

The Navigator bar provides you with quick, mouse-driven access to your modules, 
module tasks, and currently open windows through two areas:

• Module navigator, and
• Open windows navigator.

You can resize the Navigator bar to meet the needs of your display by using your mouse 
to click on the right frame of the bar and drag the frame to the position you want. You 
can also hide or show the Navigator bar using the options on the View menu. Select the 
option to hide or show the bar, as applicable. These settings will be retained by the 
system when you close FundWare.

MODULE NAVIGATOR

The module navigator lists the modules for which your organization is licensed (unless 
your individual security settings do not allow you to access a module). When you click a 
module (it just takes a single click), the module expands to display all of the associated 
module tasks. 
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Accessing any of the tasks within the module takes another single click on the specific 
item. Some tasks are “nested” below a title. A single click will expand the title, 
displaying the related tasks below. 

Figure 1.27—Module Navigator—Expanded Menus

If your security settings restrict your access to specific tasks, those tasks will not 
be listed in the menu bar. 
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OPEN WINDOWS NAVIGATOR

The open windows navigator lists the windows that are currently open in this instance of 
FundWare, highlighting the window currently displayed. A single click of an entry in 
the open windows navigator redisplays the window in your workspace. 

Figure 1.28—Open Windows Navigator

As with all Windows applications, the more FundWare windows that you open 
concurrently, the greater impact to your processor speed. You can use the Open 
Windows Navigator to monitor how many windows you have open at any one 
time.

HOW YOUR SECURITY RIGHTS IMPACT THE NAVIGATOR BAR

There is no security impact to the open windows navigator. If your security rights 
allowed you to open a task, then that window will display in the open windows 
navigator. However, your individual security rights may impact the modules and tasks 
that you see on the module navigator. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the module navigator.

• Any tasks within a module from which you are restricted will not be listed in the 
menu bar. 

CUSTOMIZING YOUR DISPLAY

Throughout FundWare, you will encounter forms (similar to a table or spreadsheet) that 
allow you to customize the display through the shortcut menu (accessed by right-
clicking your mouse) or through direct manipulation with your mouse. Most of these 
settings are retained with your user name. Therefore, the forms display according to 
your settings wherever you log in to FundWare. (In other words, the program 
remembers how the form displayed when you closed FundWare. This is how it will 
display the next time you open the program.)
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Not all forms provide these options. If you attempt one of the customization 
options described here and are unsuccessful, it is likely that the option is not 
offered on that form.

HIDING AND DISPLAYING COLUMNS

To add or remove a column from a form, hover your mouse over the pane and right-
click. A shortcut menu displays, which allows you to hide or display columns from the 
form. 

Figure 1.29—Example Shortcut Menu for the GL New Journal Entry Form

The columns currently displayed in the form are indicated with a check mark. Select a 
column from the shortcut menu to add or remove that column to the detail pane.

If you have disabled fields through the module setup (e.g., the Accounts 
Payable parameter or stage settings), the associated column will not be listed on 
the shortcut menu.

RE-ORDERING THE COLUMNS

To re-order the columns in a form, “drag and drop” the column by clicking the column 
heading and moving the column to the desired position (holding the mouse button 
down).

In this example, the Account column is disabled 
because this column must always display. 

The remaining columns are currently displayed in the 
New Journal Entry form.
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RESIZING THE COLUMNS

To resize a column, hover your mouse over the column border until the icon changes. 
Figure 1.30—Mouse Icon

Click your mouse button and drag the column border until it is the desired width.

SORTING THE ENTRIES IN A FORM

To resort the entries in a form, click the heading of the column on which you want the 
sort based. To reverse the sort order, click the column heading again. 

Figure 1.31—Sorting the Detail Pane

Sort order is not retained when you close FundWare.

HELP

If you encounter questions or problems while you are working in the program, you can 
access the online help from the Help menu (on the menu bar) or by clicking F1 to access 
the online help for the current module.

Original display.

Entries resorted 
based on Obligation 
number.

Entry order reversed.
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You can also access PDF files (portable document format) of the guides from your 
server:

• FundWare\Data\User Documentation
You must have Adobe Acrobat Reader installed to view the files. This program is 
available from the FundWare CD or as a free download from www.adobe.com.

TRAINING AND CONSULTING SERVICES

Blackbaud, Inc. offers a number of options to help you improve your use of FundWare.
• Regional classes—Training classes held several times per month in various 

cities across the nation. These one- to five-day classes provide a hands-on 
learning environment and low student-to-instructor ratio.

• eClasses—Interactive training classes offered over the Internet provide you and 
your staff the opportunity to receive training from FundWare experts without 
leaving your desk.

• Onsite custom training sessions and consulting—Our training/consulting group 
offers you onsite services, including:
— Training your staff using your data.
— Installing/upgrading and configuring the software to meet the specific needs 

of your organization.
For more information about any of our training or consulting services, please explore 
our Web site (http://www.blackbaud.com) or contact our Client Sales department (800-
551-4458).

USING THIS DOCUMENT

This manual is organized to reflect the most common uses of the module. It provides 
you with overview information of FundWare, followed by specific features and 
functions of the module.
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CONVENTIONS

Use Table 1.7 as a reference for conventions used in this document. 

GETTING SUPPORT

The following table provides a quick reference for getting the support you need for 
FundWare modules.

Table 1.7—Icon Conventions
Indicator Description

A caution or warning that must be heeded. Information contained in a warning should be care
reviewed to avoid adverse affect on software operation.
An example, used to clarify an issue.

ENTER Keyboard directions are indicated in small capital letters (e.g., Press ENTER).
demo user Specific text entries are indicated with italics (e.g., Type demo user for User Name).
Click OK An item on the screen that requires user interface is indicated in bold.

Table 1.8—Getting Support
Department Contact Description

Business 
Office

800-551-4458 Obtain general information or contact a sta
member.

Technical 
Support

800-227-7575
e-mail: FWSupport@blackbaud.com

Get help resolving technical issues with th
product. Please have the following informa
ready when you call:
• Blackbaud Site ID
• FundWare version number
• Error message details

Knowledgebase
www.blackbaud.com

A searchable database where you can typ
your questions and get a list of possible 
answers.
• Requires your license number and Black

Site ID.
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Training 800-551-4458
Ask for the Client Sales department.

www.blackbaud.com

Contact us for more information on our trai
options:
• Regionals—Classes from 1 to 5 days in 

length; held in cities around the country.
• eClasses—Two- to three-hour classes of

over the Internet.
• Onsite custom training and consulting—O

consulting staff can implement FundWar
and/or train your employees using your 
organization’s data.

Product 
Management

www.blackbaud.com Contact our Product Management departm
with any suggestions for improving FundW

All other 
information

www.blackbaud.com Links are available for all other FundWare 
information including replacement software
user guides and software updates.

Blackbaud, Inc.
6430 S. Fiddler’s Green Circle, Suite 200
Greenwood Village, CO 80111
800-551-4458
303-756-3030

Table 1.8—Getting Support (Continued)
Department Contact Description
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DEFINING AND USING VENDOR RECORDS

Your vendor records are saved in the Vendors folder on the Accounts Payable folder 
tree (Figure 2.1). From this folder, you can add, view, edit, and delete vendors. 

Figure 2.1—Vendors Folder

How your organization defined the Basic Setup parameter will determine certain 
information on the vendor record. See Customizing Your Vendor Record Settings on 
page 1.40 for more information.

ADDING VENDOR RECORDS
The vendor record stores all the information about a vendor, including addresses, notes, 
and Accounts Payable activity. Use the following steps to add a vendor.
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1.  Select Vendors from the folder tree to display the existing vendor records in the 
detail pane. (You can also access vendor records by clicking Maintenance > 
Vendors on the navigator bar or selecting Accounts Payable > Maintenance > 
Vendors from the menu bar. The Vendor Maintenance window displays a list of 
your vendor records.)

2. Click New or right-click and select New from the shortcut menu. The New 
Vendor Entry window displays, open to the Vendor tab (Figure 2.2). 

Figure 2.2—New Vendor Entry, Vendor Tab

3. Enter a number in the Vendor text box. 

4. Complete the information on the Vendor tab according to Table 2.1. 

Table 2.1—Vendor Tab Field Definitions

Field Definition

Vendor Enter the Vendor Number (up to 9 numeric characters).
• If the Auto Vendor # setting, Field 1 of the Basic Setup parameter, is set to “Y,” 

FundWare automatically assigns the vendor number and this field is disabled. 
(See Defining the Basic Setup Parameter on page 1.48 for more information.)
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5. Click Apply to save your entries and remain in the vendor record, or click OK 
to save the information and close the vendor record.

VENDOR ADDRESS TAB

Use the following steps to add address information to your vendor record.

SortKey Allows you to enter an additional name or reference for the vendor (up to 
10 alphanumeric characters). (Optional)
• For example, if the vendor name is officially “Invesco Field at Mile High Stadium,” 

but you know you always call it “Mile High,” you could enter this in the Sortkey.
• You can leave off leading words such as “the.” “The Plant Shop” would be listed in 

the Ts, but using “Plant Shop” as the sortkey might be easier to remember.
• Spelling out numbers might make a vendor easier to find. “First” would be in the 

Fs, but numbers such as 1st would be at the beginning of the list.
• If you file 1099 forms with the IRS electronically, see Using the Sortkey When 

Filing 1099s Electronically on page 2.55 and IRS publications.

Name Enter the Vendor Name (up to 35 alphanumeric characters). 

Phone/Fax Enter the telephone and fax numbers (numeric characters only). 
• FundWare formats the numbers automatically.

Alternate Name Enter an Alternate Vendor Name (up to 35 alphanumeric characters).
• The Alternate Vendor Name and any Alternate Address entry will print instead of 

the Name and Main Address on checks and check registers. 
— If you enter an Alternate Name, AP will also print the Alternate Address even 

if there is no information in these fields.
• This field is enabled only if the setting for Alt Address (Field 1 of the Basic Setup 

parameter) is “Y.” (See Defining the Basic Setup Parameter on page 1.48 for 
more information.)

Table 2.1—Vendor Tab Field Definitions (Continued)

Field Definition
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1.  Select the Address tab (Figure 2.3). 

Figure 2.3—New Vendor Entry, Address Tab

2. Enter the main and alternate vendor addresses. Table 2.2 provides the 
definitions for these fields.

Your Alternate Address entry will print (with the Alternate Name) on 
checks and check registers, instead of the Main Address and vendor 
Name). If the Alternate Name field is blank, AP will print the vendor 
Name with the Alternate Address. If the Alternate Name and Alternate 
Address fields are blank, AP will print the vendor name and Main 
Address.

If you entered an Alternate Name, AP will print the Alternate Name and 
Alternate Address on checks and check registers, even if there is no 
information in the Alternate Address fields (i.e., the address lines will 
be blank).
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This field is enabled only if the setting for Alt Address in your basic 
setup is set to “Y.” (See Defining the Basic Setup Parameter on page 
1.48 for more information.) 

3. Click Apply to save your entries and remain in the vendor record, or click OK 
to save the information and close the vendor record.

VENDOR DISCOUNTS TAB

The discount information and net days entered on the Discounts tab is reflected on your 
obligations. See Applying Vendor Discounts to Obligations on page 2.87 and 
Calculating Obligation Due Dates on page 1.84 for more information. 

The discounts feature is enabled through field 1 of the Basic Setup parameter. 
For more information on this setting, see Defining the Basic Setup Parameter 
on page 1.48.

Use the following steps to add discount information to your vendor record. 

Table 2.2—Vendor Address Tab Field Definitions

Main and Alternate 
Address Field Definition

Street 1 Enter the first line of the street address (up to 35 alphanumeric characters).

Street 2 Enter the second line of the street address (up to 35 alphanumeric characters).

City Enter the city (up to 19 alphanumeric characters).
• Click the lookup button to view a list of your city definitions.

S/T/P Enter the state, territory, or province abbreviation (up to 5 alphanumeric 
characters).

Post Enter the zip code (up to 9 alphanumeric characters). Formatting for 9-character 
zip codes is automatic (xxxxx-xxxx). 
• Select the appropriate radio button to indicate if this code is a U.S. zip code or 

in another country’s format.

Country Enter the country (up to 35 alphanumeric characters).
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1.  Select the Discounts tab to define vendor discounts and due dates (Figure 2.4). 

Figure 2.4—Discounts Tab

2. If the vendor offers a standard discount that you want applied automatically, 
select the Discounts given by Vendor check box (activating the feature) and 
enter the following information:

• Percentage—The percentage of the discount.
• Days—The number of days that the discount is available after the invoice 

date. 
These values are automatically used in check processing. 

3. In the Net Days field, enter the number of days after the invoice date that 
payment is due. You do not have to select the Discounts given by Vendor check 
box to use this field (i.e., Net Days is available even if you are not using the 
Discounts feature).

4. Click Apply to save your entries and remain in the vendor record, or click OK 
to save the information and close the vendor record.

VENDOR NOTES TAB

Use the following steps to add notes to the vendor record.
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1.  Select the Notes tab to enter any special information about this vendor (Figure 
2.5). 

Figure 2.5—Notes Tab

2. Add any necessary information to the note fields.

FundWare recommends that you reserve the Note 1 field for vendor tax 
ID information. When you must report tax information on a vendor, you 
can enter the tax ID number here. By elimination, you can then 
determine the vendors requiring 1099 forms. See Using Notes for 1099 
and Minority Vendors on page 2.56 for more information.

3. Click Apply to save your entries and remain in the vendor record, or click OK 
to save the information and close the vendor record.

VENDOR DATA ITEMS TAB

Use the following steps to add vendor data items to the vendor record.
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1.  Select the Vendor Data Items tab (Figure 2.6). 

Figure 2.6—Vendor Data Items Tab

2. Click New. The Data Item Entry window displays (Figure 2.7). 

Figure 2.7—Example Data Item Entry
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3. Select the Data Item from the drop-down list (any user-defined data items that 
you have created will also display in the drop-down list). There are three 
system-defined data items:

• .VACCT
• .VHOLD
• .VPAYMENT

For more information on these options, see System-Defined Vendor 
Data Items on page 1.176.

4. Enter the required information in the Value text box. (If the vendor data item has 
a default value defined, you can accept or modify this default.) The values for 
the system-defined data items are:

• .VACCT—Enter the default account number.
• .VHOLD—Select either Y (on hold) or N (not on hold) from the drop-down 

menu. (The default selection is N.)
When a vendor is on hold, you will not be able to enter new obligations 
or pay existing ones.

• .VPAYMENT—Select either Combined or Separate from the drop-down 
menu. (The default selection is Combined.) See Using the Combined or 
Separate Check Function on page 2.94 for more information on this feature.

5. Click Apply to save your entries and remain in the vendor record, or click OK 
to save the information and close the vendor record.
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VENDOR ACTIVITY DETAIL AND ACTIVITY SUMMARY TABS

The Activity Detail and Activity Summary tabs are read-only displays of vendor-
related information. The Activity Detail tab displays information about the individual 
vendor obligations (Figure 2.8). 

Figure 2.8—Example Activity Detail Tab

From the Activity Detail tab, you can double-click any entry to view the 
original obligation. (This assumes you have security rights to the Inquiry > 
Obligation task. See the Blackbaud FundWare System Administration Guide for 
more information on security settings.)

The Posted Date reflects the business date when the obligation reached the 
status displayed, with the exception of reconciled and voided paid obligations. 
The Posted Date for reconciled and voided paid obligations reflects the business 
date when the obligation was paid. All business dates are reflected in the 
Revision History when you view an individual obligation.
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The Activity Summary tab displays totals, by category, for the vendor’s activity 
(Figure 2.9). 

Figure 2.9—System Information Tab

EDITING AND VIEWING VENDOR RECORDS
Use the following steps to edit or view a vendor record.

1.  Select Vendors from the folder tree to display the existing vendor records in the 
detail pane. (You can also access vendor records by clicking Maintenance > 
Vendors on the navigator bar or selecting Accounts Payable > Maintenance > 
Vendors from the menu bar. The Vendor Maintenance window displays a list of 
your vendor records.)

2. Select the vendor you want to edit or view.

For tips on searching for vendor records, see Searching Your Vendor 
Records on page 2.50.

3. Double-click, click Edit, or right-click and select Edit from the shortcut menu. 
The vendor record displays. 

4. Move through the tabs and make any necessary edits. For more information 
about the tabs and fields, see Adding Vendor Records on page 2.39. 
Blackbaud, Inc. 2.49



Blackbaud FundWare Accounts Payable Guide—Volume 2

2.50
5. Click OK to save any edits and close the vendor record.

DELETING VENDOR RECORDS
Use the following steps to delete a vendor record with no associated activity (i.e., you 
have not entered any obligations for the vendor).

If a vendor record has associated activity, you cannot delete the record. To 
change the status of a vendor, you must apply the Vendor Data Item .VHOLD. 
See System-Defined Vendor Data Items on page 1.176 for more information.

1.  Select Vendors from the folder tree to display the existing vendor records in the 
detail pane. (You can also access vendor records by clicking Maintenance > 
Vendors on the navigator bar or selecting Accounts Payable > Maintenance > 
Vendors from the menu bar. The Vendor Maintenance window displays a list of 
your vendor records.)

2. Select the vendor record to be deleted.

For tips on searching for vendor records, see Searching Your Vendor 
Records on page 2.50.

3. Click Delete or right-click and select Delete from the shortcut menu. A 
confirmation message displays.

If the vendor has associated activity, a message will display informing 
you that the record cannot be deleted.

4. Click Yes to delete the vendor record. The record is removed from the division.

SEARCHING YOUR VENDOR RECORDS
In the Vendors folder, you can search your vendor records in two ways:

• Click any column heading. The vendor records will be sorted based on the 
contents of the column (e.g., A–Z). Clicking a second time reverses the entries 
(e.g., Z–A).
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• Type all or part of the vendor name (i.e., the first letters of the vendor name) in 
the Search text box at the top of the Vendors folder and click Go (Figure 2.10). 

Figure 2.10—Search Results

In the Vendor Maintenance window, you can also search your vendor records by 
clicking the column or typing the vendor number in the text box (Figure 2.11). 

Figure 2.11—Vendor Maintenance Window
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DISPLAYING VENDOR INFORMATION
The Display Vendors task allows you to display or scroll vendor information. Use the 
following instructions to display vendor information. (Instructions for the Scroll task 
follow.)

1.  Click Display Vendors on the module navigator (if the module is not expanded, 
click Accounts Payable first) or select Accounts Payable > Display Vendors 
from the menu bar. The Display Vendors window displays (Figure 2.12). 

Figure 2.12—Display Vendors

2. Type D to display. Complete the fields according to Table 2.3. 

Table 2.3—Display Vendors

Field Definition

Vendor Enter a valid vendor number.

Display Enter the information to be displayed, or press F1 and select from the displayed options:
• Vendor—Displays the vendor record.
• All obligations for vendor—Displays all obligations (paid and unpaid) for the selected 

vendor. Additional fields will display to filter results.
• Unpaid obligations for vendor—Displays unpaid obligations for the selected vendor. 

Additional fields will display to filter results.
• Paid obligations for vendor—Displays paid obligations for the selected vendor. 

Additional fields will display to filter results.
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When you have completed your entries, the vendor information is displayed 
(Figure 2.13). 

Figure 2.13—Example Results for Display Vendors Task

3. When complete, press ESC to display the option menu and type E to exit the 
task.

Use the following instructions to scroll vendor information.

After Enter a valid date.
• Only available for the obligation display options.

Refs Enter the letter codes for up to four obligation references to be displayed with the 
obligation information.
• Only available for the obligation display options.

Select Enter the letter code for an obligation reference to be used to filter the information 
displayed or leave blank to bypass this filter option.
• If you enter an obligation reference, you must also enter a range of values to determine 

the obligations displayed.
• Only available for the obligation display options.

Table 2.3—Display Vendors (Continued)

Field Definition
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1.  Click Display Vendors on the module navigator (if the module is not expanded, 
click Accounts Payable first) or select Accounts Payable > Display Vendors 
from the menu bar. The Display Vendors window displays (Figure 2.14). 

Figure 2.14—Display Vendors

2. Type S to scroll. Complete the fields according to Table 2.4. 

Table 2.4—Scroll Vendors

Field Definition

Selected data item Enter a vendor data item by which the information in the display will be sorted or 
press F1 and select from the displayed options.

Selected value Enter a value for the selected data item by which FundWare will filter the results 
displayed.
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When you have completed your entries, the vendor information is displayed 
(Figure 2.15). 

Figure 2.15—Example Results for Display Vendors Task

3. When complete, press ESC to display the option menu and type E to exit the 
task.

USING THE VENDOR RECORD TO PRODUCE 1099 FORMS
You can use the Sortkey field, Notes, or data items on the vendor record to help you 
produce your 1099 forms. 

USING THE SORTKEY WHEN FILING 1099S ELECTRONICALLY

If you will be filing your 1099s electronically with the IRS, you must include a four-
character “Name Control” for each vendor. Consult your IRS instructions for complete 
details on what is required in this field. 
The 1099 module will extract the first four characters of the vendor’s Sortkey for this 
purpose. You should define the Sortkey in the Accounts Payable vendor maintenance 
screens to conform with the IRS guidelines. Produce and review the 1099 Proof Report 
to make sure that the “Name Control” for each vendor is correct.
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USING NOTES FOR 1099 AND MINORITY VENDORS

You can use the Note fields to record special information about 1099 and minority 
vendors:

1.  Enter the tax identification number in the same Note field for each vendor that 
requires a 1099 tax form (that is, a vendor who is a non-corporate 
subcontractor). For example, your organization may decide to use the Note 1 
field, in which case you must always enter this information in the Note 1 field.

2. Leave the Note field blank for vendors who do not receive a 1099.

3. When you produce your 1099s, you can filter your vendors based on whether 
there is a value in this field. Additionally, you can specify that the system pull 
the tax ID number from the field. 

When you enter the tax identification number, enter only the number, not text 
stating “TIN” or “SSN.” Entering only numbers for each vendor will make 
sorting by this field easier and more accurate.

Similarly, if you must report purchases from minority vendors, use another Note field to 
classify the vendors. As with 1099 information, enter that information in the same note 
field for each vendor.

You can also use a combination of two vendor data items for this purpose. See 
Using Vendor Data Items to Identify 1099 Vendors on page 2.57 for more 
information.
Using the Vendor Record to Produce 1099 Forms 
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USING VENDOR DATA ITEMS TO IDENTIFY 1099 VENDORS

You can use a pair of vendor data items to identify 1099 vendors and their tax ID 
number (Figure 2.16). The first data item identifies if the vendor must receive a 1099 
form (Y/N setting) and is used during the 1099 extract process. The second data item 
identifies the vendor’s tax ID number. 

Figure 2.16—Example Data Items Identifying 1099 Information

You can also use the Note 1 field for this purpose. See Using Notes for 1099 
and Minority Vendors on page 2.56 for more information.

IMPORTING VENDOR INFORMATION
All instructions for importing vendor data are included in the Blackbaud FundWare 
System Administration Guide. Please refer to this guide for more information. You can 
find all user guides in the FundWare > Data > User Documentation folder on your 
server.
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C H A P T E R  3

ENTERING OBLIGATIONS

AP obligations fall into one of three categories, depending on the needs of your 
organization:

• Commitment—Defined as the Commit stage in field 1 of the PO Extended 
Setup parameter.

• Encumbrance—Defined as the Encumber stage in field 1 of the PO Extended 
Setup parameter.

• Expense—Defined as a range of stages in field 2 of the Extended Setup 
parameter.

These categories are represented as stages in the AP setup. In most cases, these stages 
will display on the AP tree as subfolders to the Obligations folder. (For more 
information, see When Do Stages Appear on the Folder Tree? on page 1.67.)
Figure 3.1 shows the commitment, encumbrance, and invoice stages defined for 
Divisions 95 and 96. Note that we have defined two invoice stages for Division 96. 

Figure 3.1—Commitment, Encumbrance, and Invoice Stages for Division 95 and 96

Commitment stage

Encumbrance stage

Invoice stages
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TASKS BY STAGE
The tasks available to you within each subfolder (assuming your basic security settings 
allow), either from a button or from the shortcut menu, will vary depending on the stage 
definition (Table 3.1). 

Table 3.1—Tasks Available for Obligation Folders

Task Description

New Create a new obligation. 
• Available if the Allow Enter setting in field 6 of the stage definition is “Y.”
• When you save your entries, FundWare stores the obligation in a temporary subfolder 

for the stage called New. This allows you to review the obligation before posting to the 
stage folder (e.g., Purchase Order).

Edit Edit an existing obligation.
• Available if the Allow Modify setting in field 6 of the stage definition is “Y.”
• When you save your changes, FundWare stores the obligation in a temporary 

subfolder for the stage called Edited. This allows you to review the obligation before 
posting to the stage folder (e.g., Purchase Order).

Void Remove an obligation.
• Available if the Allow Cancel setting in field 6 of the stage definition is “Y.”
• When you void an obligation, FundWare stores the file in a temporary subfolder for 

the stage called Voided. This allows you to ensure that the obligation should be 
removed before posting. (In this case, posting will complete the void process.)

Note: After you have voided an obligation, you can only view the obligation through the 
Invoice History report or AP Inquiry. Voided obligations are also listed on the Activity 
Detail tab of the vendor record.

Transfer Transfer an obligation to another stage.
• Available if the Allow Transfer setting in field 6 of the stage definition is “Y.”
• When you transfer an obligation, FundWare stores the file in a temporary subfolder for 

the stage called Transferred from [original stage] (e.g., Transferred from 
Requisition). This allows you to review the obligation before posting to the stage 
folder (e.g., Purchase Order).

Note: You can also use the mouse to “drag-and-drop” obligations to another stage.
Tasks by Stage 



Chapter 3—Entering Obligations
Some buttons are disabled until you select an obligation. If the button is always 
disabled, your security level may not allow access to that option. For more information 
on security settings, see the Blackbaud FundWare System Administration Guide.

TASKS WITHIN TEMPORARY SUBFOLDERS

As you work with your obligations, FundWare will stores them in temporary subfolders 
where they are only visible to you. For example, when you save a new obligation at the 
Invoice stage, the invoice is saved to the Invoice > New subfolder where only you can 
access it. There is no impact to General Ledger until you post the invoice out of the New 
subfolder (assuming that this stage is designed to post to GL). 

Split Split an obligation into two parts. One part stays at the original stage, the second part 
can stay at the original stage or move to another stage.
• Available if the Allow Split setting in field 6 of the stage definition is “Y.”
• When you split an obligation, FundWare stores the new obligation in a temporary 

subfolder for the stage called Split from [original stage] (e.g., Split from 
Requisition). This allows you to review the obligation before posting to the stage 
folder (e.g., Purchase Order).

• Until you post the new obligation from the temporary subfolder, FundWare considers 
the original obligation to be in effect. 
— Conceals the remainder of the original obligation to ensure that no one attempts 

to modify the obligation. When you post the new obligation from the Split from 
subfolder, the original obligation, reflecting the remainder of the balance, returns 
to the original stage folder.

Memorize Memorize the current obligation. 
• When you memorize an obligation, you must enter a 5-character name for the 

memorized obligation.
• The current obligation remains in the stage folder and a “template” of the obligation is 

saved to the Memorized Obligations folder.

Mark for Pay Mark an obligation for payment. It moves to the Marked for Pay\New Mark folder.
• Only available at the Ready for Pay stage, defined in field 3 of the Extended Setup 

parameter.
• When you mark an obligation for pay, FundWare stores the file in a temporary 

subfolder for the financial institution account called New Mark. This allows you to 
review the obligation before posting to the Marked for Pay folder (e.g., Purchase 
Order).

Table 3.1—Tasks Available for Obligation Folders (Continued)

Task Description
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When you post all the obligations out of the New subfolder to the Invoice folder, the 
New subfolder disappears until it is needed again. The following subfolders can display 
within a folder:

• New
• Edited
• Voided
• Transferred from [original stage]
• Split from [original stage]
• New Mark (displayed under the Marked for Pay folder of an financial institution 

account)
• Unmarked (displayed under the Ready for Pay stage folder)

Table 3.2 describes the tasks available, either from a button or from the shortcut menu, 
from the temporary subfolders (assuming your basic security settings allow). 

Table 3.2—Tasks Available for Temporary Subfolders

Task Description

New Create a new obligation. 
• Available if the Allow Enter setting in field 6 of the stage definition is “Y.”
• When you save your entries, FundWare stores the obligation in a temporary subfolder 

for the stage called New. This allows you to review the obligation before posting to the 
stage folder (e.g., Purchase Order) and potentially impacting your General Ledger.

Edit Edit an existing obligation.
• Available if the Allow Modify setting in field 6 of the stage definition is “Y.”
• When you save your changes, FundWare stores the obligation in a temporary subfolder 

for the stage called Edited. This allows you to review the obligation before posting to the 
stage folder (e.g., Purchase Order).

Post Move all obligations from the temporary subfolder to its parent main folder (e.g., from the 
Invoice > New subfolder to the Invoice folder).
• If the stage is defined to post to General Ledger, information is posted at this time.
Tasks by Stage 
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CUSTOMIZING OBLIGATION ENTRY FORMS
How your organization defined the Basic Setup parameter and each stage definition will 
determine certain information on the obligation entry form. See Customizing Your 
Obligation Forms on page 1.44 for more information.

CREATING NEW OBLIGATIONS
How you enter your obligations will depend on your definition of the PO Basic Setup 
parameter:

• Separate Entry—Obligation detail is entered on the Line Items tab, and 
accounting information is entered on the Distribution tab. 

• Combined Entry—Both accounting distribution and obligation detail are 
entered on the Detail Lines tab. 
For more information on separate versus combined entry, see Separate and 
Combined Entry on page 2.5. For more information on this setting, see 
Modifying the Purchase Order Basic Setup Parameter on page 1.61. 

Remove Remove the obligation from the temporary subfolder.
• If the obligation is new, FundWare removes it completely from the system.
• If the obligation is not new (i.e., it has been edited, transferred, split, or marked for pay), 

FundWare returns it to its original state and stage folder. For example:
— You have a $1,000 obligation at stage 20.
— You split the obligation, transferring $400 to stage 30. The remaining $600 

obligation is concealed as long as the $400 obligation is in the Transferred from 
subfolder.

— When you remove the new $400 obligation from the Transferred from subfolder, 
the original $1,000 obligation returns to the stage 20 folder.

Verify Review the obligation by account, obligation, or vendor. See Verifying Obligations on page 
2.103 for more information.
• While you can only see the obligations that you entered within a subfolder, all obligations 

within the subfolder are displayed when you click Verify (i.e., all obligations entered by 
all users). 

Table 3.2—Tasks Available for Temporary Subfolders (Continued)

Task Description
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Instructions for each entry type are presented in this chapter:
• Entering Obligations—Separate Entry on page 2.64
• Entering Obligations—Combined Entry on page 2.74

While this chapter presents separate instructions for each entry type (see Entering 
Obligations—Separate Entry on page 2.64 or Entering Obligations—Combined Entry 
on page 2.74), we can only offer general instructions for those fields that can be 
customized through your AP setup. Therefore, entry at the stages defined for your 
organization may be slightly different from the instructions provided in this chapter.

ENTERING OBLIGATIONS—SEPARATE ENTRY

Use the following steps to complete the obligation if you are configured for separate 
entry (refer to your PO Basic Setup parameter). 

Remember: The following instructions provide you with some general 
guidance. However, because your organization has configured AP to match 
your needs, certain fields can have customized labels or be disabled. 

1.  Click Open… on the module navigator (if the module is not expanded, click 
Accounts Payable first) or select Accounts Payable > Open… from the menu 
bar. AP folder tree displays.

2. Click the applicable stage folder. The folder contents display in the detail pane 
(Figure 3.2, which shows the PO Order folder, stage 20 in Division 95). 

Figure 3.2—Separate Entry—Creating New Obligations
Creating New Obligations 
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3. Click New. The specific Entry windows displays, open to the Header tab 
(Figure 3.3 shows an example New Purchase Order Entry window). 

Figure 3.3—Separate Entry—Header Tab

The title of the obligation entry window will reflect the stage name and 
number.
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4. Complete the required information according to Table 3.3. 

Table 3.3—Separate Entry, Header Tab

Option Definition

Vendor

Number or Name You must select either the vendor number or name from the drop-down list. When 
you move off the Number field, AP fills in the remaining Vendor information.
• You can use the Vendor Selector button ( ) to locate a vendor. See Using the 

Vendor Selector on page 2.84 for instructions.
• You can use the Vendor Maintenance button ( ) to add a new vendor. See 

Adding Vendors During Obligation Entry on page 2.85 for instructions.
• You can begin typing a vendor number. AP will pre-fill the field with the first 

matching number in the vendor list. AP will continue to look for a matching 
record as you type.

If this is a one-time vendor: Enter 0 and fill in the remaining fields:

• Name
• Street 1 and 2
• City

• S/T/P
• Postal Code
• Country

Description

Line 1–3 Enter the obligation description. Up to three lines may display, depending on the 
setting in field 2 of the Basic Setup parameter.
• Field 2 (Obligation desc) of the check format definition allows you to print Line 1 

on the check stub.
• Additional lines cannot be printed on the check stub.

Other

Total Amount Enter the total dollar amount for this obligation (up to 9 numeric characters).

“Authorized by” Enter up to 30 alphanumeric characters.
• “Authorized by” is the FundWare default used by many organizations. 
• The label for this field is defined in field 3 (History desc) of the stage definition.

Invoice Date Enter the invoice date or click the icon to select from the calendar.

“Stage” Date Enter the appropriate date for the stage (e.g., “Date Ordered,” “Due Date”) or click 
the icon to select from the calendar. 
• The label for this field is defined in field 4 (Date desc) of the stage definition.
Creating New Obligations 
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Payment

Separate check 
for this obligation

Select this check box to indicate that one check will be written for this obligation 
only. (Your entry on the obligation will not change the setting on the vendor record.) 
For example:
• If the ACME Soap vendor record indicates “Combined,” by default there will be 

no check mark in this check box. If you select this check box, AP will create a 
check for this one obligation, regardless of other obligations for ACME Soap in 
the check run. 
— You could have one check for a single obligation and one check for three 

other obligations.
• If the Smith Paper Company vendor record indicates “Separate,” by default there 

will be a check mark in this check box. If you deselect this check box (i.e., 
remove the check mark), AP will create one combined check for this and any 
other obligations in the check run that:
— Belong to the Smith Paper Company, and
— Have the check box deselected.

If you have not added the .VPAYMENT data item to the vendor record (Vendor 
Data Items Tab on page 2.45), the check box will be deselected (i.e., checks will 
be combined). You can change this setting by selecting the check box.
Note: This option is disabled for one-time vendors.

Discount

Type If you are entering or modifying discount information, select from the drop-down 
menu (No Discounts, Percent of Total, or Flat Amount).
• If you select Percent of Total or Flat Amount, additional fields will display.
• If you are entering an obligation at an invoice stage and you have defined 

discount information on the vendor record, default information displayed when 
you selected the vendor.

For more information on discounts, see Applying Vendor Discounts to Obligations 
on page 2.87.

Percent Enter the percentage of the vendor discount.
• Displayed if you select Percent of Total from the Type drop-down menu. 

Flat Amount Enter the dollar amount of the vendor discount.
• Displayed if you select Flat Amount from the Type drop-down menu. 

Table 3.3—Separate Entry, Header Tab (Continued)

Option Definition
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If you are an existing customer upgrading from a version prior to 7.20, 
you must add the .VPAYMENT data item to your Accounts Payable 
parameter. See Modifying the AP Parameter—For Upgrading 
Customers Only on page 2.96 for instructions.

5. Continue to the next section for instructions on the Data Items tab. 

DATA ITEMS TAB

Use the following steps to complete the Data Items tab.

Use Discount 
Date

If the discount has an expiration date (e.g., it is only offered for 10 days), select the 
check box and enter the last day that the discount is offered.
• When you mark the obligation for pay, FundWare compares the business date to 

the discount date. If the Mark for Pay date is later, the discount is not applied to 
the obligation.
— Note: When FundWare calculates the discount date, the system is looking 

at the date the invoice was marked for payment, not the date that you cut 
the check.

• Displayed if you select Percent of Total and Flat Amount from the Type drop-
down menu. 

• If you have defined a default number of days for the vendor, FundWare 
calculates the Discount Date.

Table 3.3—Separate Entry, Header Tab (Continued)

Option Definition
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1.  Select the Data Items tab (Figure 3.4). 

Figure 3.4—Separate Entry—Data Items Tab

2. Enter values for any applicable data items, including required data items. (If a 
data item is required, “Yes” is displayed in the Required column.)

Your organization can specify different Editable or Display Only Data 
Items for each stage. See Adding Stage Definitions on page 1.75 for 
instructions.

3. Continue to the next section for instructions on the Line Items tab. 

LINE ITEMS TAB

Use the following steps to complete the Line Items tab (most frequently completed at 
the purchase order stage).

While you can add as many line item entries as necessary, the total amount on 
the tab should equal the total on the Header and Distribution tabs before you 
can complete the obligation entry process. However, if there is a difference, 
FundWare will offer to create a miscellaneous line for the missing amount 
automatically.
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1.  Select the Line Items tab (Figure 3.5). 

Figure 3.5—Separate Entry—Line Items Tab

2. Click New. The Detail Entry window displays (Figure 3.6). 

Figure 3.6—Separate Entry—Line Items Detail Entry
Creating New Obligations 
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3. Complete the required information according to Table 3.4.

4. Continue to the next section for instructions on the Distribution tab. 

DISTRIBUTION TAB

Use the following steps to complete the Distribution tab.
While you can add as many distribution entries as necessary, the total amount 
on the tab must equal the total on the Header tab before you can complete the 
obligation entry process. These totals should also equal the total amount entered 
on the Line Items tab. However, if there is a difference, FundWare will offer to 
create a miscellaneous line for the missing amount automatically.

Table 3.4—Separate Entry—Detail Entry Screen

Field Description

Line Detail lines are assigned a number by Accounts Payable. Until you click OK, 
FundWare will display “New” in this field.

Description Enter a description of the line item (up to 55 alphanumeric characters).

Stock nbr Enter the item stock number (up to 15 alphanumeric characters).

Quantity Enter the number of items purchased (up to 11 numeric characters).
• If you do not enter a decimal, a whole number is assumed. 
• If you enter a decimal point, you can enter up to 6 places after the point.

Unit Desc. Enter a description of the unit (e.g., box, ream) (up to 5 alphanumeric characters).
• FundWare does not use this information in any calculations. 

Unit Price Enter the price per unit (up to 15 numeric characters).
• If you do not enter a decimal, a whole number is assumed. 
• If you enter a decimal point, you can enter up to 6 places after the point.

Amount FundWare calculates the dollar amount based on the Quantity and Unit Price. 
• If you modify this entry, FundWare assumes that the Quantity, Unit Description, 

and Unit Price no longer apply and remove any entries in this field.
• This field must be populated with a dollar amount, either calculated by FundWare 

or entered by the user (up to 9 numeric characters).
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1.  Select the Distribution tab to assign amounts to one or more accounts (Figure 
3.7). 

Figure 3.7—Separate Entry—Distribution Tab

2. Click New if this obligation does not use a distribution table. The Distribution 
Entry window displays (Figure 3.8). 

Figure 3.8—New Distribution Entry
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If you are applying a distribution table to this obligation, you will click 
Auto. See Using a Distribution Table on page 2.100 for more 
information.

3. In the Account Number(s) field, enter the account number or select a number 
from the drop-down menu, which stores account numbers that you have entered 
recently. The description displays in the disabled Account Description field.

You can access the Account Selector or Account Maintenance by 
clicking the icons to the right of the text box. See Selecting an Account 
Through the Account Selector on page 2.97 or Adding a New Account 
Through Account Maintenance on page 2.98.

4. Enter a description of the distribution (up to 30 alphanumeric characters).

5. Enter the amount to be distributed to this account (up to 9 numeric characters).

6. When you have entered all the necessary obligation information:

• Click OK to save the obligation and close the window. The obligation is 
saved to the applicable New subfolder (e.g., Purchase Orders > New). 

• Click New to save the obligation and continue entering additional 
obligations (i.e., creating a batch or group of obligations). Your obligation 
information is saved and the form is cleared.
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When you have completed and saved your entries, the obligation is stored in the New 
subfolder for the stage or the Memorized Obligations folder. (Figure 3.9 shows an 
example invoice in the Purchase Orders > New subfolder.) 

Figure 3.9—Purchase Orders > New Subfolder

To move the obligation into the main folder (e.g., Purchase Orders), click Post.

ENTERING OBLIGATIONS—COMBINED ENTRY

Use the following steps to complete the obligation if you are setup for combined entry.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Accounts Payable first) or select Accounts Payable > Open… from the menu 
bar. AP folder tree displays.
Creating New Obligations 
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2. Click one of the obligation folders. The folder contents display in the detail 
pane (Figure 3.10). Buttons for the selected folder display at the bottom of the 
window. 

Figure 3.10—Creating New Obligations
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3. Click New. The entry window displays (Figure 3.11 shows an example New 
Invoice Entry window). 

Figure 3.11—Combined Entry—Header Tab
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4. Complete the required information according to Table 3.5. 

Table 3.5—Combined Entry, Header Tab

Option Definition

Vendor

Number or Name You must select either the vendor number or name from the drop-down list. When 
you move off the Number field, AP fills in the remaining Vendor information.
• You can use the Vendor Selector button ( ) to locate a vendor. See Using the 

Vendor Selector on page 2.84 for instructions.
• You can use the Vendor Maintenance button ( ) to add a new vendor. See 

Adding Vendors During Obligation Entry on page 2.85 for instructions.
• You can begin type typing a vendor number. AP will pre-fill the field with the first 

matching number in the vendor list. AP will continue to look for a matching 
record as you type.

If this is a one-time vendor: Enter 0 and fill in the remaining fields:

• Name
• Street 1 and 2
• City

• S/T/P
• Postal Code
• Country

Description

Line 1–3 Enter the obligation description. Up to three lines may display, depending on the 
setting in field 2 of the Basic Setup parameter.
• Field 2 (Obligation desc) of the check format definition allows you to print Line 1 

the check stub.
• Additional lines cannot be printed on the check stub.

Other

Total Amount Enter the total dollar amount for this obligation (up to 9 numeric characters).

“Authorized by” Enter up to 30 alphanumeric characters.
• “Authorized by” is the FundWare default used by many organizations. 
• The label for this field is defined in field 3 (History desc) of the stage definition.

Invoice Date Enter the invoice date or click the icon to select from the calendar.

“Stage” Date Enter the appropriate date for the stage (e.g., “Date Ordered,” “Due Date”) or click 
the icon to select from the calendar. 
• The label for this field is defined in field 4 (Date desc) of the stage definition.
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Payment

Separate check 
for this obligation

Select this check box to indicate that one check will be written for this obligation 
only. (Your entry on the obligation will not change the setting on the vendor record.) 
For example:
• If the ACME Soap vendor record indicates “Combined,” by default there will be 

no check mark in this check box. If you select this check box, AP will create a 
check for this one obligation, regardless of other obligations for ACME Soap in 
the check run. 
— You could have one check for a single obligation and one check for three 

other obligations.
• If the Smith Paper Company vendor record indicates “Separate,” by default there 

will be a check mark in this check box. If you deselect this check box (i.e., 
remove the check mark), AP will create one combined check for this and any 
other obligations in the check run that:
— Belong to the Smith Paper Company, and
— Have the check box deselected.

If you have not added the .VPAYMENT data item to the vendor record (Vendor 
Data Items Tab on page 2.45), the check box will be deselected (i.e., checks will 
be combined). You can change this setting by selecting the check box.
Note: This option is disabled for one-time vendors.

Discount

Type If you are entering or modifying discount information, select from the drop-down 
menu (No Discounts, Percent of Total, or Flat Amount).
• If you select Percent of Total or Flat Amount, additional fields will display.
• If you are entering an obligation at an invoice stage and you have defined 

discount information on the vendor record, default information displayed when 
you selected the vendor.

For more information on discounts, see Applying Vendor Discounts to Obligations 
on page 2.87.

Percent Enter the percentage of the vendor discount.
• Displayed if you select Percent of Total from the Type drop-down menu. 

Flat Amount Enter the dollar amount of the vendor discount.
• Displayed if you select Flat Amount from the Type drop-down menu. 

Table 3.5—Combined Entry, Header Tab (Continued)

Option Definition
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5. Continue to the next section for instructions on the Data Items tab. 

DATA ITEMS TAB

Use the following instructions to complete the Data Items tab.
1.  Select the Data Items tab (Figure 3.12). 

Figure 3.12—Combined Entry—Data Items Tab

2. Enter values for any applicable data items, including required data items. (If a 
data item is required, “Yes” is displayed in the Required column.)

Use Discount 
Date

If the discount has an expiration date (e.g., it is only offered for 10 days), select the 
check box and enter the last day that the discount is offered.
• When you mark the obligation for pay, FundWare compares the business date to 

the discount date. If the Mark for Pay date is later, the discount is not applied to 
the obligation.
— Note: FundWare is looking at the Mark for Pay date, not the check date.

• Displayed if you select Percent of Total and Flat Amount from the Type drop-
down menu. 

• If you have defined a default number of days for the vendor, FundWare 
calculates the Discount Date.

Table 3.5—Combined Entry, Header Tab (Continued)

Option Definition
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Your organization can specify different Editable or Display Only Data 
Items for each stage. See Adding Stage Definitions on page 1.75 for 
instructions.

3. Continue to the next section for instructions on the Detail Lines tab. 

DETAIL LINES TAB

Use the following instructions to complete the Detail Lines tab.
 While you can add as many detail lines as necessary, the total amount on the 
tab must equal the total on the Header tab before you can complete the 
obligation entry process. 

1.  Select the Distribution tab to assign amounts to one or more accounts (Figure 
3.13). 

Figure 3.13—Combined Entry—Data Items Tab
Creating New Obligations 
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2. Click New if this obligation does not use a distribution table. The Distribution 
Entry window displays (Figure 3.14). 

Figure 3.14—New Distribution Entry

If you are applying a distribution table to this obligation, you will click 
Auto. See Using a Distribution Table on page 2.100 for more 
information.

3. In the Account Number(s) field, enter the account number or select a number 
from the drop-down menu, which stores account numbers that you have entered 
recently. The description displays in the disabled Account Description field.

You can access the Account Selector or Account Maintenance by 
clicking the icons to the right of the text box. See Selecting an Account 
Through the Account Selector on page 2.97 or Adding a New Account 
Through Account Maintenance on page 2.98.

4. Complete the required information according to Table 3.6. 

Table 3.6—Combined Entry, Detail Lines Tab

Field Description

Description Enter a description of the line item (up to 30 alphanumeric characters).
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5. Click Apply to add another line, or click OK if you are finished.

6. When you have entered all the necessary obligation information:

• Click OK to save the obligation and close the window. The obligation is 
saved to the applicable New subfolder (e.g., Purchase Orders > New). 

• Click New to save the obligation and continue entering additional 
obligations (i.e., creating a batch or group of obligations). Your obligation 
information is saved and the form is cleared.

Stock nbr Enter the item stock number (up to 15 alphanumeric characters).

Quantity Enter the number of items purchased (up to 11 numeric characters).
• If you do not enter a decimal, a whole number is assumed. 
• If you enter a decimal point, you can enter up to 6 places after the point.

Unit Desc. Enter a description of the unit (e.g., box, ream) (up to 5 alphanumeric characters).
• FundWare does not use this information in any calculations. 

Unit Price Enter the price per unit (up to 15 numeric characters).
• If you do not enter a decimal, a whole number is assumed. 
• If you enter a decimal point, you can enter up to 6 places after the point.

Amount FundWare calculates the dollar amount based on the Quantity and Unit Price. 
• If you modify this entry, FundWare assumes that the Quantity, Unit Description, 

and Unit Price no longer apply and remove any entries in this field.
• This field must be populated with a dollar amount, either calculated by FundWare 

or entered by the user (up to 9 numeric characters).

Table 3.6—Combined Entry, Detail Lines Tab (Continued)

Field Description
Creating New Obligations 
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When you have completed and saved your entries, the obligation is stored in the New 
subfolder. (Figure 3.15 shows an example invoice in the Invoice > New folder.) 

Figure 3.15—Invoice > New Subfolder

To move the obligation into the main folder (e.g., Invoice), click Post.

OBLIGATION ENTRY TOOLS
There are a number of tools available to help you enter your obligations:

• The Vendor Selector can assist you to find a vendor.
• Vendor Maintenance allows you to add a vendor while you are entering an 

obligation.
• When you do not want to enter a record for a vendor, you can use the One-Time 

Vendor to enter the obligation.
• The .VPAYMENT vendor data item allows you to determine if the vendor will 

receive one check or multiple checks for multiple obligations.
• You can apply discounts to the obligation or vendor record.
• The Account Selector can assist you to find an account.
Blackbaud, Inc. 2.83



Blackbaud FundWare Accounts Payable Guide—Volume 2

2.84
• Account Maintenance allows you to add a new account while you are entering 
an obligation.

USING THE VENDOR SELECTOR

When you are entering obligations, you can use the Vendor Selector to find a vendor 
record by the vendor number or sortkey.

1.  Click the vendor selector button on the obligation ( ). The Vendor Selector 
displays (Figure 3.16). 

Figure 3.16—Vendor Selector

2. Select Vendor Number or Sortkey from the Sort By drop-down menu.

3. Enter the first value that FundWare should display in the Scroll Vendors Starting 
With text box.
Obligation Entry Tools 
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4. Click Search Now. The search results display (Figure 3.17). 

Figure 3.17—Vendor Selector—Results

5. Select a vendor and click OK. The vendor information is entered on the 
obligation.

ADDING VENDORS DURING OBLIGATION ENTRY

When you are adding obligations, you can also create a new vendor record. This is 
particularly useful if you are adding obligations in a batch and do not want to exit the 
obligation entry form.
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1.  Click . The Vendors Maintenance window displays (Figure 3.18). 

Figure 3.18—Vendors Maintenance Window

2. Click New. The New Vendor Entry window displays, open to the Vendor tab 
(see Figure 2.2—New Vendor Entry, Vendor Tab on 2.40).

3. Enter the vendor information. See Adding Vendor Records on page 2.39 for 
specific instructions.

4. When complete, click OK to save the vendor record and return to the Vendors 
Maintenance window.

5. Click Close to return to the obligation entry form.

USING THE ONE-TIME VENDOR FEATURE

You might need to create an obligation for a vendor with whom you do not do business 
regularly. You may not want to add a record for this vendor, so you can use the “one-
time vendor” record provided by FundWare instead.

You cannot extract 1099 information from a one-time vendor transaction. 
Therefore, if you must produce a 1099 for the vendor, you cannot use the one-
time vendor feature.
Obligation Entry Tools 
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To use this feature, select the One-Time Vendor record from the Vendor Number or 
Vendor Name drop-down menu. FundWare enables the address fields, where you will 
enter the one-time vendor’s name (required) and address (optional) information.
Continue with the obligation entry as you usually would.

APPLYING VENDOR DISCOUNTS TO OBLIGATIONS

There are two main ways in which you can apply vendor discounts to an obligation:
• A consistent discount offered by the vendor, stored on the vendor record.
• A one-time discount, applied directly to the obligation.

When you are entering an obligation at a stage defined for discounts (i.e., the field 7 
Discount info setting of the stage definition is Y—Field is accessible), FundWare 
displays the Type field (Figure 3.19). 

Figure 3.19—Discount Type Field
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When you select a vendor with the Discount given by Vendor feature enabled, 
FundWare enters default discount information on the obligation (Figure 3.20). The date 
that FundWare displays in the Date field is calculated using the current business date 
and the Days defined on the vendor record. 

Figure 3.20—Default Vendor Discount Information on Obligation

You can modify any of the discount information. If you remove the check mark from the 
Use Discount Date check box (i.e., click the check box), the Date field is disabled and 
FundWare does not apply an expiration date for the discount.
Obligation Entry Tools 
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If you select a vendor that does not have the Discount given by Vendor feature enabled, 
you can still select a discount option from the Type drop-down menu (Figure 3.21). 
FundWare applies your entries to the current obligation only. 

Figure 3.21—Vendor Discount Information Added to Obligation

You can enter the discount amount or percent, as well as specify if the discount applies 
for a certain period of time only.

THE “TAKE DISCOUNT” OVERRIDE

In the normal course of the AP process:
• You enter an obligation, including any discount information (e.g., Flat Amount, 

Discount Date).
• You mark the obligation for pay.
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• If the business date on which you mark the obligation for pay was after the 
Discount Date, FundWare nullifies the discount and you pay the full amount 
(i.e., the discount has expired).

However, if you use the “Take Discount” feature you can override any Discount Date at 
two points in the process: 

• When you mark an obligation for pay, and 
• When an obligation is in the New Mark folder for a bank (i.e., it has been 

marked for pay but not posted to the bank’s Mark for Payment folder).
The following steps explain the configuration and process for the “Take Discount” 
feature.

1.  Confirm which stage you have defined as Ready for Pay in field 3 of the 
Extended Setup parameter (Setup > Extended Setup) (Figure 3.22). (This is 
the stage at which you mark an obligation for pay.) 

Figure 3.22—Ready for Pay Stage for Division 95

In Division 95, this is the Invoice stage (30). In Division 96, this is the 
Approved for Payment stage (40).
Obligation Entry Tools 



Chapter 3—Entering Obligations
2. Define the Ready for Pay stage to allow you to edit obligations (Figure 3.23). 
This is specified in field 6 of the stage definition (Setup > Master Records > 
Stages, Allow Modify field). 

Figure 3.23—Stage Definition—Allow Modify

3. Define the Ready for Pay stage to allow the Take Discount feature (Figure 
3.23). This is specified in field 7 of the stage definition (Setup > Master 
Records > Stages, Take Discount field). 

Figure 3.24—Stage Definition—Take Discount Feature
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4. Mark the obligation for pay. The Mark for Pay—Group window displays, 
including the “Take Discount” check box (Figure 3.25). 

Figure 3.25—Mark for Pay—Take Discount Regardless of Date Option

5. Select the Take discount regardless of date check box to apply the discount. If 
necessary, you also can modify the Discount Date (i.e., Last date to take 
discount) at this time.

For this example process, we will not apply the “Take Discount” setting 
at this step.

6. Click OK to mark the obligation for pay.
Obligation Entry Tools 
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7. The obligation is saved to the New Mark folder for the bank after you have 
marked the obligation for pay but not posted it to the bank’s Mark for Payment 
folder (Figure 3.26). 

Figure 3.26—New Mark Folder

8. Open the obligation (e.g., double-click, select and click Edit). The Take 
discount regardless of date check box is displayed in the Discount area of the 
invoice (Figure 3.27). 

Figure 3.27—Take Discount Regardless of Date
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9. Select the Take discount regardless of date check box to apply the discount. If 
necessary, you also can modify any of the discount information at this time.

10. Click Apply to save the information or OK to save the information and exit the 
window. When viewed in the detail pane, the invoice amount reflects the 
application of the discount (Figure 3.28). 

Figure 3.28—Discount Applied to Invoice

USING THE COMBINED OR SEPARATE CHECK FUNCTION

The .VPAYMENT vendor data item applied to the vendor record indicates, by default, 
to Accounts Payable how you would like to handle multiple obligations to the same 
vendor within a check run. (See Vendor Data Items Tab on page 2.45 for instructions to 
apply the .VPAYMENT data item to a vendor record.)
Obligation Entry Tools 
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When you select a vendor during obligation entry, the .VPAYMENT setting from the 
vendor record is entered on the obligation entry form (Figure 3.29). However, you can 
override this setting at any time. 

Figure 3.29—.VPAYMENT Default From Vendor Record

If one vendor has three obligations in a check run, and if the .VPAYMENT data 
item value is Separate for the vendor, AP will create three checks for the vendor 
(one for each obligation). (This assumes that you don’t change the default 
payment setting for the vendor on each obligation.)

If you are an existing customer upgrading from a version prior to 7.20, you must 
add the .VPAYMENT data item to your Accounts Payable parameter. See 
Modifying the AP Parameter—For Upgrading Customers Only on page 2.96 for 
instructions.

To override this setting for the obligation, select the Payment check box to remove or 
add a check mark. For example:

• If the ACME Soap vendor record indicates “Combined,” by default there will 
be no check mark in this check box. If you select this check box, AP will create 
a check for this one obligation, regardless of other obligations for the ACME 
Soap in the check run. 
— You could have one check for a single obligation and one check for three 

other obligations.
• If the Smith Paper Company vendor record indicates “Separate,” by default 

there will be a check mark in this check box. If you deselect this check box (i.e., 
remove the check mark), AP will create one combined check for this and any 
other obligations in the check run that:

In this example, 
the vendor gets 
separate checks 
for each obligation, 
by default. (In 
other words, the 
.VPAYMENT value 
is for separate 
checks.)
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— Belong to the Smith Paper Company, and
— Have the check box deselected.

Your entry on the obligation will not change the setting on the vendor 
record.

By default, the check box will not be selected (i.e., checks will be combined) if:
• You are an existing Accounts Payable customer upgrading from a version 

earlier than 7.20, and 
• You have not added the .VPAYMENT data item to the vendor record (see 

Modifying the AP Parameter—For Upgrading Customers Only on page 2.96).
You can change this setting by selecting the check box on the obligation or changing the 
vendor record.

ONE-TIME VENDORS AND SEPARATE CHECKS

AP will not allow you to combine checks for a one-time vendor. Therefore, the Separate 
checks for this obligation check box will be disabled when you select Vendor Number 0 
or the one-time vendors record on the obligation entry form. If you have multiple 
obligations for the same one-time vendor in a single check run, AP will create separate 
checks for each obligation.

PAYMENT SETTING AND PARTIAL TRANSFERS

Each obligation can have only one payment setting (i.e., either combined or separate), 
even if you transfer part the obligation to another stage (because each portion is still part 
of the same obligation). If you change the setting in one stage, FundWare will then 
change the payment setting for both stages.

MODIFYING THE AP PARAMETER—FOR UPGRADING CUSTOMERS ONLY

If you are an existing Accounts Payable customer upgrading from a version of 
FundWare earlier than 7.20, you must modify your AP parameter for each division 
before you can use the .VPAYMENT vendor data item.

Remember—You must complete this task for all your divisions. If you use the 
sample divisions, you should modify the parameter for those divisions as well.

1.  Click Setup > Basic Setup on the module navigator (if the module is not 
expanded, click Accounts Payable first) or select Accounts Payable > Setup > 
Basic Setup from the menu bar. The task option menu displays.
Obligation Entry Tools 
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2. Type C to change the parameter. You do not need to actively change any 
information within the parameter. 

3. Type 0 to accept the changes. The new data item will be added as the parameter 
is saved. (A message concerning this will appear briefly at the top of window.)

4. Type E to save the parameter and close the window.

SELECTING AN ACCOUNT THROUGH THE ACCOUNT SELECTOR

The Account Selector (Figure 3.30) is available from many locations in AP, including 
the obligation entry form. This feature allows you to locate an account using filters:

• ID types
• Status
• Account mask—No entry or an entry of X takes the place of account numbers, 

allowing a range of accounts to be filtered.
• Description—The account description.
• Aliases 1 and 2—Alternate account descriptions.
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• Attributes—Attributes assigned to the account, e.g., EX for expense accounts. 

Figure 3.30—Account Selector

Use the following steps to filter accounts with the Account Selector.
1.  Select the criteria by which to filter the account.

2. Click Search.

3. The accounts fitting the search criteria display. 

4. Select the account that you want. 

5. Click OK. The selected account number displays in the text box. 

ADDING A NEW ACCOUNT THROUGH ACCOUNT MAINTENANCE

When you are entering obligations, you can use the Account Maintenance window add a 
new account number. 
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1.  Click the Account Maintenance button ( ). The Account Maintenance 
window displays (Figure 3.31). 

Figure 3.31—Account Maintenance Window

2. Enter the ID type and account number.

3. Enter the account description.

4. On the General tab, select a status.

5. Select an attribute in the first row.

6. Enter any additional information you want for this account.

7. Click OK. 

8. Click Apply to add another account. If you are done, click OK.
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USING A DISTRIBUTION TABLE

Distribution tables allow you to apply the obligation charges across a predetermined set 
of accounts. You access your distribution tables from the Distribution tab (separate 
entry) or the Detail Lines tab (combined entry). (See Working With Distribution Tables 
on page 1.113 for more information.)

1.  Click Auto. The Auto Distribution window displays (Figure 3.32). 

Figure 3.32—Auto Distribution Window

2. Select a distribution table from the drop-down list.

3. Enter the resolution account mask. (The resolution account is used with the 
distribution account mask to complete the account number.) 

Enter zero (0) in the positions of the account where the distribution 
account has specific numbers (i.e., 0–9, not masked characters). For 
example: 

4. Click OK. The obligation amount is distributed as defined by the distribution 
table.

The distribution table is defined as: 70%—A01 01-01 XXXX

30%—A02 01-01 XXXX

In the Account Mask field of the Auto 
Distribution window, you enter: A00 00-00 7130

The obligation total of $1,000 is 
distributed as:

$700—A01 01-01 7130

$300—A02 01-01 7130
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USING CREDIT MEMOS
You can enter an obligation as a “credit memo” by entering the credit amount as a 
negative number. The next time you write checks for obligations to ABC Hardware, you 
can include this credit and decrease the total check amount (i.e., decrease the amount 
paid to ABC Hardware). For example, 

• You return an item to ABC Hardware.
• ABC Hardware gives you a $45.00 credit.
• You enter an obligation to ABC Hardware for –$45.00.
• You enter two obligations to ABC Hardware, totalling $150.00.
• When you process checks, include all three obligations.
• The check to ABC Hardware is $105.00.

When applying credit memos, you need to following these rules:
• You cannot apply only part of a credit memo. Therefore, the obligations for the 

vendor must total more than the amount of the credit memo when you write 
your checks.

• Both the credit memo and the obligation to which it is applied are defined for 
combined checks (i.e., there is no check mark in the Separate check for this 
obligation box) (Figure 3.33). 

Figure 3.33—Example Header Tab Defined for Combined Checks
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BUDGET CONTROL
When your organization uses the Budget Control feature, FundWare monitors your 
Accounts Payable and General Ledger transactions to ensure that you remain within a 
specified budget for your accounts. You can define the Budget Control feature so that 
FundWare notifies the user when a transaction approaches or exceeds an account’s 
budgeted amount.

If your organization is using the Budget Control feature, you can get three different 
types of messages (Figure 3.34):

• Message—Informs you when you are nearing the amount defined by the Budget 
Control message level.

• Warning—Informs you when you are nearing the amount defined by the Budget 
Control warning level.

• Error—Informs you when you are at or above the amount defined by the Budget 
Control error level.

Figure 3.34—Budget Control Messages

You may complete the transaction if you get a Budget Control message or warning. 
However, if you get an error FundWare will not allow you to post the obligation. 
Consult the procedures defined by your organization to determine how you will handle 
Budget Control notices.
For more instructions to define Budget Control, see the Blackbaud FundWare General 
Ledger–Project/Grant Guide. 
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VERIFYING OBLIGATIONS
Not every situation that exceeds budget limits can be reported during entry. For 
example:

• Budget Control compares the obligation amount to the budget amount in the 
General Ledger. However, before you actually post the obligations that are in 
your New subfolder, another user posts to General Ledger. This new posting 
impacts the budget for the accounts in your obligation.

• You enter obligations on May 31 (May budget = $300), but do not post them 
until June 1 (June budget = $0).

You can identify situations like by looking at the Pre-Posting Verification window. To 
display the window, open the temporary subfolders and click Verify (Figure 3.35). The 
Verify tasks displays all obligations within that subfolder, including those entered by 
other users. For more information on the temporary subfolders, see Tasks Within 
Temporary Subfolders on page 2.61. 

Figure 3.35—Pre-Posting Verification

If you have defined an account with a budget of zero ($0.00), FundWare will 
display a “No Budget” message when you post an obligation to that account. 
However, you can still post the obligation. 

The Pre-Posting Verification window displays, open to the Account tab. There are three 
tabs available from the Pre-Posting Verification window: Account, Obligation, and 
Vendor.
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The following sections provide clarification on each of these tabs.

ACCOUNT TAB

When the Pre-Posting Verification window opens, it is open to the Account tab (Figure 
3.36). 

Figure 3.36—Pre-Posting Verification—Account Tab
Verifying Obligations 
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Click the plus sign (+) in the account column, to view the obligations that will post to 
that account (Figure 3.37). Any Budget Control messages are displayed in the 
exceptions column. Remember, the system will not let you post to any account that has 
an Error. 

Figure 3.37—Pre-Posting Verification—Account Tab Expanded

Click the minus sign (–) to close the expanded 
display and return to the summarized view.

Double-click the obligation line 
to view the obligation.
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You can double-click the obligation line (Figure 3.37) to view the obligation (Figure 
3.38). 

Figure 3.38—Obligation Opened From the Verify Screen
Verifying Obligations 
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Note: If the obligation has been modified, FundWare will only note the change 
in amount. For example, we posted a purchase order for $500 for Ace 
Hardware. The Verify—Account tab shows the $500 purchase order, to 
account A01 01-00 7910 (Figure 3.39). 

Figure 3.39—Pre-Posting Verification—Verify

We then posted the purchase order. Once posted, we edited the obligation by 
$100, making the total amount $600. The additional $100 we applied toward 
account A01 01-00 7130. When we view the Account tab we see the $100 
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because what you are verifying is the amount that will be posted to accounts. 
The $500 has already been posted, therefore, only the additional $100 displays 
(Figure 3.40). 

Figure 3.40—Verify—Account Tab Showing the Difference

From this tab you can:
• Sort the display by Exception (highest severity first) or by Account (as shown in 

Figure 3.41). To do so, click the applicable column heading. 

Figure 3.41—sorting the Pre-Posting Verification Entries

• Double-click an entry to display the obligation and modify your entries, as 
necessary.

Sorted by Account

Sorted by Exception
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• Click Print to produce a copy of the Verification window directly to the printer 
(i.e., this feature does not produce a file in your report directory). You can select 
the print orientation (i.e., Portrait or Landscape) using the applicable radio 
buttons.

• Click another tab for a different view. 
• Click Close to return to the main window.

OBLIGATION TAB

The Obligation tab on the Pre-Posting Verification window gives the obligation 
description and vendor name, distribution information, account number, and amount 
(Figure 3.42). 

Figure 3.42—Pre-Posting Verification—Obligation Tab

From this tab you can:
• Click Print to produce a copy of the Verification window directly to the printer 

(i.e., this feature does not produce a file in your report directory). You can select 
the print orientation (i.e., Portrait or Landscape) using the applicable radio 
buttons.
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• Click Close to return to the main window.

VENDOR TAB

The Vendor tab on the Pre-Posting Verification window allows you to view the 
obligations in the batch by vendor (Figure 3.43). 

Figure 3.43—Pre-Posting Verification—Vendor Tab

From this tab you can:
• Click Print to produce a copy of the Verification window directly to the printer 

(i.e., this feature does not produce a file in your report directory). You can select 
the print orientation (i.e., Portrait or Landscape) using the applicable radio 
buttons.

• Click Close to return to the main window.
Verifying Obligations 
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EDITING OBLIGATIONS
Use the following steps to edit an obligation.

1.  Open the applicable folder on the Navigation tree.

2. Select one or more obligations. (If you are in the New temporary subfolder, you 
can only select one obligation.) 

3. Click Edit. The obligation entry form displays. 

4. Edit the information, as necessary. If you selected multiple obligations, each 
obligation can be identified and accessed from the top of the window (Figure 
3.44). 

Figure 3.44—Next Obligation

5. Click Apply to save your changes and remain in the obligation entry form or 
OK to save your changes and close the form.

6. The obligation is stored in the Edited subfolder (e.g., Invoice > Edited) 
(Figure 3.45). 

Figure 3.45—Example Edited Subfolder

If the obligation was already in one of the temporary subfolders (e.g., 
Invoice > New), it remains in the folder.

Number of current 
obligation

Click to view the 
first obligation

Click to view the 
previous obligation

Click to view the 
next obligation

Click to view the 
last obligation
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7. Click Post to move it into the main folder (e.g., Invoice).

The stage date of the obligation does not change when you edit your 
entries. (The label for the stage date is defined by your organization in 
field 4 of the stage definition.)

VOIDING OBLIGATIONS
Use the following steps to void an obligation.

1.  Open the applicable folder on the Navigation tree.

2. Select one or more obligations. (Because you can also select the obligations to 
void in the Void Obligation Group window, you can skip this step.)

3. Click Void. The Void Obligation Group window displays. Selected obligations 
display (Figure 3.46). 

Figure 3.46—Selected Obligations in the Void Obligation Group Window

4. Complete the History note field, as necessary (up to 30 alphanumeric 
characters). FundWare enters this information in the History desc field on the 
obligation when you complete the transfer process. 
Voiding Obligations 
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The label for this field on the obligation is defined in field 3 (History 
desc) of the stage definition (e.g., Authorized by).

5. To change the default Stage Date, enter a new date or click the ellipsis to access 
the calendar function. (The Stage Date defaults to the current Business Date.)

You can enter 00/00/0000 as the Stage Date or leave the field blank to 
maintain the original obligation date.

6. To select or add obligations to the transfer task, click the ellipsis ( ). The 
Multiple Obligation Selector window displays (Figure 3.47). 

Figure 3.47—Multiple Obligation Selector

7. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
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8. Click Search Now. The search results display (Figure 3.48). 

Figure 3.48—Multiple Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

9. Select the obligations.

10. Click OK to close the Multiple Obligation Selector. The obligations are listed in 
the Obligation Nbr. field.
Voiding Obligations 
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11. Click Append to add the obligations to the list of obligations in the Obligations 
for Edit area (i.e., the list of obligations that will be transferred) (Figure 3.49). 

Figure 3.49—Obligation Added to the Void Obligation Group

You can remove an obligation by selecting the obligation and clicking 
the buttons in the lower right corner of the window. You must select a 
stage before you select an obligation (i.e., the obligations are not 
enabled until you select a stage).

12. Click OK. FundWare moves the obligation(s) to the Voided subfolder for the 
stage folder (e.g., Invoice > Edited) (Figure 3.50). 

Figure 3.50—Example Voided Subfolder
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13. Click Post to complete the void process. If you want to reverse the void status 
and return the obligation to the original stage folder, click Remove.

VIEWING VOIDED OBLIGATIONS

Voided obligations remain in the data files with a zero dollar amount and all data entry. 
This data can be seen on the Activity Detail tab of the vendor record and in the Invoice 
History report if you select the Print zero dollars option. No changes can be made to 
the obligation after it is voided and posted.
If you know the obligation number, you can also view a single voided obligation using 
AP Inquiry. 

1.  Click Inquiry on the module navigator (if the module is not expanded, click 
Accounts Payable first) or select Accounts Payable > Inquiry from the menu 
bar. 

2. Select Obligation from the Category drop-down list.

3. Enter any additional criteria, as needed (Figure 3.51). 

Figure 3.51—AP Inquiry—Obligations
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4. Click Run. The matching obligations (excluding voided obligations) display in 
the Inquiry - Obligation Pick List (Figure 3.52). 

Figure 3.52—Inquiry - Obligation Pick List

5. Enter the voided obligation number in the Obligation number text box.

6. Click Display. The obligation displays in the Obligation View. 
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7. Select the Revision History tab to view the obligation history (Figure 3.53). 

Figure 3.53—Obligation View
Voiding Obligations 
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MEMORIZING OBLIGATIONS
If you have recurring obligations (e.g., rent, a lease payment), you can create an 
obligation template. FundWare stores these templates in the Memorized Obligations 
folder (Figure 3.54). Once you have a memorized obligation to use as a template, you 
can create an active obligation at a later time without re-entering the data. 

Figure 3.54—Memorized Obligations Folder

A memorized obligation can begin as an existing obligation or be created directly in the 
Memorized Obligations folder.

MEMORIZING AN EXISTING OBLIGATION

Use the following steps to create a memorized obligation from an existing obligation in 
a purchase order or invoice folder (i.e., a stage defined as Purchase Order in the PO 
Extended Setup parameter or Invoice or Basic Extended Parameter).

1.  Select the obligation in stage folder. (This option is not available from any of 
the temporary subfolders.)
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2. Click Memorize. The Memorize Obligation window displays (Figure 3.55). 

Figure 3.55—Memorizing Obligations

3. At the prompt, enter a name for the obligation. It is saved in the Memorized 
Obligations folder.

ENTERING A MEMORIZED OBLIGATION

Use the following steps to create a memorized obligation directly in the Memorized 
Obligations folder.

1.  Open the Memorized Obligations folder.
Memorizing Obligations 
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2. Click New. The New Memorized Obligation window displays (Figure 3.56). 

Figure 3.56—New Memorized Obligation (Combined Entry)

3. Enter the information just as you would for any obligation.

4. Click OK.

CREATING A NEW OBLIGATION FROM A MEMORIZED OBLIGATION

Use the following steps to create a new obligation from a memorized obligation 
template.

1.  Open the Memorized Obligations folder.

2. Select the memorized obligation template that you want to use.
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3. Click Create. The system asks you to select a stage to which the new obligation 
will be saved (Figure 3.57). 

Figure 3.57—Stage Selector

4. Select the applicable stage. 

5. Click OK. The obligation is added to the New subfolder of the selected stage 
(e.g., Purchase Order > New). From there you can post it to the stage folder. 

TIPS FOR WORKING WITH MEMORIZED OBLIGATIONS

You can use the sorting options available in the detail pane to create a group of related 
obligations. For example:

• Display the Recur Frequency column (right click and select from the shortcut 
menu),

• Click the column heading to sort your memorized obligations by frequency,
• Select the appropriate obligations, and
• Click Create and select a stage to create all your monthly memorized 

obligations in one step.
Memorizing Obligations 
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You can also use filter your memorized obligations (Figure 3.58) to locate specific 
information quickly and easily. For more information on the obligation filter, see 
Filtering Obligations on page 2.18. 

Figure 3.58—Memorized Obligations Filter Option

IMPORTING AND EXPORTING OBLIGATIONS
All instructions for importing and exporting AP obligation data are included in the 
Blackbaud FundWare System Administration Guide. Please refer to this guide for more 
information. You can find all user guides in the FundWare > Data > User 
Documentation folder on your server.
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C H A P T E R  4

TRANSFERRING AND SPLITTING OBLIGATIONS

Once you have entered an obligation at a stage, you must move the obligation forward 
through your AP process. You can do this in a number of ways:

• Transfer—Moving a complete obligation from one stage to another.
• Split—Dividing an obligation into two separate obligations. The new obligation 

can remain at the original stage or move to another stage and is given a new 
obligation number.

• Partial transfer—Transferring just part of an obligation. Both parts of the 
obligation have the same obligation number, but separate dollar amounts.

Before you transfer part of an obligation, consider splitting the 
obligation instead. When you split an obligation, you create a new 
obligation with a new obligation number. This can lead to less 
confusion than a partial transfer, which results in multiple amounts, 
stages, and dates associated with one obligation number

TRANSFERRING OBLIGATIONS
You can transfer an obligation from one stage to another in two ways.

• Click Transfer and complete the Transfer Group window.
• Highlight the obligation(s) and drag it to another folder with the mouse.

When you transfer an obligation, FundWare moves the obligation to the applicable 
Transferred From… subfolder (e.g., Invoice > Transferred From Purchase Order). 
At this point, the obligation is still considered to be at the original stage (i.e., the 
Activity Detail tab of the vendor record lists the obligation at the original stage). 
FundWare moves the obligation to the new stage when you post from the Transferred 
From… subfolder.
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USING TRANSFER GROUP WINDOW

Use the following steps to transfer one or more obligations using the Transfer button.
1.  Open the applicable folder on the Navigation tree.

2. Select one or more obligations. (This is optional.)

3. Click Transfer. The Transfer Group window displays. Any selected obligations 
are included in the Obligations for Edit area (Figure 4.1). 

Figure 4.1—Transfer to Stage

4. Select the Transfer To Stage from the drop-down list.

5. Complete the History note field, as necessary (up to 30 alphanumeric 
characters). FundWare enters this information in the History desc field on the 
obligation when you complete the transfer process. 

The label for this field on the obligation is defined in field 3 (History 
desc) of the stage definition (e.g., Authorized by).
Transferring Obligations 
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6. To change the default Stage Date, enter a new date or click the ellipsis to access 
the calendar function. (The Stage Date defaults to the current Business Date.)

You can enter 00/00/0000 as the Stage Date or leave the field blank to 
maintain the original obligation date.

7. To select or add obligations to the transfer task, click the ellipsis ( ). The 
Multiple Obligation Selector window displays (Figure 4.2). 

Figure 4.2—Multiple Obligation Selector

8. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
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9. Click Search Now. The search results display (Figure 4.3). 

Figure 4.3—Multiple Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

10. Select the obligations.

11. Click OK to close the Multiple Obligation Selector. The obligations are listed in 
the Obligation Nbr. field.
Transferring Obligations 
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12. Click Append to add the obligations to the list of obligations in the Obligations 
for Edit area (i.e., the list of obligations that will be transferred) (Figure 4.4). 

Figure 4.4—Obligation Added to Transfer Group

You can remove or edit an obligation by selecting the obligation and 
clicking the buttons in the lower right corner of the window. You must 
select a stage before you select an obligation (i.e., the obligations are 
not enabled until you select a stage).

13. Click OK. The obligation (or obligations) moves to the applicable Transferred 
From… subfolder, waiting to be posted.

USING DRAG-AND-DROP

Use the following steps to transfer one or more obligations using the “drag-and-drop” 
option.

1.  Open the applicable folder on the Navigation tree.

2. Select one or more obligations in the detail pane. 
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3. Hover the mouse over the obligation until the cursor display includes a plus sign 
and rectangle (Figure 4.5). 

Figure 4.5—Drop and Drag Cursor

4. Click and hold the mouse button while dragging the cursor to the folder in 
which you want the obligation. If you are not allowed to move the obligation to 
the selected folder, the cursor will change to a circle and slash (Figure 4.6). 

Figure 4.6—Drag and Drop Not Allowed

The obligation (or obligations) moves to the applicable Transferred From… subfolder, 
waiting to be posted.

Note the following rules for using the drag-and-drop option:

• Subfolders that appear only when they hold obligations (e.g., Mark for 
Pay) must be displayed on the folder tree for you to drag-and-drop an 
obligation to them.

• Your security restrictions are respected (i.e., you cannot drag-and-drop an 
obligation to a stage from which you are restricted).

• You cannot drag-and-drop a memorized obligation to create a new 
obligation.

SPLITTING OBLIGATIONS
You can split an obligation into two obligations: an edited original obligation and a new 
obligation (with a new obligation number). 

In this example, the icon tells us we can’t drag and drop this 
obligation to the Purchase Order folder because it is already in this 
folder.
Splitting Obligations 
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• The overall description, references, and discounts are applied to both 
obligations. 

• The original obligation retains its stage and date. 
• The new obligation uses a stage selected by you and a stage date equal to the 

business date at the time of the split.
• The new obligation number is stored in obligation reference A—Obligation 

number. The number of the originating obligation is stored in obligation 
reference C—Original obligation number. 

When you split an obligation, FundWare moves the whole obligation to the applicable 
Split From… subfolder (e.g., Invoice > Split From Purchase Order). At this point, 
the obligation is still whole and considered to be at the original stage (i.e., the Activity 
Detail tab of the vendor record lists the obligation at the original stage). FundWare 
creates the new obligation when you post from the Split From… subfolder.
One of the most useful functions of obligation splitting is to subtract dollars from a 
long-term encumbrance as the dollars are actually spent. For example, you could create 
an obligation for the year’s encumbrance for computer equipment. When a purchase is 
made, you split that purchase into a separate obligation so it can be processed and paid.
The process for splitting an obligations varies slightly depending on your entry method 
(i.e., combined or separate entry).

SPLITTING OBLIGATIONS WITH COMBINED ENTRY

Use the following steps to split an obligation if you are using combined entry.
1.  Open the applicable folder on the Navigation tree.

2. Click Split. A window prompts you for the Split To Stage (Figure 4.7). 

Figure 4.7—Split to Stage
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3. Select the stage where you want FundWare to save the new obligation (created 
by the split) and click OK. The obligation displays, open to the Header tab 
(Figure 4.8). 

Figure 4.8—Header Tab
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4. Select the Detail Lines tab. The distribution for the original obligation displays 
in the upper of two detail panes (Figure 4.9). 

Figure 4.9—Detail Lines Tab

When you complete the split, the upper detail pane will contain the 
remaining portion of the original obligation, the lower detail pane will 
contain the detail lines for the new obligation. 
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5. If the obligation has multiple line items, you can split an entire line by 
highlighting it and clicking Split. The line moves to the lower detail pane 
(Figure 4.10). 

Figure 4.10—Splitting an Entire Line Item

The line item for account A01 01-00 7200 moves 
from the original stage (Stage 20 - Purchase Order) 
to the split stage (Invoice - Stage 30).
Splitting Obligations 
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6. To split a portion of a line item, highlight the line and click Partial. The Partial 
Split Distribution Line window displays (Figure 4.11). 

Figure 4.11—Partial Split Distribution Line
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7. Enter the Split Amount or the Split Quantity and click OK. You return to the 
Line Items tab (Figure 4.12). 

Figure 4.12—Line Items Tab With Split Amount

8. To enter or edit the line item information, highlight a line in one of the detail 
panes and click Edit. The Distribution Entry window displays (Figure 4.13). 

Figure 4.13—Distribution Entry Screen
Splitting Obligations 
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9. Enter the detail information and click OK. The Distribution Entry window 
closes and you return to the Detail Lines tab of the obligation entry form.

10. Click Apply to save your changes and remain in the obligation form, or click 
OK to save your changes and close the obligation form. The obligation moves 
to the appropriate Split From subfolder (e.g., Invoices > Split From P.O.).

The whole obligation is stored in the appropriate Split From subfolder. 
FundWare will create the new obligation and return the remainder 
obligation to the original stage when you post.

11. If the new obligation is ready for posting, select it and click Post. The stage date 
for the new obligation reflects the current business date.

SPLITTING OBLIGATIONS WITH SEPARATE ENTRY

Use the following steps to split an obligation if you are using separate entry.
1.  Open the applicable folder on the Navigation tree.

2. Click Split. A window prompts you for the Split To Stage (Figure 4.14). 

Figure 4.14—Split to Stage
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3. Select the stage where you want FundWare to save the new obligation (created 
by the split) and click OK. The obligation displays, open to the Header tab 
(Figure 4.15). 

Figure 4.15—Header Tab
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4. Select the Line Items tab (Figure 4.16). 

Figure 4.16—Line Items Tab

Remember—You must split the same amount to the new obligation on 
both the Line Items and Distribution tabs. 

5. If the obligation has multiple line items, you can split an entire line by 
highlighting it and clicking Split. The line moves to the lower detail pane 
(Figure 4.17). 

Figure 4.17—Line Items Tab—Split Entry
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6. To split a portion of a line item, highlight the line and click Partial to display 
the Partial Line Item Split window (Figure 4.18). 

Figure 4.18—Partial Line Item Split

7. Enter the Split Amount or the Split Quantity and click OK. You return to the 
Line Items tab (Figure 4.19). 

Figure 4.19—Line Items Tab With Split Amount
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8. Highlight a line item in the detail pane and click Edit to add additional 
information for the new obligation. The Detail Entry window displays (Figure 
4.20). 

Figure 4.20—Detail Entry Screen

9. Enter the detail information and click OK.

10. Select the Distribution tab. The distribution for the original obligation displays 
in the upper of two detail panes (Figure 4.21). 

Figure 4.21—Distribution Tab
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11. If the obligation has multiple line items, you can split an entire line by 
highlighting it and clicking Split or using. The line moves to the lower detail 
pane (Figure 4.22). (You can also “drag and drop” lines.) 

Figure 4.22—Splitting an Entire Line Item

When you complete the split, the upper detail pane will contain the 
remaining portion of the original obligation, the lower detail pane will 
contain the detail lines for the new obligation. 

The line item for account A01 01-00 7200 moves from 
the original stage (Stage 20 - Purchase Order) to the 
split stage (Invoice - Stage 30).
Splitting Obligations 



Chapter 4—Transferring and Splitting Obligations
12. To split a portion of a line item, highlight the line and click Partial to display 
the Partial Split Distribution Line window (Figure 4.23). 

Figure 4.23—Partial Split Distribution Line

13. Enter the Amount and click OK. You return to the Distribution tab (Figure 
4.24). 

Figure 4.24—Distribution Tab With Split Amount
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14. To enter or edit the line item information, highlight a line in one of the detail 
panes and click Edit. The Distribution Entry window displays (Figure 4.25). 

Figure 4.25—Distribution Entry Screen

15. Enter the detail information and click OK.

Remember—You must split the same amount to the new obligation on 
both the Line Items and Distribution tabs. You cannot complete this 
process until the amount on each tab matches.

16. Click Apply to save your changes and remain in the obligation form, or click 
OK to save your changes and close the obligation form. The obligation moves 
to the appropriate Split From subfolder (e.g., Invoices > Split From P.O.).

The whole obligation is stored in the appropriate Split From subfolder. 
FundWare will create the new obligation and return the remainder 
obligation to the original stage when you post.

17. If the new obligation is ready for posting, select it and click Post. The stage date 
for the new obligation reflects the current business date.
Splitting Obligations 
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TRANSFERRING PART OF AN OBLIGATION
You can transfer just part of an obligation. For example, if some items are back ordered, 
you can transfer the received portion so that it can be paid. Both parts of the obligation 
have the same obligation number, but separate dollar amounts. 

Before you transfer part of an obligation, consider splitting the obligation 
instead. When you split an obligation, you create a new obligation with a new 
obligation number. This can lead to less confusion than a partial transfer, which 
results in multiple amounts, stages, and dates associated with one obligation 
number

PARTIALLY TRANSFERRING OBLIGATIONS WITH COMBINED ENTRY

Use the following steps to partially transfer an obligation if you are using combined 
entry.

1.  Open the applicable folder on the Navigation tree.

2. Select one or more obligations. (This is optional.)

3. Click Transfer. The Transfer Group window displays. Any selected obligations 
are included in the Obligations for Edit area (Figure 4.1). 

Figure 4.26—Transfer to Stage
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4. Select the Transfer To Stage from the drop-down list.

5. Complete the History note field, as necessary (up to 30 alphanumeric 
characters). FundWare enters this information in the History desc field on the 
obligation when you complete the transfer process. 

The label for this field on the obligation is defined in field 3 (History 
desc) of the stage definition (e.g., Authorized by).

6. To change the default Stage Date, enter a new date or click the ellipsis to access 
the calendar function. (The Stage Date defaults to the current Business Date.)

You can enter 00/00/0000 as the Stage Date or leave the field blank to 
maintain the original obligation date.

7. To select or add obligations to the transfer task, click the ellipsis ( ). The 
Multiple Obligation Selector window displays (Figure 4.27). 

Figure 4.27—Multiple Obligation Selector

8. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
Transferring Part of an Obligation 
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9. Click Search Now. The search results display (Figure 4.28). 

Figure 4.28—Multiple Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

10. Select the obligations.

11. Click OK to close the Multiple Obligation Selector. The obligations are listed in 
the Obligation Nbr. field.
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12. Click Append to add the obligations to the list of obligations in the Obligations 
for Edit area (i.e., the list of obligations that will be transferred) (Figure 4.29). 

Figure 4.29—Obligation Added to Transfer Group

You can remove or edit an obligation by selecting the obligation and 
clicking the buttons in the lower right corner of the window. You must 
select a stage before you select an obligation (i.e., the obligations are 
not enabled until you select a stage).

13. Select an obligation that you want to partially transfer.

14. Click Edit. The Purchase Order Edit window displays.
Transferring Part of an Obligation 
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15. Select the Detail Lines tab. It displays with the obligation in the lower of two 
detail panes (Figure 4.30). You must complete the screen so that the lower 
detail pane contains the portion you want to transfer and the upper detail pane 
contains the portion that you do not want to transfer. 

Figure 4.30—Detail Lines Tab
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16. Select the line(s) that you do not want to transfer and drag it to the upper detail 
pane or click UnTransfer. (In other words, by default FundWare will transfer 
all of the obligation. Moving the detail line from the transfer area tells 
FundWare that this part of the obligation should not be transferred.) The 
selected line(s) moves to the upper detail pane (Figure 4.31). 

Figure 4.31—Partial Transfer
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17. To transfer part of a line item, select the line(s) that you do not want to transfer 
and click Partial. The Partial Transfer Distribution Line window displays 
(Figure 4.32). 

Figure 4.32—Partial Transfer Distribution Line

18. In the From Amount field, enter the amount of the line item that you want to 
remain at the current stage (i.e., that should not be transferred).
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19. Click OK. The funds are moved to the Distribution Lines window for the 
current stage (i.e., will not be transferred) (Figure 4.33). 

Figure 4.33—Partial Transfer of Line Items

20. Click OK. You return to the Transfer Group window.

21. Click OK. The second obligation (or obligations) is saved to the Transferred 
From… subfolder under the selected stage, waiting to be posted.

PARTIALLY TRANSFERRING OBLIGATIONS WITH SEPARATE ENTRY

Use the following steps to partially transfer an obligation if you are using separate entry.
1.  Open the applicable folder on the Navigation tree.

2. Select one or more obligations. (This is optional.)
Transferring Part of an Obligation 
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3. Click Transfer. The Transfer Group window displays. Any selected obligations 
are included in the Obligations for Edit area (Figure 4.34). 

Figure 4.34—Transfer to Stage

4. Select the Transfer To Stage from the drop-down list.

5. Complete the History note field, as necessary (up to 30 alphanumeric 
characters). FundWare enters this information in the History desc field on the 
obligation when you complete the transfer process. 

The label for this field on the obligation is defined in field 3 (History 
desc) of the stage definition (e.g., Authorized by).

6. To change the default Stage Date, enter a new date or click the ellipsis to access 
the calendar function. (The Stage Date defaults to the current Business Date.)

You can enter 00/00/0000 as the Stage Date or leave the field blank to 
maintain the original obligation date.
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7. To select or add obligations to the transfer task, click the ellipsis ( ). The 
Multiple Obligation Selector window displays (Figure 4.35). 

Figure 4.35—Multiple Obligation Selector

8. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
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9. Click Search Now. The search results display (Figure 4.36). 

Figure 4.36—Multiple Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

10. Select the obligations.

11. Click OK to close the Multiple Obligation Selector. The obligations are listed in 
the Obligation Nbr. field.
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12. Click Append to add the obligations to the list of obligations in the Obligations 
for Edit area (i.e., the list of obligations that will be transferred) (Figure 4.37). 

Figure 4.37—Obligation Added to Transfer Group

You can remove or edit an obligation by selecting the obligation and 
clicking the buttons in the lower right corner of the window. You must 
select a stage before you select an obligation (i.e., the obligations are 
not enabled until you select a stage).

13. Select an obligation that you want to partially transfer.

14. Click Edit. The Purchase Order Edit window displays.
Transferring Part of an Obligation 
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15. Select the Distribution tab. It displays with the obligation in the lower of two 
detail panes (Figure 4.38). You must complete the screen so that the lower 
detail pane contains the portion you want to transfer, and the upper detail pane 
contains the portion that you do not want to transfer. 

Figure 4.38—Distribution Tab
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16. Select the line(s) that you do not want to transfer and drag it to the upper detail 
pane or click UnTransfer. (In other words, by default FundWare will transfer 
all of the obligation. Moving the detail line from the transfer area tells 
FundWare that this part of the obligation should not be transferred.) The 
selected line(s) moves to the upper detail pane (Figure 4.39). 

Figure 4.39—Partial Transfer
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17. To transfer part of a line item, select the line(s) that you do not want to transfer 
and click Partial. The Partial Transfer Distribution Line window displays 
(Figure 4.40). 

Figure 4.40—Partial Transfer Distribution Line

18. In the From Amount field, enter the amount of the line item that you want to 
remain at the current stage (i.e., that should not be transferred).
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19. Click OK. The funds are moved to the Distribution Lines window for the 
current stage (i.e., will not be transferred) (Figure 4.41). 

Figure 4.41—Partial Transfer of Line Items

20. Click OK. You return to the Transfer Group window.

21. Click OK. The second obligation (or obligations) is saved to the Transferred 
From… subfolder under the selected stage, waiting to be posted. 

 

Transferring Part of an Obligation 



C H A P T E R  5

PAYING OBLIGATIONS

FundWare Accounts Payable gives you the capability to perform all the tasks required to 
pay obligations. You can easily control and track the obligations as they move through 
the following steps in the payment process:

• Designate which obligations to pay.
• Create a preliminary check register.
• Create the checks.
• Log the checks.
• Reconcile the checks.

PAYMENT STAGES
Your organization selected its check writing stage during setup (Working With Stages on 
page 1.67). In Division 95, we defined Stage 30—Invoice as the Ready for Pay stage 
(i.e., that stage at which an obligation is marked for pay, or the “check writing stage”) in 
the Extended Setup parameter and refer to this stage throughout the manual. Remember 
that your organization probably defined a different stage as the Ready for Pay stage.

MARKING OBLIGATIONS FOR PAYMENT
Marking obligations for payment is the first step in the payment process. Use the 
following instructions to mark obligations for payment.
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1.  Open the applicable folder on the Navigation tree. When you open the folder for 
the Ready for Pay stage (in Division 95, this is Stage 30—Invoice), Mark for 
Pay is enabled (Figure 5.1). 

Figure 5.1—Ready for Pay Stage

2. Select one or more obligations. (This is optional.)
Marking Obligations for Payment 
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3. Click Mark for Pay. The Transfer Group window displays. Any selected 
obligations are included in the Obligations for Edit area (Figure 5.2). 

Figure 5.2—Mark for Pay Window

If you have produced the check file but not logged your checks, 
FundWare will display a message that you cannot mark obligations for 
pay until you complete the check writing process. From the Cut 
Checks subfolder of the Financial Institution account, click Log 
Checks and complete the task.

4. Select the Financial Institution account (FIA) from the Bank drop-down list.

5. Complete the History desc field, as necessary (up to 30 alphanumeric 
characters). FundWare enters this information in the History desc field on the 
obligation when you complete the Mark for Pay process.
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The label for this field and the associated field on the obligation is 
determined by the entry in field 3 (History desc) of the stage definition 
for the Mark for Pay stage. For example, in Division 95, stage 50 is the 
Mark for Pay stage. The History desc is “Authorized by;” therefore, this 
field is labeled “Authorized by.”

6. To change the default Due Date, enter a new date or click the ellipsis to access 
the calendar function. (The Stage Date defaults to the current Business Date.)

You can enter 00/00/0000 as the Stage Date or leave the field blank to 
maintain the original obligation date.

7. If applicable, override the discount setting. (For more information on this 
feature, see The “Take Discount” Override on page 2.89.)

8. To select or add obligations to the Mark for Pay task, click the ellipsis ( ). The 
Multiple Obligation Selector window displays (Figure 5.3). 

Figure 5.3—Multiple Obligation Selector

9. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
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10. Click Search Now. The search results display (Figure 5.4). 

Figure 5.4—Multiple Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

11. Select the obligations.

12. Click OK to close the Multiple Obligation Selector. The obligations are listed in 
the Obligation Nbr. field.
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13. Click Append to add the obligations to the list of obligations in the Mark For 
Pay - Obligations area (i.e., the list of obligations that will be marked for 
payment) (Figure 5.5). 

Figure 5.5—Obligations Marked for Payment

You can remove or edit an obligation by selecting the obligation and 
clicking the buttons in the lower right corner of the window. You must 
select an FIA before you select an obligation (i.e., the obligations are 
not enabled until you select a bank).
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14. Click OK. The obligation (or obligations) is saved to the New Mark subfolder 
of the Mark for Pay stage, under the selected FIA (Figure 5.6). 

Figure 5.6—New Mark Folder for Alpenglow Federal Bank (Division 95)

In Division 95, the Extended Setup parameter defines the Mark for Pay 
stage as stage 50—Marked for Payment. Therefore, our obligations are 
saved to the Marked for Payment > New Mark subfolder. Your 
organization can name this stage to suite your needs.

15. Edit or verify the obligation before posting it to the Mark for Pay stage folder, as 
necessary. (For more information on the verify feature, see Verifying 
Obligations on page 2.103.)

If you remove an obligation from the New Mark subfolder, FundWare 
removes the mark for payment and returns the obligation to the Ready 
for Pay folder.

16. Click Post. When the posting task is finished, a completion message displays.
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17. Click OK. All the obligations in the New Mark subfolder are moved to the 
Mark for Pay stage folder for the FIA (Figure 5.7). 

Figure 5.7—Marked for Payment Folder for Alpenglow Federal Bank (Division 95)

“UNMARKING” AN OBLIGATION

If you have posted a obligation to the Mark for Pay stage folder, but later need to modify 
that obligation, you must “unmark” the obligation (i.e., transfer the obligation back to 
the Ready for Pay stage). 

1.  Select the obligation in the Mark for Pay stage folder.

In Division 95, the Extended Setup parameter defines the Mark for Pay 
stage as stage 50—Marked for Payment. Therefore, our obligations are 
saved to the Marked for Payment > New Mark subfolder. Your 
organization can name this stage to suite your needs.
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2. Click UnMark. The Unmark for Pay - Group window displays (Figure 5.8). 

Figure 5.8—UnMark for Pay - Group

3. Complete the History desc field, as necessary (up to 30 alphanumeric 
characters). FundWare enters this information in the History desc field on the 
obligation when you complete the Mark for Pay process.

The label for this field and the associated field on the obligation is 
determined by the entry in field 3 (History desc) of the stage definition 
for the Mark for Pay stage. For example, in Division 95, stage 50 is the 
Mark for Pay stage. The History desc is “Authorized by;” therefore, this 
field is labeled “Authorized by.”

4. To change the default Due Date, enter a new date or click the ellipsis to access 
the calendar function. (The Stage Date defaults to the current Business Date.)

You can enter 00/00/0000 as the Stage Date or leave the field blank to 
maintain the original obligation date.
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5. To select or add obligations to be “unmarked,” click the ellipsis ( ). The 
Multiple Obligation Selector window displays (Figure 5.9). 

Figure 5.9—Multiple Obligation Selector

6. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
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7. Click Search Now. The search results display (Figure 5.10). 

Figure 5.10—Multiple Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

8. Select the obligations.

9. Click OK to close the Multiple Obligation Selector. The obligations are listed in 
the Obligation Nbr. field.
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10. Click Append to add the obligations to the list of obligations in the Mark For 
Pay - Obligations area (i.e., the list of obligations that will be marked for 
payment) (Figure 5.11). 

Figure 5.11—Obligations UnMarked for Payment

You can remove or edit an obligation by selecting the obligation and 
clicking the buttons in the lower right corner of the window. You must 
select an FIA before you select an obligation (i.e., the obligations are 
not enabled until you select a bank).

11. Click OK. The unmarked obligations are moved to the UnMarked from… 
subfolder (e.g., UnMarked from Alpenglow Federal Bank) in the folder for 
the Ready to Pay stage (e.g., Invoice).

If you decide to unmark an obligation before processing your checks 
(e.g., if you have a negative check), you must post the obligation from 
the UnMarked from… subfolder (e.g., UnMarked from Alpenglow 
Federal Bank) to the folder for the Ready to Pay stage (e.g., Invoice) 
before you can start the check writing task. 
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CREATING A CHECK FILE
The obligations in the Mark for Pay stage folder are ready to begin the check writing 
process. Use the following instructions to create your checks.

1.  Click File > Print Manager on the module navigator. The Print Manager 
feature opens.

2. Minimize Print Manager. (You cannot open Print Manager once you begin the 
Check Wizard. By opening the program first, you can view or print the 
Preliminary Check Register file [OTPREG] without closing the check wizard.)

3. Open the Mark for Pay stage folder. At the bottom of the window, FundWare 
indicates the total dollar amount and number of obligations marked for pay 
(Figure 5.12). 

Figure 5.12—Creating a Check File

In Division 95, the Extended Setup parameter defines the Mark for Pay 
stage as stage 50—Marked for Payment. Therefore, our obligations are 
saved to the Marked for Payment > New Mark subfolder. Your 
organization can name this stage to suite your needs.
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4. Click Chk Writing. The preliminary check register displays, indicating any 
potential duplicate entries, total number of checks, and total dollar amount 
(Figure 5.13). 

Figure 5.13—Check Writing

5. Click Produce Register to create the preliminary register file (OTPREG.L##, 
where ## represents your division number).

6. Open this report in Print Manager and review the information (either onscreen 
or printed).

If you click Close while you are at the Preliminary Check Register step, 
FundWare will cancel the check writing process. At other steps in the 
process, FundWare will save your entries, allowing you to restart the 
wizard at that point 

7. Continue with the Produce Check tab.

Number of checks 
in this run.

Total dollar amount 
in this run.

A message displays here if there are any 
possible duplicate entries.
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PRODUCE CHECKS TAB

Use the following instructions to continue the check writing process with the Produce 
Checks tab.

1.  Select the Produce Checks tab (Figure 5.14). 

Figure 5.14—Produce Checks Tab

2. Enter the starting control number. 

Depending on the setup of the Financial Institution account (AP By Use 
association), the starting control number may be different from the 
printed check number and you may not be allowed to change this 
number. 

3. Click Produce Sample Check to review the check results before creating the 
final check file. The sample check report is named OTDCHK.L## (where ## 
represents your division number).

This step is not required but suggested if you have recently defined or 
modified your check format.

4. Open this report in Print Manager and review the information (either onscreen 
or printed).
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If you click Close before producing your checks, FundWare will cancel 
the check writing process. After you click Produce Checks, FundWare 
will save your entries, allowing you to restart the wizard at that point.

5. Click Produce Checks to create the final check file. The name of the check file 
includes the first four digits of the Usage ID of the Financial Institutions 
account, or fills the remaining positions with “X.”

You have an FIA with an ID of “1.” When you produce the check file 
for this FIA, the file name is OTCHK1XXX.L## (where ## represents 
your division number). 

You have an FIA with an ID of “14503.” When you produce the check 
file for this FIA, the file name is OTCHK1450.L## (where ## 
represents your division number). 

6. Open the check file in Print Manager and print your checks.

7. Continue with the Log Check Numbers tab (enabled once you produce the 
final check file).

LOG CHECK NUMBERS TAB

If you have printed your checks, you are ready to log a single check number (1255) or a 
series of check numbers (1255 through 1259). (Because checks can be destroyed 
accidently during the printing process, you should not log check numbers until the 
physical check has been printed.)
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1.  Select the Log Check Numbers tab (Figure 5.15). 

Figure 5.15—Produce Checks—Log Check Numbers Tab

2. Select one or more checks.
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3. Enter the check number (either the first or only check number) in the Starting 
With text box (Figure 5.16). 

Figure 5.16—Assigning Check Numbers to a Group

4. Click Assign. If you only select one check, FundWare assigns the number that 
you enter in the Starting With text box to the selected check. If you select 
multiple checks, FundWare assigns the check numbers sequentially beginning 
with the first selected check and the number that you enter in the Starting With 
text box. 

5. Ensure that the assigned check numbers match the numbers of the physical 
printed checks.

If you click Close before posting your checks, FundWare will save your 
entries. To restart the wizard at that point, click Log Checks from the 
Cut Checks folder.

6. Click Post. If you have an existing check register (OTREG.L##), FundWare 
asks if you want to overwrite or append the file. 

7. Click Yes to overwrite the existing file or click No to append the new check 
register to the existing file. A batch confirmation message displays.
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8. Click OK. A final confirmation message displays regarding Financial 
Institutions.

9. Click OK. FundWare displays the Done tab, disabling the Log Check 
Numbers tab (Figure 5.17). 

Figure 5.17—Done Tab

10. Click Done. You have completed the check writing process and the window 
closes.
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VIEWING SEPARATE AND COMBINED CHECKS FOR VENDORS

When you click Chk Writing and the Preliminary Check Register displays, you will see 
all the checks in the batch, including separate checks for vendors if the vendor record or 
obligation has this setting (Figure 5.14). For more information on this feature, see Using 
the Combined or Separate Check Function on page 2.94. 

Figure 5.18—Preliminary Check Register—Separate Checks

The vendor 
record for ABC 
Hardware has 
a .VPAYMENT 
value of 
Separate. For 
each 
obligation, we 
accepted the 
default setting. 
Therefore, this 
batch includes 
separate 
checks for the 
two ABC 
Hardware 
obligations in 
this batch.

In comparison, 
Fredericka 
Loomis has 
one combined 
check.
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NEGATIVE OBLIGATIONS AND CHECKS

Your organization may receive a refund or credit memo, in which case you will enter it 
as a negative amount. If this results in a negative check in the preliminary check register, 
the text is in red and a warning message displays (Figure 5.19). 

Figure 5.19—Negative Check Displayed in the Preliminary Check Register

You are not permitted to write checks for that run. Therefore, you must remove the 
obligation from the Mark for Pay stage folder (see “UnMarking” an Obligation on page 
2.168 for instructions) before you can proceed with the check writing task. Once you 
have additional obligations for the vendor, increasing the net amount due to the vendor 
to $0.00 or greater, you can mark the negative obligation for pay and continue the 
process.

If you remove the obligation from the Mark for Pay stage folder, you must post 
the obligation from the UnMarked from… subfolder (e.g., UnMarked from 
Alpenglow Federal Bank) to the folder for the Ready to Pay stage (e.g., 
Invoice) before you can restart the check writing task. 

However, in rare situations (e.g., a vendor going out of business) you may have to take 
the following action to resolve an obligation with a negative amount.
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1.  Enter a new obligation for the vendor. The amount of the new obligation must 
be a positive amount equal to the negative balance.

2. Enter the account number(s) that should be debited. 

• If the vendor will issue a refund at a later date, enter the receivable account 
used to track pending refunds.

• If the vendor will not refund, enter the account number to write off bad 
debts or the expense account originally charged with the credit memo.

3. Mark both the negative and positive obligations for pay.

4. Produce the check run. FundWare will produce a check for the vendor with a 
zero amount ($0.00).

5. Log the check. Both Accounts Payable and the General Ledger are now correct.

If you have a large number of refunds and write-offs, you may want to define a bank 
specifically to handle them. 

LOGGING UNUSED CHECKS
There could be a number of reasons why you skip a check number. Therefore, AP lets 
you keep track of unused check numbers. 
Logging Unused Checks 
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1.  Open the Paid stage folder for the Financial Institutions account (Figure 5.20). 

Figure 5.20—Paid Folder (Division 95)

In Division 95, the Extended Setup parameter defines the Paid stage as 
stage 60—Paid. Therefore, our obligations are saved to the Paid folder. 
Your organization can name this stage to suite your needs.

2. Click Log Unused. The Unused Checks window displays (Figure 5.21). 

Figure 5.21—Unused Checks

3. Enter the number of the unused check in the Unused Check text box.

4. Enter a optional description (up to 35 alphanumeric characters). For example, 
“check tore in printer.”
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5. Click OK to log the unused check and close the Unused Checks window, or 
click Apply to log the unused check and remain in the Unused Checks window.

VOIDING A CHECK
After you print a check, you can void it from the Paid stage folder. When you void a 
check, FundWare will:

• Return the obligation to the Ready for Pay stage folder (e.g., Invoice). (If you 
want to void the obligation as well, you must do that once the obligation has 
returned to the Ready for Pay stage folder.)

• Post a journal entry to General Ledger:
— Debit = Cash, 
— Credit = Accounts Payable. 

• Change the check status to void.
Use the following instructions to void checks.

1.  Select the check(s) from the Paid stage folder (Figure 5.22). 

Figure 5.22—Selecting Checks to Void

In Division 95, the Extended Setup parameter defines the Paid stage as 
stage 60—Paid. Therefore, our obligations are saved to the Paid folder. 
Your organization can name this stage to suite your needs.
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2. Click Void. The Void Checks window displays with the selected checks 
(Figure 5.23). 

Figure 5.23—Void Checks

To remove a check from the list of checks to be voided, select the check 
and click Remove.

3. Click Post. If you have an existing check register (OCVCHK.L##), FundWare 
asks if you want to overwrite or append the file. 

4. Click Yes to overwrite the existing file or click No to append the new check 
register to the existing file. A final confirmation message displays regarding 
Financial Institutions.

5. Click OK. FundWare has:

• Returned the obligation to the Ready for Pay stage folder (e.g., Invoice), 
using the original obligation number. (To void the obligation as well, you 
must select the obligation and click Void.)

• Posted a journal entry to General Ledger:
— Debit = Cash, 
— Credit = Accounts Payable. 

• Changed the check status to void.
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CREATING MANUAL CHECKS FOR AN EXISTING OBLIGATION
Use the following instructions to enter manual checks for existing obligation.

1.  Open the New Manual Checks subfolder for the FIA.

2. Click New. The New Manual Check window displays (Figure 5.24). 

Figure 5.24—New Manual Check Window

3. Select Existing Obligation. The Stage drop-down list is enabled.

4. Select the stage at which the existing obligation is stored from the Stage drop-
down list. (If you select New Obligation, you do not need to select a stage.)
Creating Manual Checks for an Existing Obligation 
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5. Click OK. The New Manual Check window displays (Figure 5.25). 

Figure 5.25—New Manual Check (Combined Entry)
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6. Enter the obligation number in the Obligation field or click the ellipsis ( ) to 
select the number from a list of existing obligations. The Single Obligation 
Selector window displays (Figure 5.26). 

Figure 5.26—Single Obligation Selector

7. Enter your search criteria. FundWare will filter the search results based on the 
Sort By selection, and will jump to a specific location if you enter a value in the 
Scroll Starting With field. 
Creating Manual Checks for an Existing Obligation 
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8. Click Search Now. The search results display (Figure 5.27). 

Figure 5.27—Single Obligation Selector—Search Results

You can sort the search results by clicking a column heading. Clicking 
the heading a second time reverses the sort order. Click Scroll Up or 
Scroll Down to move through the search results.

9. Select the obligation.
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10. Click OK to close the Single Obligation Selector. The obligation is displayed in 
the New Manual Check form (Figure 5.28). 

Figure 5.28—Existing Obligation in the New Manual Check Form (Combined Entry)

11. Enter the number of the new check in the Check Number field. 

12. Click OK to save the check and close the New Manual Check window, or click 
Apply to save the check and remain in the New Manual Check window.

13. Edit or verify the check before posting it to the Paid stage folder, as necessary. 
(For more information on the verify feature, see Verifying Obligations on page 
2.103.)

If you remove a check from the New Manual Check subfolder, 
FundWare removes the mark for payment and returns the obligation to 
the original stage folder.

14. Click Post. All the checks in the detail pane move to the Paid subfolder. 
Creating Manual Checks for an Existing Obligation 
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CREATING MANUAL CHECKS FOR A NEW OBLIGATION
Use the following instructions to enter a manual check for a new obligation.

1.  Open the New Manual Checks subfolder for the FIA.

2. Click New. The New Manual Check window displays (Figure 5.24). 

Figure 5.29—New Manual Check Window

3. Select New Obligation. (If you select New Obligation, the Stage drop-down list 
is enabled and you must select the stage at which the existing obligation is 
stored.)
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4. Click OK. The New Manual Check window displays (Figure 5.25). 

Figure 5.30—New Manual Check (Combined Entry)

5. Enter the number of the new check in the Check Number field. 

6. Enter the required obligation information. (See Entering Obligations—Separate 
Entry on page 2.64 or Entering Obligations—Combined Entry on page 2.74 for 
specific instructions.)

7. Click OK to save the check and close the New Manual Check window, or click 
Apply to save the check and remain in the New Manual Check window.

8. Edit or verify the check before posting it to the Paid stage folder, as necessary. 
(For more information on the verify feature, see Verifying Obligations on page 
2.103.)

If you remove a check from the New Manual Check subfolder, 
FundWare removes the mark for payment and returns the obligation to 
the original stage folder.

9. Click Post. All the checks in the detail pane move to the Paid subfolder. 
Creating Manual Checks for a New Obligation 
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RECONCILING CHECKS
After you log checks, they move to the Paid stage folder, ready to be reconciled. Use the 
following steps to reconcile your checks within AP. (If you have the separate Bank 
Reconciliation module, refer to the Blackbaud FundWare Bank Reconciliation Guide 
for instructions.) 

1.  Open the Paid stage folder for the Financial Institutions account (Figure 5.20). 

Figure 5.31—Paid Folder (Division 95)

In Division 95, the Extended Setup parameter defines the Paid stage as 
stage 60—Paid. Therefore, our obligations are saved to the Paid folder. 
Your organization can name this stage to suite your needs.
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2. Select the obligations that you want to reconcile (Figure 5.32). 

Figure 5.32—Obligations Selected

3. Click Mark Recon. The Mark for Reconcile Checks group window displays 
(Figure 5.33). 

Figure 5.33—Mark for Reconcile Checks
Reconciling Checks 
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To remove a check from the list of checks to be reconciled, select the 
check and click Remove. The check remains in the Paid stage folder.

4. Click Mark to reconcile the checks in the list. FundWare moves the checks the 
Marked for Reconciliation subfolder for the FIA (Figure 5.34). 

Figure 5.34—Marked for Reconciliation

5. Open the Marked for Reconciliation subfolder. 

To remove a check from the Marked for Reconciliation subfolder, 
select the check and click UnMar Recon. FundWare returns the check 
to the Paid stage folder.

6. Click Post Rec. The reconciliation is complete and the checks are moved to the 
Reconciled stage folder for the FIA.

In Division 95, the Extended Setup parameter defines the Paid stage as 
stage 70—Reconciled. Therefore, our obligations are saved to the 
Reconciled folder. Your organization can name this stage to suite your 
needs.
Blackbaud, Inc. 2.195



Blackbaud FundWare Accounts Payable Guide—Volume 2

2.196
FIA RECAP
AP provides an overview of each Financial Institutions account. This overview shows 
the number of obligations and dollar totals in each FIA folder. Excluded from these 
totals are any obligations stored in a temporary subfolder (e.g., New Mark). Select 
Disbursements > [Bank Name] to view the FIA recap (Figure 5.35). 

Figure 5.35—FIA Recap

IMPORTING RECONCILIATION INFORMATION
All instructions for importing check reconciliation data are included in the Blackbaud 
FundWare System Administration Guide. Please refer to this guide for more 
information. You can find all user guides in the FundWare > Data > User 
Documentation folder on your server.
 

FIA Recap 
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AP INQUIRY

Accounts Payable Inquiry allows you to retrieve data for viewing or printing based on 
user-defined search criteria. To access Inquiry, click Inquiry on the module navigator (if 
the module is not expanded, click Accounts Payable first) or select Accounts 
Payable > Inquiry from the menu bar. The AP - Inquiry window displays (Figure 6.1). 

Figure 6.1—Accounts Payable Inquiry

Use the following instructions to define your search criteria. 
1.  Select the category by which Inquiry will search your AP information: 

• Checks, 
• Check Run, 
• Obligations, or 
• Vendors. 
FundWare enters default search criteria in the first search field, based on the 
category selected.
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2. Select a Data Item from the drop-down list. (The selections available are 
specific to the selected Category.)

3. Enter the range of values for the data item in the First Value and Last Value 
fields.

You can use the * as a wild card. For example, if you want to locate all 
vendors with a zip code within a certain range, you could select the 
Postal Code data item and enter a First Value of “800*” and a Last 
Value of “802*”. FundWare would search for all zip codes beginning 
with those four numbers.

4. Select the applicable Include/Exclude value from the drop-down list:

• Include—All records located matching the data item value range will be 
included in the search results.

• Exclude—All records located matching the data item value range will be 
excluded from the search results.

5. Continue entering up to 10 search criteria to narrow your search results.

6. Click Run. FundWare displays the results of the inquiry in the “pick list” 
window (Figure 6.2). 

Figure 6.2—Example Vendor Inquiry Based on Postal Code

Click Print to save the search results to a report. The report names are 
defined in Inquiry Reports on page 2.204.

7. For more information about an entry, double-click the left column (e.g., in a 
Vendor inquiry, the vendor number and name are the far left columns; in an 
Obligation inquiry, the obligation number is the far left column) to view the 
record details. This is also referred to as “drilling down” on the record.
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An additional option (Display Obligation) appears on the pick list for an 
Obligation inquiry. You can enter the obligation number and click 
Display to view the obligation.

8. Click Close to exit the pick list and return to the Inquiry search criteria.

CHECK DRILL-DOWN
Double-click a Check Number on the Check List to display more detail on the Check 
Display Form (Figure 6.3). 

Figure 6.3—Check Pick List
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CHECK RUN DRILL-DOWN
Double-click the Check Run Number on the List of Check Runs to display the Check 
Run Recap Form (Figure 6.4). 

Figure 6.4—Check Run Pick List
Check Run Drill-Down 
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OBLIGATION DRILL-DOWN
Double-click the Obligation # on the Obligation List to display the Obligation View, 
open to the Header tab (Figure 6.5). The window that displays is similar to a read-only 
version of the edit/entry window. 

Figure 6.5—Obligation Pick List
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Click Revision History or Stage History tab to display the history of the obligation 
(Figure 6.6). 

Figure 6.6—Revision History and Stage History

The Revision History tab details changes in the life of the obligation. You may have to 
scroll right/left to see all the data. 

Select a stage and the Stage History tab displays the obligation’s dollar and distribution data at that 
point. You may have to scroll right/left to see all the data. 
Obligation Drill-Down 



Chapter 6—AP Inquiry
VENDOR DRILL-DOWN
Double-click the Vendor # or Name to display the vendor record (Figure 6.7). You can 
view the vendor’s activity and drill-down on an obligation from the Activity Detail tab 
of the vendor record. 

Figure 6.7—Vendor Pick List
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INQUIRY REPORTS
When you click Print on the selector screen, FundWare saves the search results to a file, 
viewable through Print Manager. If a file already exists, you are given the option of 
overwriting the existing information or appending the new information to the existing 
file. The report names for each type of Inquiry file are listed in Table 6.1.

DISPLAYING OBLIGATIONS
The Display Invoices task allows you to display detail information about a specific 
obligation or more general information for obligations at a specific stage. Use the 
following instructions to display detailed obligation information. (Instructions for the 
stage task follow.)

Table 6.1—Report File Names

Category Report Name

Check OCIOCW.L##

Obligation OTIOTB.L##

Vendor OTIOTS.L##

Check Run No report is available
Inquiry Reports 
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1.  Click Display Invoices on the module navigator (if the module is not expanded, 
click Accounts Payable first) or select Accounts Payable > Display Invoices 
from the menu bar. The Display Invoices window displays (Figure 6.8). 

Figure 6.8—Display Invoices

2. Type D to display detail information about a specific obligation. Complete the 
fields according to Table 6.2. 

Table 6.2—Display Invoices—Detail

Field Definition

Obligation Enter a valid obligation number.

Display 
zero

FundWare will display information about the obligation by stage. However, if the 
transaction nets to zero at a stage, you can choose to display or hide that stage.
• N (Do not display zero stages.)—Any stage that nets to zero is not displayed in the 

inquiry results.
• Y (Display zero stages.)—All stages are displayed in the inquiry results, even if the 

transaction nets to zero.

Display 
dates

Indicate whether FundWare should include the posting date for each line of the 
distribution.
• N (Do not display dist dates.)—This display of the distribution lines will not include the 

posting date.
• Y (Display dist posting dates.)—The posting date is displayed with each line of the 

distribution.
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When you have completed your entries, the obligation information is displayed 
over a number of pages. For example, Figure 6.9 shows the first fields 
displayed, including the vendor information. 

Figure 6.9—Display Invoices (Detail)—Example 1

Figure 6.10 shows a stage with a transaction amount netting to zero. 

Figure 6.10—Display Invoices (Detail)—Example 2
Displaying Obligations 
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Figure 6.11 shows distribution information, including the posting date. 

Figure 6.11—Display Invoices (Detail)—Example 3

3. When complete, press ESC. FundWare asks if you have additional information 
to display.

4. Type Y to continue viewing obligation information or N to close the task.

Use the following instructions to display obligation information by stage.
Blackbaud, Inc. 2.207



Blackbaud FundWare Accounts Payable Guide—Volume 2

2.208
1.  Click Display Invoices on the module navigator (if the module is not expanded, 
click Accounts Payable first) or select Accounts Payable > Display Invoices 
from the menu bar. The Display Vendors window displays (Figure 6.12). 

Figure 6.12—Display Invoices

2. Type S to display obligation information by stage. Complete the fields 
according to Table 6.3. 

Table 6.3—Display Invoices—By Stage

Field Definition

Reference Enter the code for an obligation reference by which FundWare can filter the display 
results. (Required.)

Value Enter a value for the obligation reference to filter the display results. (Optional.)
• Leave this field blank to include all obligations.

Stages Enter the range of stages to be included in the display or accept the default to display 
all obligations.
• To display only one stage, enter the stage number for both parts of the range.

Stage dates Enter a range of stage dates (i.e., the business date that the obligation was posted to 
the stage) to be included in the display or accept the default to display all obligations.
• To display only one date, enter the date for both parts of the range.

Display zero Indicate if obligations that net to zero should be included in the display.
Displaying Obligations 
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When you have completed your entries, the obligation information is displayed. 
For example, Figure 6.13 shows obligations at all stages for a specific date 
range. 

Figure 6.13—Display Invoices (Stage Summary)—Example 1

Figure 6.14 shows the same search, but includes obligations that net to zero. 

Figure 6.14—Display Invoices (Stage Summary)—Example 2

3. When complete, press ESC to display the option menu and type E to exit the 
task.
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C H A P T E R  7

AP REPORTS

The Accounts Payable reporting feature provides you with more than 25 system-defined 
reports, divided into 5 report categories, and 3 user-defined report categories from 
which you can create an unlimited number of user-defined reports (Table 7.1). A ninth 
report category holds your custom PO forms. 

Table 7.1—System-Defined Reports by Category

System-Defined Reports

Check Reports

The system-defined check reports are:
• Check Report Check Register (OTRREG)
• Check Summary (OCCKSUM)
• Check Complete Detail (OCCKHST)
• Check Historical (OCOSTND)
• Check Discounts Taken/Lost (OCDISC)

Purchase Order Reports

The system-defined purchase order reports are:
• PO Detail (OTORD)
• PO Summary (OTSUM)
• PO History (OTHIST)
• PO Distribution (OTDIST)
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In addition, you can define your own reports under the following categories:
• User-Defined Check Reports,
• User-Defined Obligation Reports, and 
• User-Defined Vendor Reports.

PO/Invoice Reports

The system-defined PO/invoice reports are:
• Invoice Detail (OTORD)
• Invoice Aging (OTAGE)
• Invoice Summary (OTSUM)
• Invoice History (OTHIST)
• Invoice Distribution (OTDIST)
• Invoice Cash Requirements (OTCASH)
• Invoice Distribution by Account (OTDSTA)

System Lists

The system-defined system reports are:
• Stages List (OTSTAGE)
• References List (OTREF)
• Banks List (OCBANK)
• Distribution Tables List (OTSTDST)
• City Abbreviations List (NWCITY)
• Location Abbreviation List (OTLOC)

Vendor Reports

The system-defined vendor reports are:
• Vendor One Line (OTV1LST)
• Vendor Complete Record (OTVLIST)
• Vendor Billing Summary (OTV1SUM)
• Vendor Mailing Labels (OTVLBL)
• Vendor Check History (OTVCHKH)

Table 7.1—System-Defined Reports by Category (Continued)

System-Defined Reports
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PRODUCING REPORTS
Use the following instructions to produce an existing report.

1.  Click the report name on the HomePage. The parameter window displays. 

You can also access the report through Report Manager: click Report 
Manager on the Navigator bar or select File > Report Manager from 
the menu bar; and select Accounts Payable, the report category, and the 
report name; and double-click or click Produce.

2. The Produce Reports parameters window displays (Figure 7.1). The parameters 
will vary based on the report that you select. 

Figure 7.1—Example Report Parameter Windows

3. Complete the report settings. Table 7.2 describes what options may be displayed 
on the parameters window. 

Table 7.2—Report Parameter Options

Option Entry Description

Run Enter a single check run 
number.

Only the checks in the check run will be included in the 
report.
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Vendor/
Vendors

Enter a range of vendor 
numbers.

Only the vendor numbers within the range will be 
included in the report.

Amount Enter a range based on the 
check amount.

Only checks where the amount is within the range will 
be included in the report.

Check Enter a range of check 
numbers.

Only the check numbers within the range will be 
included in the report.

Cut Dates Enter a date range, based on 
the date the check was 
produced.

Only the checks produced during the date range will be 
included in the report.

Bank Select the applicable FIA from 
the drop-down list.

Only checks for the selected bank will be included in 
the report.

Status Select the applicable check 
box (or boxes) for the check 
status.

Only checks where the status matches the selections 
will be included in the report.

Reporting 
Date

Enter the reporting date for 
the report.

Only the checks or obligations produced by the 
reporting date will be included in the report.
• Does not apply to the Invoice Aging report.

Print 
References

Select up to nine references 
to include (right box) or 
exclude (left box) using the 
arrow buttons.

The selected information will included in the report. 

Reference/
References

Select a data item from the 
drop-down list and enter a 
range (based on the value of 
the data item).

Filter the information included in the report. This setting 
determines what items will be included in the report, 
not what information (i.e., you can filter based on 
.CITY, but the city won’t display on the report unless 
the report definition or Print References include .CITY).

Stage Select a stage range from the 
drop-down lists.

Only the obligations at the selected stages will be 
included in the report. 
• Tip: To only include obligations in one stage, select 

the same stage from both drop-down lists.

Stage 
Dates

Select a date range from the 
drop-down lists.

Only the obligations meeting the stage date range (i.e., 
the date the obligation was created or transferred to a 
stage) will be included in the report. 

Change 
Dates

Select a date range from the 
drop-down lists.

Only obligations edited during the date range will be 
included in the report.

Table 7.2—Report Parameter Options (Continued)

Option Entry Description
Producing Reports 
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Print zero 
amounts

Select the check box to print 
zero amounts.

Select the check box if zero amounts ($0.00) should be 
printed in the report. If you do not select the check box, 
the zero amount entries will be left blank.

Page break 
on change

Select the check box to insert 
a page break at changes.

The report can use the filter values (i.e., the Reference 
data item and value range) to enter a page break at 
each change in value.

Report 
Type

Select the Detail or Summary 
radio button. 

You can include all report information using the Detail 
option, or include Summary information only.

Account 
Mask

Enter an account mask. Only the accounts matching the mask will be included 
in the report.

Discount 
Date

Enter a date. Includes obligations matching the discount date 
(defined on the Header tab of the obligation).

Report Select the applicable radio 
button.

Select the radio button for your desired report output:
• View—Saves a file (using the report name and the 

letter L plus the division number) in the report 
directory and displays the report in Print Manager.

• Print—Saves a file (using the report name and the 
letter L plus the division number) in the report 
directory and prints the report from your default 
printer.

• File—Saves a file (using the report name and the 
letter L plus the division number) in the report 
directory.

Purchase Orders Only

PO 
Letterhead

Select a letterhead option 
from the drop-down list.

The letterhead options are based on your location 
definitions. See Working With Location Abbreviations 
on page 1.122 for more information.

Address Enter line 1 of the company 
address.

Includes the address on the PO.

Anc. 
Address

Enter line 2 of the company 
address (i.e., ancillary 
address).

Includes the address on the PO.

City/State/
Zip

Enter the city, state, and zip 
code (5 or 9 numbers).

Includes the address on the PO.

Country Enter the country for the 
company address.

Includes the address on the PO.

Table 7.2—Report Parameter Options (Continued)

Option Entry Description
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4. Click OK to produce the report. (Click Cancel to exit the Produce Reports 
window without producing the report.)

CREATING OR EDITING USER-DEFINED REPORTS
To meet the reporting needs of your organization, FundWare gives you a number of 
options when working with reports. You can:

• Copy an existing user-defined report—Select the report and click Copy.
• Create a new report within one of the user-defined categories (e.g., Check 

Reports)—Select the report category to which the new report will belong and 
click New.

• Edit an existing user-defined report—Select the report and click Edit. 
Use the following instructions to create a report in one of the three user-defined 
categories (check, obligation, or vendor reports).

Vendor Reports and User-Defined Reports—The window that displays for vendor and user-defined 
reports allows you to filter the information included in the report, based on data item values. Your 
selections do not determine the actual information in the report (i.e., you can filter based on .CITY, but if 
the report definition does not include this data item, you won’t see the cities included by the filter).

• Field Select a data item from the 
drop-down list.

The report will use this data item to filter the results.

• First 
Value

Enter the first value of the 
range.

The report will use this data item value to filter the 
results.
• To filter on only one value, enter the same first and 

last value.

• Last 
Value

Enter the last value of the 
range.

The report will use this data item value to filter the 
results.
• To filter on only one value, enter the same first and 

last value.

• Sort Select a sort priority number 
from the drop-down list.

The report will filter the results in the order entered, 
based on this number.

• Range Select Included or Excluded 
from the drop-down list.

The filter results will be included or excluded from your 
report based on your selection.

Table 7.2—Report Parameter Options (Continued)

Option Entry Description
Creating or Editing User-Defined Reports 
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DEFINING OR EDITING THE REPORT NAME AND GENERAL TAB

Use the following instructions to enter or modify the report name, title, and type.
1.  Enter the report name (up to 5 alphanumeric characters) (Figure 7.2). 

Figure 7.2—General Tab

2. Enter the report title (up to 40 alphanumeric characters).

The information displayed for Report Type, Source, and Maintain is not 
editable.

3. Leave the Report Group field blank. (The ability to group reports is a feature of 
GL reports, and this functionality may be incorporated into AP in the future.)

4. Enter the number of lines per page. The default is 60.

5. Select the applicable radio button to indicate the Report Spacing: Single or 
Double.
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6. Select the check box for each applicable printing option (Table 7.3). 

7. Format your report by entering the lines per page and checking the appropriate 
boxes.

8. Click Apply to save your changes and remain in the Define window, or click 
OK to save your changes and return to Report Manager.

DEFINING THE COLUMNS TAB

The Columns tab (Figure 7.3) allows you to define the columns in your report:
• Calculated Amount—Produces a calculated amount by performing a 

mathematical action on two existing report columns.
• Data Item—Allows you to select from any data item defined for the division. 
• Worksheet—Displays a blank column in the report, allowing you space to enter 

notations as you review the information.

Table 7.3—Printing Options

Option Description

Print Page Totals The report will include a total at the end of each page.

Print Break Totals Leave blank. This feature has no current impact in the software.

Print Report Totals The report will include an overall total at the end.

Print Only Non-Zero Records The report will exclude records with a value of zero.
Creating or Editing User-Defined Reports 
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Once you define the column type, you must define the necessary elements of the column 
(e.g., width). 

Figure 7.3—Defining Report Columns

1.  Select the type of information included in the column by clicking one of the 
three Column Types buttons. The column is added to the display of columns 
and the fields required for the column are enabled.

The contents of the report will be sorted on the value in the first 
column.

As you add columns to the report, you can change the column order by 
simply dragging them to a different position.
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2. Define the column parameters according to Table 7.4. 

You can remove a column from the report by selecting the column and 
clicking Delete.

3. Enter the column heading (up to two lines) in the Text Line 1 and Text Line 2 
text boxes. The default for Text Line 1 will reflect the column type.

While you can enter more than 200 characters for each title line, you 
must coordinate the length of the column title with the column width.

Table 7.4—Column Parameters

Field Description

Column Uneditable field indicating the current column using a letter designation (e.g., A, B, C).

Column Type This field indicates the column type (i.e., calculated amount, data item, or worksheet). 
You can change this setting by selecting a new type from the drop-down list.

Data Item Select the data item name, which determines where information included in the 
column will be found.
• Enabled if the column type is Data Item.

Value From Select the data item information to be displayed in the column (e.g., data item value, 
lookup column 1).
• Enabled if the column type is Data Item.

Operation Select the first column, action, and second column for the calculation (e.g., C divided 
by D).
• Enabled if the column type is Calculated Amount.

Sum Column Select the check box if the report should include a total for this column.
• Enabled if the column type is Calculated Amount or Data Item.

Print Column Select the check box if the report should display this column. 
• While most columns will be displayed, you may want to include a column that is 

used in a calculation but not displayed in the report. In that case, the check box 
should be empty.

• Enabled if the column type is Calculated Amount or Data Item

Width Indicate the width (in characters) of the column.
• The default width is 20 characters.
• Disabled if the column is not printed in the report (i.e., the Print Column check box is 

empty).
Creating or Editing User-Defined Reports 
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4. Click Apply to save your changes and remain in the Define window, or click 
OK to save your changes and return to Report Manager.

COPYING REPORTS
You can copy a user-defined report format to use it as a basis for a new report. To do so:

1.  Select a report from a Report Manager list.

2. Click Copy. The Define window displays with a blank Report Name field. 

3. Make your changes in the tabs, enter a report name, and click OK. 

DELETING REPORTS
Use the following instructions to delete a user-defined report. (You cannot delete the 
reports that are provided with FundWare, only the reports that you create.)

1.  Click Report Manager on the Navigator bar or select File > Report Manager 
from the menu bar; and select Accounts Payable, the report category, and the 
report name.

2. Click Delete. A confirmation message displays.

3. Click OK. The report is deleted and no longer displays in the Report Manager 
list of reports.

4. Click Report Manager on the Navigator bar or select File > Report Manager 
from the menu bar; and select Accounts Payable, the report category, and the 
report name.

PRODUCING STANDARD PURCHASE ORDER FORMS
The Produce Standard PO Forms feature saves your purchase orders, using the standard 
report form, to a report (OTPORD.L##, where ## represents your division number) that 
can be accessed from Print Manager. Use the following steps to produce your purchase 
orders.
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You must repeat the task for each shipping address.

1.  Click PO Forms > Produce Standard PO Forms on the module navigator (if 
the module is not expanded, click Accounts Payable first) or select Accounts 
Payable > PO Forms > Produce Standard PO Forms from the menu bar. The 
first page of the task displays (Figure 7.4). 

Figure 7.4—Produce Standard PO Forms, Page 1 of 3

2. Complete the necessary information according to Table 7.5. 

Table 7.5—Produce Standard PO Forms, Page 1 of 3

Field Name Options Description

Reference Reference item Enter the letter for an obligation reference to be used as a filter 
for the purchase orders produced by this task. (Press F1 to see a 
list of all obligation references defined for the division.)

Reference value Enter all or a range of values for the obligation reference or 
leave the fields blank to include all records.

Vendor Enter all or a range of vendor numbers or leave the fields blank 
to include all records.

Stage Enter a range of stage numbers (e.g., your purchase order stage 
or stages) or leave the fields blank to include all stages.

Change date Enter all or a range of valid dates. 
Producing Standard Purchase Order Forms 
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Stage date Enter a range of valid stage dates or leave the fields blank to 
include all dates.

Print zero Y
N

Indicate if zero amounts ($0.00) should be printed in the report 
or left blank:
• Y—Zero amounts are printed.
• N—Zero amounts are not printed.

PO Options—Enter values for the following purchase order options

• PO Form B
S

Indicate the source of the purchase order form:
• B—Blank stock form.
• S—Standard stock form.

• Terms from Not used
1
2
Obligation 
reference

Define how FundWare will determine the purchase terms to be 
printed on the form.
• Not Used—Purchase terms are not printed on the form.
• 1—FundWare prompts you for a description (up to 

30 alphanumeric characters) to print on all POs.
• 2—FundWare prints the history note field of PO stage. (The 

label for this field is defined in field 3—History desc of the 
stage definition.)

• Obligation reference—Select an obligation reference (e.g., 
your organization has defined a reference where purchase 
order terms are stored).

• Print PO 
number

Y
N

Indicate if FundWare should print the purchase order number on 
the form:
• Y—Purchase order number is printed on the form.
• N—Purchase order number is not printed on the form.

• Update ref Not used
Obligation 
reference

If your organization has defined an obligation reference used for 
purchase order numbers, you can print that value on the 
purchase order form.
• Not Used—Purchase order numbers are not printed on the 

form.
• Obligation reference—Select an obligation reference used for 

purchase order numbers.

• 1st PO number 15 characters Enter the first purchase order number to print (up to 
15 alphanumeric characters).

Table 7.5—Produce Standard PO Forms, Page 1 of 3 (Continued)

Field Name Options Description
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3. Press PAGE DOWN to access the next page of the task (Figure 7.5). 

Figure 7.5—Produce Standard Purchase Orders, Page 2 of 3

4. In the fields for Reference 1–9, select Not Used (i.e., leave blank) or enter an 
obligation reference to be printed on the purchase order form. (Press F1 for a list 
of obligation references.)

5. Press PAGE DOWN to access the next page of the task (Figure 7.6).

Figure 7.6—Produce Standard Purchase Orders, Page 3 of 3
Producing Standard Purchase Order Forms 
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6. Complete the necessary fields according to Table 7.6. 

Table 7.6—Produce Standard Purchase Orders, Page 3 of 3

Field Name Description

PO Letterhead—Enter the purchase order billing address. Press F1 to view any Location Abbreviations 
defined for the division.

• Name Enter the vendor name (up to 35 alphanumeric characters).

• Street 1 Enter the first line of the vendor billing address (up to 35 alphanumeric characters).

• Street 2 Enter the second line of the vendor billing address, if required (up to 35 alphanumeric 
characters).

• City Enter the city for the vendor billing address (up to 20 alphanumeric characters).
• Press F1 to see a list of your city abbreviations, which can complete the city, state (or 

province), and postal code.

• STP Enter the state or province for the vendor billing address (up to 6 alphanumeric 
characters).
• Press F1 to see a list of your city abbreviations, which can complete the city, state (or 

province), and postal code.

• Post Enter the postal code (i.e., zip code) for the vendor billing address (up to 9 alphanumeric 
characters).
• Press F1 to see a list of your city abbreviations, which can complete the city, state (or 

province), and postal code.

• Country Enter the country of the vendor billing address, if required (up to 35 alphanumeric 
characters).

Ship To—Specify the shipping address for the purchase.

• Name Enter the vendor name (up to 35 alphanumeric characters).

• Street 1 Enter the first line of the vendor shipping address (up to 35 alphanumeric characters).

• Street 2 Enter the second line of the vendor shipping address, if required (up to 35 alphanumeric 
characters).

• City Enter the city for the vendor shipping address (up to 20 alphanumeric characters). 
• Press F1 to see a list of your city abbreviations, which can complete the city, state (or 

province), and postal code.

• STP Enter the state or province for the vendor shipping address (up to 6 alphanumeric 
characters). 
• Press F1 to see a list of your city abbreviations, which can complete the city, state (or 

province), and postal code.
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When you have completed your entries, the system offers you the chance to 
return to a field or accept your entries.

7. Type 0 to accept your entries. FundWare saves the purchase orders to the report 
file (OTPORD.L##, where ## represents your division number) and closes the 
Produce Standard PO Forms task.

• Post Enter the postal code (i.e., zip code) for the vendor shipping address (up to 
6 alphanumeric characters). 
• Press F1 to see a list of your city abbreviations, which can complete the city, state (or 

province), and postal code.

• Country Enter the country of the vendor shipping address, if required (up to 35 alphanumeric 
characters).

• Ship 
attention

Enter the name of the recipient, if required (up to 35 alphanumeric characters).

Table 7.6—Produce Standard Purchase Orders, Page 3 of 3 (Continued)

Field Name Description
Producing Standard Purchase Order Forms 
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Figure 7.7 shows an example standard form for purchase orders. 

Figure 7.7—Example Standard Form for Purchase Orders

PRODUCING CUSTOM PO FORMS
Your organization can define custom purchase order forms. These “templates” are saved 
to the Custom PO Form report category, visible on the HomePage or through Report 
Manager. The selection criteria that you enter when you produce the form determines 
the purchase orders included in the report. 

See Defining Custom Forms on page 1.101 for the instructions to define a 
custom PO form.

Use the following instructions to produce a custom form. 
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1.  Click the report name on the HomePage (under the Custom PO Forms 
category). The Custom PO Form parameter window displays (Figure 7.8). 

Figure 7.8—Example Custom PO Form Parameter Window

You can also access the report through Report Manager: click Report 
Manager on the Navigator bar or select File > Report Manager from 
the menu bar; and select Accounts Payable, the Custom PO Forms 
category, and the report name; and double-click or click Produce. 

2. Complete the report parameters according to Table 7.7. 

Table 7.7—Custom Forms Report Parameter Options

Option Entry Description

References Data item Select a data item from the drop-down list and enter a range 
of values (based on the value of the data item) to filter the 
information included in the report.

Vendors Vendor numbers Enter a range of vendor numbers in the text boxes to filter the 
information included in the report.
Producing Custom PO Forms 
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Changed 
Date

Check box
Date range

Select the check box to include all checks or enter a date 
range to filter the information included in the report.

Stage Date Check box
Date range

Select the check box to include all obligations or enter a date 
range to filter the information included in the report.

Stages Stages Enter a range of stage numbers (e.g., your purchase order 
stage or stages). By default, all stages are selected.

Next Form 
Number

Valid number Enter the first number to be assigned to the custom forms.
• This field is enabled or disabled based on the custom form 

definition.

Updating 
Form

No entry—Information 
only

This field reflects the setting in field 2 the custom form 
definition (i.e., the form number is not updated or is updated 
from an obligation reference).

Auto 
Transfer 
Stages

No entry—Information 
only

This field reflects the setting in field 2 the custom form 
definition (i.e., obligations are not automatically transferred or 
obligations are transferred from one stage to another when 
the forms are produced).

Invoice To and Ship To Addresses—Enter the applicable billing and shipping information. 
• The Invoice To and Ship To address fields may be disabled, depending on the setting in field 3 of the 

custom form definition.

• Name Up to 35 alphanumeric 
characters

Enter the vendor name or select a Location Abbreviation from 
the drop-down list.

• Street 1 Up to 35 alphanumeric 
characters

Enter the first line of the vendor billing or shipping address.

• Street 2 Up to 35 alphanumeric 
characters

Enter the second line of the vendor billing or shipping 
address, if required.

• City Up to 20 alphanumeric 
characters

Enter the city for the vendor billing or shipping address. 

• State/Prov Up to 6 alphanumeric 
characters

Enter the state or province for the vendor billing or shipping 
address.

• Zip Up to 9 alphanumeric 
characters

Enter the zip code (i.e., postal code) for the vendor billing or 
shipping address. 

• Country Up to 35 alphanumeric 
characters

Enter the country of the vendor billing or shipping address, if 
necessary.

Table 7.7—Custom Forms Report Parameter Options (Continued)

Option Entry Description
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3. Click OK to produce the report.

Terms Up to 35 alphanumeric 
characters

Enter any applicable terms. 
• This field may be disabled, depending on the setting in 

field 3 of the custom form definition.

Ship 
Attention

Up to 35 alphanumeric 
characters

Enter the name of the recipient. 
• This field may be disabled, depending on the setting in 

field 3 of the custom form definition.

Report Select the applicable 
radio button.

Select the radio button for your desired report output:
• View—Saves a file (using the report name and the letter L 

plus the division name) in the report directory and displays 
the report in Print Manager.

• Print—Saves a file (using the report name and the letter L 
plus the division name) in the report directory and prints the 
report from your default printer.

• File—Saves a file (using the report name and the letter L 
plus the division name) in the report directory.

Print zeroes Select the check box 
to print zero amounts.

Select the check box if zero amounts ($0.00) should be 
printed in the report. If you do not select the check box, the 
zero amount entries will be left blank.

Table 7.7—Custom Forms Report Parameter Options (Continued)

Option Entry Description
Producing Custom PO Forms 
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To access the report, click Print Manager and select the file. (The file name will reflect 
the name of the form and your division number.) Figure 7.9 shows a sample custom 
form. 

Figure 7.9—Example Custom Form (OTFORM1.L95)

EXPORTING REPORT INFORMATION
All FundWare reports, including standard reports, trace reports, even check files, are in 
ASCII format. ASCII is a generic format that most spreadsheet or word processing 
programs can read. You can bring any of your FundWare reports into your favorite word 
processor or spreadsheet and modify them there. 

1.  Produce the report (via the HomePage or Report Manager).

2. Note the name and location of your report (i.e., the file name that you use to 
open the file through Print Manager). 

For example, the trial balance is called GLTRBAL.L02 for division 02. 
By default, this report is saved as an ASCII formatted file in your 
FundWare > Data folder. 

3. Using the secondary software program of your choice (e.g., Excel), select File > 
Open to locate and open the FundWare report file.

4. The secondary software may display a “Wizard” to guide you through the 
process of importing and formatting the file. Follow these instructions.
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C H A P T E R  8

AP WARRANT/VOUCHER APPROVAL REPORT

The New Accounts Payable Warrant/Voucher Approval Report is designed to list 
obligations ready for Council or Commission Approval, and can also be used informally 
for Manager Approval within any organization.
The report has features for customized format, sorting, signatures, and titles.
Users can specify what pieces of information, available from a standard list of 
obligation and/or check data items, they wish to appear in the body of the report. 

 The examples in the documentation are using a W for Warrant, but you may use 
whatever Obligation Reference you have set up for this purpose. Refer to your 
Accounts Payable Guide should you need to start using a new Obligation 
Reference.

REPORT SETUP
If you are a governmental entity that needs a report of open obligations to submit to your 
governing council or commission for approval, with specific terms based on your locale 
and type of entity, a new report has been developed that will allow custom configuration 
for the approvals that you need.
This new warrant report will allow you to specify the information needed in the report 
header, the body of the report, the footer information of the report, and signature lines 
and titles.
To define the warrant report, use the Navigator Bar Item, Accounts Payable > Define 
Warrant Reports.
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Figure 8.1—Warrant report definition program

You can also access this program via the toolbar.
Report Setup 



Chapter 8—AP Warrant/Voucher Approval Report
Figure 8.2—AP Warrant Reports Toolbar

A sample of the warrant report that you can define with the above program is provided 
in Figure 8.3 and Figure 8.4.  Refer back to these diagrams when filling out the Report 
Definition.
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Figure 8.3—Warrant report headings, columns and body
Report Setup 
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Figure 8.4—Warrant report summary page information

NEW WARRANT REPORT CREATION
To add a new warrant report, select the A)dd option.
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Figure 8.5—Warrant report definition selector
New Warrant Report Creation 
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REPORT DEFINITION

Figure 8.6—Warrant report definition

In the Report field, enter the name for your warrant report, up to 10 characters (Figure 
8.6).  You can add as many warrant report definitions as you need.  Each individual 
definition will  have a unique name.
Field 1  Enter a 35 character description for your warrant report 
Field 2  Enter the letter of your ID Type for the General Ledger or Project Grant 
accounts that will be selected for the body of your warrant report 
Field 3  Enter the dimension number of your account structure that contains your Fund 
dimension 

• "If you are unsure of your Fund dimension value, you can find it from General 
Ledger/Project Grant -> Maintenance -> ID Types.  For the ID Type that you 
entered in Field 2 of the warrant report definition, select the Account Structure 
tab (Figure 8.7). Your Fund Dimension can be found by the Radio Button 
selected under the Fund column heading.
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Figure 8.7—Warrant report Fund dimension
Report Definition 
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Figure 8.8—Continuation of Report Definition

Field 4  Enter the Stage number of your warrant stage.
               Typically, this is your ready to pay stage.

Stage 30 would be entered as 030

• "If you are unsure of your AP stage values, you can find them in Accounts 
Payable -> Setup -> Define Extended Setup.

• "Select D)isplay.  Your ready to pay stage can be found in field 3 (Figure 8.9).
Blackbaud, Inc. 2.241



Blackbaud FundWare Accounts Payable Guide—Volume 2

2.242
Figure 8.9—Ready to pay stage

Figure 8.10—Continuation of Report Definition

Field 5  Enter the reference value that you want to have your vendors sorted by.
Report Definition 
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 Enter # here to sort the vendors by name.

Field 6   Enter the way in which you want the Print Manager to handle the filing of your 
warrant report, when a previously produced report already exists in your report folder .

 Enter N if you want a previously filed warrant report to be replaced by the 
newly produced report.  Enter Y if you want the newly produced report to add 
on to the end of the previously produced report.

Field 7   Enter your choice for the three columns of the body of the report that you need 
to include. 

Enter # for the invoice date or the letter of the obligation references.

 The warrant report includes the vendor name in column 1, then your Field 7 
choices in the next three columns.  (see Figure 8.2).  Column 5 is Charge-Off 
Information, which is the General Ledger Account number and description for 
the included obligations. Column 6 is the amount charged to each account.

Field 8  Enter text for the first three lines of the warrant report heading. The fourth line 
of the warrant report heading is generated by the system, and contains the warrant 
number and the report date (Figure 8.3).
Field 9   Enter up to 40 characters for two titles for the required warrant approval 
officials next to Title 1 and Title 2.
Also in Field 9 of the warrant report definition, enter the number of signature lines for 
the required warrant approval signatures (from 0 - 9).
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Figure 8.11—Warrant report summary page titles

Field 10     Enter the text that is to appear on the warrant report summary page.
To include the report date in the text, enter <D> for the mm/dd/yyyy; to include the total 
amount of the obligations/vouchers included in the report, enter <$> into the text.
Report Definition 
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Figure 8.12—Warrant report summary page text

When you have completed all ten fields of the report definition, the Enter field to be 
changed (0 to accept) prompt will appear.  Press your [Enter] key to add the Report to 
your division.  If you need to change any of the previously defined fields prior to adding 
the report, enter the number of the field at the prompt and press [Enter].
When your field changes are complete, press [Enter] to add the warrant report.  
You will receive a message that your Report has been added when you press [Enter] at 
the Enter field to be changed (0 to accept) prompt.  You can change any of the fields in 
the report definition later as needed.

REPORT PRODUCTION
To produce a Warrant report, access Report Manager, select Accounts Payable in the 
Module drop-down list, and select Warrant Reports in the Report Category drop-down 
list. WARRANT1 will be highlighted and can be produced.
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Figure 8.13—Report Manager - Produce Reports

Select the Reference Letter from the Reference drop-down list for which you are 
producing the report (Figure 8.13).
Reference  After choosing the Reference Letter from the dropdown, select the 
Reference values you wish to use. If you set up W for Warrant, you will use the Warrant 
Numbers you wish to include. You may use any Obligation Reference letter you have set 
up on your system to filter this report.
Vendor  Leave the default to include all vendors who have obligations with the 
Reference Letter you have selected.
Reporting Date  Enter the Reporting Date for the report production.
Report  Select the Option of View, Print, or File.  If View is Selected, the report can be 
printed from the View Screen.
Report Production 
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Once you have completed the screen, click OK.
In the Print Manager, your report will file in the Fundware\data directory with the report 
name and the .L## extension (where ## is your division number, such as 
WARRANT1.L95.
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A P P E N D I X  A

SAMPLE REPORTS

The Blackbaud FundWare Accounts Payable standard reports are listed in Table A.1, 
and an example of many of these reports is included on the following pages. Your 
reports will vary from the examples based on your selection criteria and page break 
definitions.

Table A.1—Sample Reports

Name Title Category

OTRREG Check Reprint Check Register Check Reports

OCCKSUM Check Summary Check Reports

OCCKHST Check Complete Detail Check Reports

OCOSTND Check Historical Check Reports

OCDISC Check Discounts Taken/Lost Check Reports

OTORD Invoice Detail PO/Invoice

OTAGE Invoice Aging PO/Invoice

OTSUM Invoice Summary PO/Invoice

OTHIST Invoice History PO/Invoice

OTDIST Invoice Distribution PO/Invoice

OTCASH Invoice Cash Requirements PO/Invoice

OTDSTA Invoice Distribution by Account PO/Invoice

OTSTAGE Stages List System Lists

OTREF References List System Lists

OCBANK Banks List System Lists

OTSTDST Distribution Table List System Lists
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NWCITY City Abbreviations List System Lists

OTLOC Location Abbreviation List System Lists

IOCW Check User-Defined Check Reports

IOTB Obligation User-Defined Obligation Reports

IOTS Vendor User-Defined Vendor Reports

OTV1LST Vendor One Line Vendor Reports

OTVLIST Vendor Complete Record Vendor Reports

OTV1SUM Vendor Billing Summary Vendor Reports

OTVLBL Vendor Mailing Labels Vendor Reports

OTVCHKH Vendor Check History Vendor Reports

OTORD PO Detail Purchase Order Reports

OTSUM PO Summary Purchase Order Reports

OTHIST PO History Purchase Order Reports

OTDIST PO Distribution Purchase Order Reports

Table A.1—Sample Reports (Continued)

Name Title Category
 



Appendix A—Sample Reports
OTRREG—REPRINT CHECK REGISTER

Figure 1.1—OTRREG—Reprint Check Register

OCCKSUM—CHECK SUMMARY

Figure 1.2—OCCKSUM—Check Summary
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OCCKHST—CHECK COMPLETE DETAIL

Figure 1.3—OCCKHST—Check Complete Detail

OCOSTND—CHECK HISTORICAL

Figure 1.4—OCOSTND—Check Historical
OCCKHST—Check Complete Detail 
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OCDISC—CHECK DISCOUNTS TAKEN/LOST

Figure 1.5—OCDISC—Check Discounts Taken/Lost
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OTORD—INVOICE DETAIL

Figure 1.6—OTORD—Invoice Detail
OTORD—Invoice Detail 
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OTAGE—INVOICE AGING

Figure 1.7—OTAGE—Invoice Aging

OTSUM—INVOICE SUMMARY

Figure 1.8—OTSUM—Invoice Summary
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OTHIST—INVOICE HISTORY

Figure 1.9—OTHIST—Invoice History
OTHIST—Invoice History 
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OTDIST—INVOICE DISTRIBUTION—EXAMPLE 1

Figure 1.10—OTDIST—Invoice Distribution—Example 1

OTDIST—INVOICE DISTRIBUTION—EXAMPLE 2
You can include distribution line detail as shown in Example 2, by selecting the 
appropriate options in the Ledger Options for Accounts Payable and Purchase Order 
Basic Set Up. For more information see Defining the Basic Setup Parameter on page 
1.48 and Modifying the Purchase Order Basic Setup Parameter on page 1.61.
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Figure 1.11—OTDIST—Invoice Distribution—Example 2
OTDIST—Invoice Distribution—Example 2 
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OTCASH—INVOICE CASH REQUIREMENTS

Figure 1.12—OTCASH—Invoice Cash Requirements
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OTDSTA—INVOICE DISTRIBUTION BY ACCOUNT

Figure 1.13—OTDSTA—Invoice Distribution by Account

You can include distribution line detail, by selecting the appropriate options in the 
Ledger Options for Accounts Payable and Purchase Order Basic Set Up. For more 
information see Defining the Basic Setup Parameter on page 1.48 and Modifying the 
Purchase Order Basic Setup Parameter on page 1.61.
OTDSTA—Invoice Distribution by Account 
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OTV1LST—VENDOR ONE LINE REPORT

Figure 1.14—OTV1LST—Vendor One Line Report
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OTVLIST—VENDOR COMPLETE RECORD

Figure 1.15—OTVLIST—Vendor Complete Record
OTVLIST—Vendor Complete Record 



Appendix A—Sample Reports
OTV1SUM—VENDOR BILLING SUMMARY

Figure 1.16—OTV1SUM—Vendor Billing Summary
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OTVLBL—VENDOR MAILING LABELS

Figure 1.17—OTVLBL—Vendor Mailing Labels
OTVLBL—Vendor Mailing Labels 
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OTCHKH—VENDOR CHECK HISTORY

Figure 1.18—OTCHKH—Vendor Check History
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 OTCHKH—Vendor Check History 



GLOSSARY

Symbols or Numbers
1099 Form—The IRS tax form for reporting payments made to non-corporate service 
providers. The 1099 lists the payer and vendor names, addresses and tax ID numbers, 
and the amount paid and Federal income tax withheld during the year. 
1099 Vendor Record—The information extracted into the 1099 module for each 
vendor. Contains the vendor’s name, address, tax ID number, the amount paid, and 
Federal income tax withheld during the year.

A
Account Mask—Allows you to group accounts using only one entry. A mask uses a 
variable (X) in place of an actual number. See also Masking.
Account Number—The number that stores transaction information in a financial 
reporting system.
Adjusting Entry—An automatic correcting transaction made by Accounts Payable 
when an account number or amount changes for an obligation that has already been 
posted to the General Ledger module.

B
Business Date—Date selected when you sign on to FundWare. It is also called the 
posting date. It must exist in the date table, and it determines the period in which the 
transaction is posted. It is separate from the computer system date.

C
Change Date—The calendar date on which the obligation was last changed.
Check Number—The check’s preprinted number. 
Check Run—A group of obligations that are marked, paid, and logged in the same 
batch for the same bank.
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Check Status—The step in the check-writing process where a check currently resides.
City Abbreviation—A 1 to 3 character code that defines a city, state, and, optionally, 
postal code and country. The code is used as a data entry short cut.
Control Account—A General Ledger account that contains a summary of the 
transactions for a group of accounts with a similar characteristic. For example, the 
Accounts Payable account in the General Ledger summarizes the payable balances of 
many individual vendors. Accounts Payable uses control accounts to reserve for 
encumbrances and commitments, accounts payable, and cash.
Control Number—A number assigned by FundWare to a check before it is logged. The 
number may or may not equal the preprinted check number.
Credit Memo—A notification from a vendor of a reduction in the amount owed. You 
can enter a credit memo in Accounts Payable as an obligation for a negative (-) amount.
Cut Date—The business date on which a check was written. This is the date printed on 
the check and posted to Accounts Payable and the General Ledger.
Cut Status—Checks that have been produced but not yet logged.

D
Data Item—A piece of information applied to an obligation or vendor record. AP 
includes two types of data items: Obligation References and Vendor Data Items.
Default—The value used by FundWare if you do not enter your own.
Discount Date—The date used to figure if a discount is available, based on the Use 
Discount Date and the Mark for Pay date.
Distribution Table—An array of accounts and percentages that specify how to allocate 
an obligation distribution. The tables provide a data entry short cut.

F
Financial Institutions—A feature that contains records of information about each bank 
or savings and loan used to process payments in Accounts Payable. The record includes 
the General Ledger account number for the cash account represented by this bank.

I
Internal Check Number—See Control Number.
 



J
Journal—A chronological listing of transactions showing debits and credits to specific 
accounts.

L
Ledger—A collection of all the accounts for a specific financial category. For example, 
a General Ledger consists of accounts recording actual financial transactions.
Log Check Numbers—This task allows you to enter the preprinted check number into 
Accounts Payable. 

M
Marked for Pay Status—Invoices marked as ready for payment.
Mark for Payment—To approve an individual or group of obligations for payment. 
When you produce checks, all marked obligations are paid.
Memorized Obligation—A way to save an obligation and post it again without re-
entering the data. Referred to as a recurring obligation in earlier versions of Accounts 
Payable.
Model Division—A sample division that you can use to learn about the Accounts 
Payable module.

O
Obligation—Any payable in FundWare Accounts Payable (e.g., purchase order, 
invoice). As an obligation moves through its normal life cycle, it could have any status 
from an initial order to a reconciled check.
Obligation Number—A system-assigned number given to every payable. It is assigned 
when an obligation is created or when an existing obligation is split. Accounts Payable 
tracks all subsequent activity by the obligation number.
Obligation Records—A payable and all its associated information. An obligation 
record includes: references, banks, city and location abbreviations, vendors, distribution 
tables, and memorized status.
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Obligation Reference Data Items—Obligation reference data items are used to store 
information with a transaction (e.g., purchase order, invoice), such as the vendor invoice 
number, due date, or contract number. For example, you could use a data item to select 
obligations for a specific contract number or due date range. 

P
Purge—To delete obligation or vendor records permanently.

R
Reconciled Status—Mark a check to indicate that it has cleared the bank. This is the 
final check writing stage. 
Recurring Obligation—See Memorized Obligation.
Reference Data Item—Obligation reference data items are used to store information 
with a transaction (e.g., purchase order, invoice), such as the vendor invoice number, 
due date, or contract number. For example, you could use a data item to select 
obligations for a specific contract number or due date range. 
Reporting Date—The date used for history reports. It defaults to the current business 
date.
Run—A group of checks produced at the same time.

S
Scroll—To use a bar to move up/down or right/left in a window when there is more 
information than will fit on a single screen.
Sortkey—An alphanumeric abbreviation for each vendor that allows you to determine a 
sort order.
Split—To divide an obligation into two obligations. Often used to split dollars from an 
encumbrance as the money is actually spent. A split is different from a transfer in that all 
the parts of a transfer have the same obligation number, while a split is assigned a new 
obligation number.
Stage—A specific step in the life of an obligation. The stage indicates the obligation 
status and provides tracking information for each transaction.
 



Stage date—The stage date is a term encountered during setup; however, your 
organization probably renamed this field to reflect your usage. For example, the stage 
date could be the due date in the Invoice stage, or the date issued in the Purchase Order 
stage.

T
Tax ID Number—The identification number assigned by the US government to each 
taxpayer for reporting purposes. Individuals use their social security number, businesses 
use their employer identification number (EIN). 
Transaction—A recorded change in assets, liabilities, and equities, expressed in terms 
of money. In Accounts Payable, a transaction is two or more amounts posted to accounts 
in the General Ledger module due to changes in the status of payable amounts.
Transfer—To move an obligation from one stage to another.

U
Unmark for Payment—To remove an obligation from a check run so that it will not be 
paid.
Unused Check—A check that cannot be used as a manual or computer check. These 
include checks that are torn, mangled by the printer, or used to adjust the printer spacing.

V
Vendor—A record containing information about each vendor in the Accounts Payable 
system. The record includes the vendor name, address, and discount information.
Vendor Data Items—Store additional information with the vendor record (e.g., e-mail 
address, alternate contact name). 
Void Status—Checks that have been voided after being printed or written.

W
Wild Card—A character used to represent any other character(s). In searches, a wild 
card means “find any character or group of characters that occur at this point.” Accounts 
Payable uses an asterisk (*) as a wild card. For example, in field 8 of the stage definition 
and in Inquiry.
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